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INTRODUCTION

Welcome to Can-Pay's GM Suite Payroll Module. The Payroll Module is a
user-friendly system. The Payroll Module is aWindows/OS2 program, and uses the
standard Windows features which make it simple to learn and use. The Payroll
Module meets all your payroll needs by providing the facilities to run multiple
payrolls or to recalculate the payroll for just one employee.

The system is flexible with user defined options. These options allow users to setup
their own database with variable information about each category of information
within the database. The data input screen and report layouts are also fully user
defined.

The Payroll module calculates tax for all Canadian provinces and territories. The
system is user friendly, flexible and includesmany features normally only available on
large main frame system. The Payroll Module provides the facilities to record and
administer employee and position information. Some of the features are:

n 200 earnings, deductions and accumulators

n future transaction processing

n date or unit sensitivity

n wage rates dependent on rate table

n pay cheques and/or direct deposit, posting to most general ledger account
numbers using 8 segments, reports including Pay Register and Cheque
Register, Statistics Canada, Record of Employment, Workers Compensation,
Labels, Name and Address Listing and Journal Entry

n All reports can be customized by the user, table driven earnings, deductions,
and employee benefit costs split by general ledger allocation, interface to
electronic time clock.
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Main Payroll Menu

The Main Payroll Menu provides access to the payroll setup definitions, employee
definitions, payroll calculation processing, report definitions and employee selection
group functions.

File The File menu provides options for setting the overall search techniques, selecting or
deselecting a particular payroll. Enabling some additional system options for exiting
from the payroll module.

Data The Data menu provides the means for defining the payroll at the company level.
Setting the definition and operation parameters for earnings, deductions and
accumulators as well as defining general ledger definition tables, defining employee
model types, setting rate tables establishing a basic company holiday reconciliation
and the standard work week.

Groups The Groups menu provides functions for setting up and using or saving employee sub
sets in groups.

Employee The Employee menu provides functions for entering hours for all or some employees
or going to the employee level where all specific employee data is maintained as well
as providing for adding a new employee.

Calculation The Calculation menu allows for the setting of calculation types and dates and
calculating and choosing a pay run.

Reports The Reports menu provides for the standard printer set up and selecting of various
standard and customized reports.

Year End The Year end menu provides for the processing of the year end T4 and T4a files.

Help The Help menu provides basic help functions following standard help conventions.
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File Menu

The File Menu from the main Payroll Menu bar provides options that are the key to
proceeding through the Payroll Module.

The options available to you are:

n set preferences for accessing employees

n select/de-select a payroll

n set system options

n exit from the GrandMaster Suite Payroll module
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Set Search Technique

If the Set Search Technique option is selected from the File menu, then the following
screen will appear:

Employees on the system may be accessed through three different techniques:

n EmployeeName - The employee name or a portion of the employee namemay
be entered. The system will provide a list of the names that match the portion
entered. The namematching process requires that the last name be entered first,
given name last. When a name is entered it must be preceded by the �%�
character, or the system option for employee search must be set for employee
name search.

n Employee Number - The employee number may be used to locate an
employee. The employee number search may only be used when a payroll has
been selected. When an employee number is entered the number must be
preceded by the �#� character or the systemoption set for employee searchmust
be set for employee number search.

n Badge Number - The employee badge number may be used to locate an
employee. The badge number is a left justified 10 character alphanumeric field.
When a badge number is entered the number must be preceded by the �@�
character or the system option for employee search must be set for badge
number search.
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F When an employee group is in effect the search for an employee is restricted to the
selection group.

Each user may save their preference for a search technique.

F When the preferred search is on the employee number, the system will require the
selection of a payroll to search for employees.

When a function offers a next employee or prior employee option the order of
presentation for the employees will depend on the search technique in effect.
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Selecting/De-selecting a Payroll

The Select Payroll option from the File menu is used to select the payroll for
processing. Selecting this will result in a dialog box which displays a list of all the
available payrolls:

One of these payrolls must be selected for use. The payroll is selected by placing the
cursor over the payroll and clicking the left-handmouse button, or by pressing the OK
button. The payroll selected will appear in the main menu screen.

The De-select Payroll option from the File menu is used to de-select the currently
selected payroll. Selecting this will result in no payrolls being selected.
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Inserting a New Payroll

The Insert option from the select payroll program will allow you to create a new
payroll. The following dialog box appears:

Type in the name of the new payroll and select the OK button.

The GrandMaster Payroll File Update dialog box will appear as follows:

Type in the payroll name, description, and path to the payroll, and select OK or the
Save option from the File menu.

Click on the box to the left of the Enable Password if you wish to password protect
the payroll.
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Passwords

If you have selected Enable Password and pressed the Set Password button, the
following dialog will appear:

Enter your desired password and then retype the password in the confirm field.

F For security reasons, the passwordwill be shown as *'s on the screen as you are typing.

N Don�t forget your password. Keep a record of it somewhere safe!
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Updating an Existing Payroll

TheUpdate option from the select payroll will allow you to update the payroll name,
description and path to the payroll. Aswith the Insert option, the following dialog box
will appear:

When you havemade the required changes select OK or the Save option from the File
menu.
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System Options

When the user selects the System option from the file menu the following screen will
appear:

Always Request

Date Range

If this option is selected a number of screens presenting views of certain lists or
information will prompt for a date range to be entered prior to displaying.

Show only Payroll

Active

Employees

If this option is selected the system will present only those employees who are
currently an active status within the payroll on employee lists or for selection from the
Employee menu as well as reporting only those active employees.

Parallel Schedule

Processing

This option is reserved for very limited special case processing to be run in conjunction
with certain scheduling installation sites.

OK Pressing OK will use the options selected during the current session only.

Save Pressing save will save the options selected as default settings.

Cancel Pressing the cancel will exit the screen without changes.
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Data

TheDatamenu from themainmenu bar is used to setup the information needed to run
payrolls.

This menu appears as follows:

The functions available allow you to define:

n general payroll information

n EFT, Workers Compensation and Provincial Health settings

n rate tables

n earning, deduction and accumulator information

n distribution tables

n employee model definition

n calendar dates

n standard work weeks and standard earnings

n import functions/export functions
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Payroll Information

The Payroll Information function is used to set up the employer information.

This function displays a notebook with four pages. Each page has information that
must be entered to run and report the payroll correctly.

TheAddress page allows you to enter the company name, two address lines, the city,
province, postal code and telephone number for the company. The Address page
appears as follows:

The following table gives a description of the screen:

Field Description

Name This field contains the name of the company.

Address 1 This field contains the address of the company.

Address 2 This field contains an alternate address for the company.

City This field contains the city of the company.

Province This field contains the province of the company.

Postal Code This field contains the postal code for the company.

Phone This field contains the phone number of the company.

OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

CANCEL The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.
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The Settings page allows you to enter certain specifics about payroll, such as the
maximum net cheque the system will issue, and the payroll frequency. The Settings
page appears as follows:

The following table gives a description of the screen:

Field Description

MaximumNet Cheque This option allows the restriction of the maximum cheque issued.

Payroll Frequency This field is used to enter the payroll frequency. There are several
choices such as: Weekly, Bi-Weekly, Semi-monthly, Monthly,
10-month or Yearly.

Allow Arrears This field allows for the situation that may occur when deductions
exceed the earnings of an employee in a given pay period resulting
in an employee receivable. This may occur for example when
group insurance deductions comes out of the first pay period of the
month but the employee does not have sufficient earnings to
accommodate it. The company may pay this on the employees
behalf and create an arrears which the system will deduct from the
next pay to offset arrears.

Use Shared Types When this field is checked this payroll will share the Earning,
Deduction, and Accumulator definitions with other payrolls on the
system.

Pay Rate Search This field determines the order that will be used to resolve pay
rates for the employees. The options are: Company Default,
Earnings Search and Position Search.

Distribution This field contains the name of the distribution table that a payroll
as a whole can be assigned to or in the case where the company
has different distribution tables that apply for expenses but use
only one set of liability accounts for all.

Payroll Level Message This message will print on all cheques issued.
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TheAccount page allows you to enter up to three Revenue Canada Account numbers
for each payroll, and oneQuebec tax account. TheAccountpage appears as follows:

F Three account numbers are allowed. The first is for �Full Rate� E.I. Employer�s
Portion employees. The second is for �Reduced Rate� E.I. Employer�s Portion
employees. The third may be used in special arrangements with Revenue Canada.
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The Dates page allows for the entry of Company important dates. The Date page
appears as follows:

The following table gives a description of the screen:

Field Description

Company Anniversary This field allows for the input of month day date
format to signify the company�s anniversary date
which may be the company beginning fiscal period
date.

Vacation Anniversary This field allows input of month day date format to
indicate the start of company policy vacation year.

Sick Anniversary This field may be used to input in month day date
format the start of company policy sick time allowed
year.

Holiday Anniversary This field may be used to input in month day date
format the start of company policy date regarding
statutory holiday time allowance.
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EFT Settings

The following submenu is available under theEFTSettings option in theDatamenu:

F EFT settings may be needed for the following:

n payroll

n funds transfer

n Revenue Canada

n Quebec

F In the event that EFT is selected for payments processing the EFTmodulemust also be
activated in addition to the payroll module of the GrandMaster Suite. Please ensure
that you have been licenced for this module as well before attempting to do direct
deposits for your employees next payroll.
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Payroll EFT Settings

When the Payroll EFT Settings option is selected a dialog box similar to the
following will appear:

The following table describes the fields available:

Field Description

Code This field is used to identify the EFT standard bank profile.

Enable EFT Transactions

Employee Direct

Deposit

This check box is used to turn on employee direct deposit.

Revenue Canada Direct

Deposit

This check box is used to turn on Revenue Canada Direct Deposit.

Quebec Tax Deposit This check box is used to turn on Quebec Tax Deposit.

WCB Deposit This check box is used to turn on WCB Deposit.

Provincial Health

Deposit

This check box is used to turn on Provincial Health Deposit.

Deduction/Benefit

Deposit

This check box is used to turn on Deduction/Benefit Deposit.

Funds Transfer

Transaction

This check box is used to turn on Funds Transfer Transaction.

F8 (list) The F8 key, or the List option in the File menu will bring up a list of all the available
codes when the cursor is placed in the Code data field.
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Save The OK button, or the Save option in the File menu will save any changes made in the
dialog box.

Esc (exit) The ESC key, CANCEL button, or the Exit option in the File menu will exit the dialog
box without saving any changes.

Funds Transfer EFT Settings

When the Funds Transfer EFT Settings option is selected a dialog box similar to the
following will appear:

The following table describes the fields available:

Field Description

Generate Funds

Transfer

This field is used to turn on the Funds Transfer Option.

Days Prior to Pay This field is used to indicate the number of days prior to the pay date
by which payroll funds must be in banking institutions

Bank

Account This field contains the bank account number from which to obtain
funds.

Name This field contains the bank account name.

Address This field contains the address of the bank.

City This field contains the city of the bank.
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Field Description

Province This field contains the province of the bank.

Postal This field contains the postal code of the bank.

Payee

Name This field contains the name of the payee for the transfer.

Reference This field contains the reference for the transfer.

Save TheOKbutton, or theSave option in the Filemenu,will save any changesmade in the
dialog box.

Esc (exit) The ESC key, CANCEL button, or theExit option in the File menu will exit the dialog
box without saving any changes.

Can-Pay Computer Software 19

Data - 3

D
A
TA



Revenue Canada EFT Settings

When the Revenue Canada EFT Settings option is selected a dialog box similar to
the following will appear:

The following table describes the fields available:

Field Description

Generate Revenue

Canada Payment

This option is used to turn on the transfer.

Account This field contains the bank account number from which funds will be
drawn.

Name This field contains the name of the bank.

Address This field contains the address of the bank.

City This field contains the city of the bank.

Province This field contains the province of the bank.

Postal This field contains the postal code of the bank.

Regular This field contains the payment threshold.

Threshold 1 This field is used to determine how often funds must be remitted.

Threshold 2 This field is used to determine how often funds must be remitted.

Save The OK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

Esc (exit) The ESC key, CANCEL button, or the Exit option in the File menu, will exit the dialog
box without saving any changes.
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Quebec EFT Settings

When the Quebec EFT Settings option is selected a dialog box similar to the
following will appear:

The following table describes the fields available:

Field Description

Generate P. Quebec

Payment

This field is used to turn on the transfer option.

Account This field contains the bank account number from which funds will be
drawn.

Name This field contains the name of the bank.

Address This field contains the address of the bank.

City This field contains the city of the bank.

Province This field contains the province of the bank.

Postal This field contains the postal code of the bank.

Regular This field is used to determine the payment threshold.

Threshold 1 This field is used to determine how often funds must be remitted.

Threshold 2 This field is used to determine how often funds must be remitted.

Save TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

Esc (exit) The ESC key, CANCEL button, or the Exit option in the File menu, will exit the dialog
box without saving any changes.

Can-Pay Computer Software 21

Data - 3

D
A
TA



EFT Processing Overview

The GrandMaster Suite EFT ProcessingModule is used to generate the funds transfer
data files that are transmitted to your bank for processing.

When you undertake the agreement with your bank for Electronic Funds Transfer, you
will be supplied with information that is required to generate your EFT funds transfer
file.

This information is entered into the Bank Profile Update screen. You must complete
the screen before you can generate the funds transfer files.

The generation of a funds transfer file can only take place after you have closed the
payroll. Closing the payroll allows access to data used by the Electronic Funds
Transfer Module.

The Actual transmission of the data file to the bank computer requires the use of a
third-party communications package. Youmay acquire this package through the bank
or it may be purchased through your local computer software supplier.

Re-Creating a Funds Transfer File

When a payroll is selected for processing by theEFTmodule, theList screen shows the
starting and ending sequence numbers that will be processed.

You can change the sequence numbers by double clicking on the list item for the
payroll. This will display a dialog box that allows you to change the starting and
ending sequence numbers that will be processed.

N Use this option carefully. You can easily double pay employees if you do this.

This option allows you to re-create a funds transfer file. It will be assigned the next
available batch number.
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Workers Compensation Settings

When the Workers Compensation settings menu is selected a screen will appear as
follows:

The following table gives a description of the dialog box:

Field Description

From The starting date of the date range selected is displayed in this field.

To The ending date of the date range selected is displayed in this field.

List of Workers

Compensation

Settings

The list will only contain those workers compensation settings that fall
within the selected date range. Shown in the list from left to right are:
starting date for the setting, ending date for the setting, province code, and
province.

Set Date Range The Set Date Range option under the File menu will allow you set the date range to
delimit the range of the selection list.

OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

Cancel The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.

Insert The INSERT button is used to insert a new workers compensation setting.

Update The UPDATE button is used to update an existing workers compensation setting.

Delete The DELETE button is used to delete an existing workers compensation setting.
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Insert New Workers Compensation Setting

To insert a new workers compensation setting, do the following:

1. Select theWorkers Compensation Settings option from the Data menu. The
Workers Compensation Settings List will appear.

2. Select the INSERT button. The following screen will appear:

3. Type in the 2 letter province code and select the OK button. A dialog box will
appear as follows:

The following table gives a description of the data fields:

Field Description

Province The selected province will appear at the top of the dialog box. This field is for
display only.

Start Date This field contains the starting date of WCB rates.

End Date This field contains the ending date for the WCB rates.

Maximum This field contains the maximum assessable amount for the WCB rates.

Rates This field contains the 9 rate levels that may be entered for the given province
for WCB.

4. Enter the appropriate information into the data fields.

5. Select the OK button to save the changes.
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Update an Existing Workers Compensation Setting

TheUPDATE button is used tomake changes to the setting currently selectedwithin the
selection bar. The following dialog box will appear:

:

The following table gives a description of the data fields:

Field Description

Province The selected province will appear at the top of the dialog box. This field is for
display only.

Start Date This field contains the starting date of WCB rates.

End Date This field contains the ending date for the WCB rates.

Maximum This field contains the maximum assessable amount for the WCB rates.

Rates This field contains the 9 rate levels that may be entered for the given province
for WCB.

OK The OK button, or the save option in the File Menu, will save any concerns that have
been made to any of the input fields.

Cancel The Cancel button, or Exit option in the File menu, willexit the dialog box without
saving any changes.
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Delete an Existing Workers Compensation Setting

To delete an existing Workers Compensation Setting highlight the item to be deleted
and select delete. A screen will appear asking you to confirm the deletion. You may
select �Yes� to confirm and proceed with the deletion to the record. Selecting �No�
will exit from the deletion process.
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Provincial Health Settings

When theProvincialHealth settingsmenu is selected a screenwill appear as follows:

The following table gives a description of the dialog box:

Field Description

From The starting date of the date range selected is displayed in this field.

To The ending date of the date range selected is displayed in this field.

List of Provincial

Health Settings

The list will only contain those provincial health settings that fall within the
selected date range. Shown in the list from left to right are: starting date
for the setting, ending date for the setting, province code, and province.

Set Date Range The Set Date Range option under the File menu will allow you set the date range to
delimit the range of the selection list.

OK The OK button, or the Save option in the File menu will save any changes made in the
dialog box.

Cancel The CANCEL button, or the Exit option in the File menu will exit the dialog box
without saving any changes.

Insert The INSERT button is used to insert a new provincial health setting.

Update The UPDATE button is used to update an existing provincial health setting.

Delete The DELETE button is used to delete an existing provincial health setting.
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Insert New Provincial Health Setting

To insert a new provincial health setting, do the following:

1. Select the Provincial Health Settings option from the Data menu. The
Provincial Health Settings List will appear.

2. Select the INSERT button. The following screen will appear:

3. Type in the 2 letter province code and select the OK button. A dialog box will
appear as follows:

The following table gives a description of the data fields:

Field Description

Province The selected province will appear at the top of the dialog box. This field is for
display only.

Start Date This field contains the starting date of the rates.

End Date This field contains the ending dates of the rates.

Rates This field contains 9 rate levels that may be entered for a given province for
Provincial Health.

4. Enter the appropriate information into the data fields.

5. Select the OK button to save the changes.
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Update an Existing Provincial Health Setting

The UPDATE button is used to make changes to the setting currently selected with the
selection bar.

The following table gives a description of the data fields:

Field Description

Province The selected province will appear at the top of the dialog box. This field is for
display only.

Start Date This field contains the starting date of the rates.

End Date This field contains the ending dates of the rates.

Rates This field contains 9 rate levels that may be entered for a given province for
Provincial Health.

OK The OK button saves any changes made in the dialog box.

Esc (exit) The ESC key, CANCEL button, or Exit option in the File menu, will exit the dialog
box without saving any changes.
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Delete Existing Provincial Health Setting

To delete an existing Provincial Health Setting highlight the item to be deleted and
select delete. A screenwill appear asking you to confirm the deletion. Youmay select
�Yes� to confirm and proceed with the deletion to the record. Selecting �No� will exit
from the deletion process.
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Rate Tables

The Rate Tables option contains the following sub menu:

The options available to the user in the Rate Tables sub menu are:

n Earning Tables

n Deduction Tables

n Accumulator Tables
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Earning Rate Tables

Rate Tables set up in the Earning Rate Tables option will apply to all payrolls in the
GrandMaster Suite system.

When the Global Earning Rate Tables option is selected the following dialog box will
appear:

F If no global rate table codes have been previously defined the listwill appear empty.

The list contains the global earning code and a description of the code to the right.

OK The OK button will save any changes made in the dialog box.

ESC (exit) The ESC key, CANCEL button, or the Exit option from the File menu will exit the
dialog box without saving any changes.

Insert The INSERT button allows the user to insert a new global earning rate.

Additional TheADDITIONAL button allows the user to insert another global earning rate for the
currently selected code. This allows for a copy to bemade of an existing rate tablewith
different effective dates being assigned.

Update The UPDATE button allows the user to update the global earning rate currently
selected by the selection n bar.

Delete TheDELETEbutton allows the user to delete the global earning rate currently selected
by the selection bar.
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Insert/Update Earning Rate Table

When the user inserts a new rate table or updates an existing rate table the following
screen will appear:

The following table contains a description of the data fields in the dialog box:

Field Description

Code The rate code is entered in this field.

Description A description of the rate code must be entered into this field.

Date Range

From

This field is used to indicate the effective start date of the rate table.

Date Range To This field is used to indicate the effective end date of the rate table.

Table Overrides

Base Rate

If this field is checked the rate table entries will override an existing employee rate
if the coordinates of the rate table also exist on the employee record.

Rate Table List Up to 200 rows can be set up. To the right of each row number may be up to 10
rates. Highlight the row to be completed or updated and double click to call up the
entry screen for the insertion of rates.
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Setting Up Rate Tables

Up to 200 different rows can be set up for each type of pay rate.

When the user double clicks on a row the rate table lists the following screen will
appear:

The following table describes the data fields within the dialog box:

Field Description

P1 This field is reserved for future development.

Rate This field is used to input the hourly rate.

Limit This field is used in conjunction with a value from an
accumulator that has been assigned to an earning type definition.
When the limit is matched to a value in a specified accumulator
the corresponding rate of pay will be used.

Step # This field is used to indicate the column number that the rate will
appear in on the rate table.

Table Row # The number in the bottom right hand corner indicates the table
row currently selected. This number is for display only.
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Deduction Rate Tables

Rate Tables set up in the Deduction Rate Tables option will apply to all payrolls in the
GrandMaster Suite system.

When the Deduction Rate Tables option is selected the following dialog box will
appear:

F If no global rate table codes have been previously defined the listwill appear empty.

The list contains the global deduction code and a description of the code to the right.

OK The OK button will save any changes made in the dialog box.

ESC (exit) The ESC key, CANCEL button, or the Exit option from the File menu will exit the
dialog box without saving any changes.

Insert The INSERT button allows the user to insert a new global deduction rate.

Additional The ADDITIONAL button allows the user to insert another global deduction rate for
the currently selected code. This allows for a copy to be made of an existing rate table
with different effective dates being assigned.

Update The UPDATE button allows the user to update the global deduction rate currently
selected by the selection bar.

Delete The DELETE button allows the user to delete the global deduction rate currently
selected by the selection bar.
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Insert/Update Deduction Rate Tables

When the user inserts a new rate table or updates an existing rate table the following
screen will appear:

The following table contains a description of the data fields in the dialog box:

Field Description

Code The rate code is entered in this field.

Description A description of the rate code must be entered into this field.

Date Range

From

This field is used to indicate the effective start date of the rate table.

Date Range To This field is used to indicate the effective end date of the rate table.

Table Overrides

Base Rate

This field does not apply to deductions and has no effect if checked.

Rate Table List Up to 200 rows can be set up. To the right of each row number may be up to 10
rates. Highlight the row to be completed or updated and double click to call up the
entry screen for the insertion of rates.
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Setting Up Rate Tables

Up to 200 different rows can be set up for each type of deduction.

When the user double clicks on a row the rate table lists the following screen will
appear:

The following table describes the data fields within the dialog box:

Field Description

P1 This field is reserved for future development.

Rate This field is used to input the deduction amount.

Limit This field is not used in the processing of a deduction rate table.

Step # This field is used to indicate the column number that the rate will
appear in on the rate table.

Table Row # The number in the bottom right hand corner indicates the table
row currently selected. This number is for display only.
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Accumulator Rate Tables

Rate Tables set up in the Accumulator Rate Tables option will apply to all payrolls in
the GrandMaster Suite system.

When the Accumulator Rate Tables option is selected the following dialog box will
appear:

If no global rate table codes have been previously defined the listwill appear empty.

The list contains the global accumulator code and a description of the code to the right.

OK The OK button will save any changes made in the dialog box.

ESC (exit) The ESC key, CANCEL button, or the Exit option from the File menu will exit the
dialog box without saving any changes.

Insert The INSERT button allows the user to insert a new global accumulator rate.

Additional The ADDITIONAL button allows the user to insert another global accumulator rate
for the currently selected code. This allows for a copy to be made of an existing rate
table with different effective dates being assigned.

Update The UPDATE button allows the user to update the global accumulator rate currently
selected by the selection bar.

Delete The DELETE button allows the user to delete the global accumulator rate currently
selected by the selection bar.
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Insert/Update Accumulator Rate Tables

When the user inserts a new rate table or update an existing rate table the following
screen will appear:

The following table contains a description of the data fields in the dialog box:

Field Description

Code The rate code is entered in this field.

Description A description of the rate code must be entered into this field.

Date Range

From

This field is used to indicate the effective start date of the rate table.

Date Range To This field is used to indicate the effective end date of the rate table.

Table Overrides

Base Rate

This field does not apply to accumulators and has no effect if checked.

Rate Table List Up to 200 rows can be set up. To the right of each row number may be up to 10
rates. Highlight the row to be completed or updated and double click to call up the
entry screen for the insertion of rates.
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Setting Up Rate Tables

Up to 200 different rows can be set up for each type of accumulator.

When the user double clicks on a row the rate table lists the following screen will
appear:

The following table describes the data fields within the dialog box:

Field Description

P1 This field does not apply to accumulators.

Rate This field is used to input the rate for the accumulator.

Limit This field does not apply to accumulators.

Step # This field is to indicate the column number that the rate will
appear on the rate table.

Table Row # The number in the bottom right hand corner indicates the table
row currently selected. This number is for display only.
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Earnings

The Earnings option contains the following sub menu:

Earnings are entered as one of either:

n Overall - Overall Earnings are earning types that are available for use by all
employees.

n Position - Position Earnings are restricted to a particular position class. These
earnings are used for special settings that are applicable to a given position
class.
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Payroll Earning Types

Payroll Earning Types are used to define the categories of earnings that will be
reported for employees. Up to 200 earning types can be accommodated by the system.

The earning categories defined must adhere to the Revenue Canada and Human
Resources Canada requirements for assessment of employee source deductions.

An earning type sets the normal rate of pay for the hours worked in that category.
Earning types will have to be present to provide pay rates for regular time, overtime,
and double time.

Earning types also have to be defined for those amounts that are paid out as a result of
Accumulator Type processing.

The following table outlines some common earning types:

Earning Type Description

Regular Hours Earning type used for hours worked at the employee�s regular rate of pay. This
earning is subject to taxes, CPP and EI.

Overtime Hours Earning type used for hours worked at the employee�s overtime rate of pay. This
earning is subject to taxes, CPP and EI.

Double Time
Hours

Earning type used for hours worked at the employee�s double time rate. This
earning is subject to taxes, CPP and EI.

Vacation Taken Earning type used for earnings that occur when an employee takes vacation. This
earning has insurable dollars and hours for EI purposes, as well as being subject to
taxes and CPP.

Vacation Paid
Out

Earning type used for earnings that occur when an employee has vacation paid
out. This earning has insurable dollars only for EI purposes, as well as being
subject to taxes and CPP.

Travel Expense Earning type used for reimbursement of travel expenses for an employee. This
earning is not subject to taxes, CPP or EI.

Sick Pay Earning type used for payment of sick pay. This earning is subject to taxes, CPP
and EI.

Advance Earning type used for processing employee advances. This earning is not subject
to taxes, CPP or EI.

Salary Earning type used for processing salary amounts paid. This earning is subject to
taxes, CPP and EI pre-set hours and dollars.
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Earning Types and Effective Dates

The Suite Payroll provides support for effective dates on earning types. This allows
the changes made to earning type definitions to have a start date and an end date that
specify the effective date range for the earning type occurrence.

An example of this would be the overall overtime rate for the company is being
changed from a rate that is 1.4 times the employee�s regular rate of pay to 1.5 times the
employee�s regular rate of pay, effective June 17, 1997. A new occurrence of the
over-time earning type would be set up with an effective date of June 17, 1997, with
the newmultiplier for the over time rate. If this date falls in themiddle of a pay period
the overtime hours worked prior to June 17, 1997would be paid at the 1.4 times rate,
while the overtime hours worked on and after June 17 would be paid at the 1.5 times
rate.

The effective date range for the different occurrences of an earning type may not
overlap. The update process will not allow the entry of a date range that will result in
an overlap.

Creating the Master Earning Types

Earning types are set up through theEarnings choice on the Payroll Data menu. The
Earnings choice displays a sub menu with the options Overall and By Position.
Using the latter, theGrandMaster Suite Payroll supports the definition of earning types
that have special rates for certain position classes.
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Earnings Overall

TheOverall choice is used to define the master payroll earning types. Selecting this
choice causes the Payroll Earning List screen to appear, as shown below. This screen
displays a list of existing earning types defined in the payroll. The File menu on the
screen hasmenu choices that allow you to display the earnings by effective date range,
and to display any earnings that are marked for deletion.

The window title may be either payroll earnings list or global earnings lists depending
on whether you are sharing the earnings with other payrolls or not. (Global earnings
are shared between payrolls, payroll earnings are not shared)

OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

Cancel The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.

Insert The INSERT button is used to insert a new earning.

Update The UPDATE button is used to update an existing earning.

Delete The DELETE button is used to delete an existing earning.
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The INSERT button is used to insert new earnings in the payroll. The insert button
will display a dialog box that requests the new earning type number. If the number of
an existing earning type is entered in theEarningType field, the functionwill retrieve
the latest version of that earning type for update.

The Insert New Earning screen appears as follows:

Enter a number for the Earning Type, and press theOKbutton. It is recommended that
the earning codes be assigned in numeric sequence beginning at number 1. This will
improve processing and display time. Once you have selectedOK the payroll earnings
update notebook will be presented.

Payroll Earnings Update

The Earnings Update screen contains a notebook with four pages. Each of these
pages contains information that is used for processing the earnings. The payroll level
earnings data is used in conjunction with the employee earnings rates and hours
worked to determine the employees� pay.

The values set in theMaster EarningRate page can be used as the default values for the
employee level earning rates for all employees with this earning type assigned or
actual pay rates can be set at the individual employee level.
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TheDesc(Description) page contains fields for describing the earnings, and for setting
the effective date range for the earning type.

When you select the Desc tab on the Payroll Earning Update the following screen
will appear:

The following table gives a description of the data fields:

Field Description

Earning This field contains the code number of the earning.

Description The description field is used for describing the earning on
pop-up lists and on reports.

Short The short description field is used for printing a description on
pay statements.

Pay Code The pay code field is used for printing a description on pay
statements.

Date From This field is used to set the starting date of the effective date
range for the earning.

Date Until This field is used to set the ending date of the effective date
range for the earning.

Earning usage
Control

This field determines whether the earning is enabled or
disabled.

F Normally only the starting date is entered when entering an earning. The function
automatically sets the end date of the earning type when a new entry for the earning
type ismadewith a start date that is later than the start date on an existing earning entry.
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The Rate page contains data fields that are used to set the default rate treatments.
These values may be changed for the individual employee when setting up the
Employee Pay Rates.

When you select the Rate tab on the Payroll Earning Update the following screen
will appear:

When rate values are set at the payroll level they are used as the default for the earning
when the earning is established for an employee. The values may be changed when
setting-up the earning for a particular employee.
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The following table gives a description of the data fields:

Field Description

Rate EvaluationMethod :

Use Set Rate When use set rate is selected as an evaluation method the system will assume
a rate value will be used to determine the pay calculation. A rate value can be
set at the payroll level as a default rate or at the individual employee level.

Use Multiplier When this option is selected as an evaluation method. The system will
perform the pay calculation based on the parameters set in the �multiple
parameters�, where pay calculation is given the values to be used in
determining a pay rate which is dependent on a different earning type.

Use Rate Table When this option is selected as an evaluation method the system will search
for a �rate table� being assigned at the payroll level as a default or at the
individual employee level to determine the rate of pay to be used.

Rate Units:

Pay Period When this option is selected the system,using a previously selected evaluation
method of �Use set rate�, determines the rate values given at either the payroll
or employee level are to be calculated per each pay period.

Hour When this option is selected the system, using one of the previously selected
evaluation methods, determines the rate values given at either the payroll or
employee level are to be calculated per each hour input.

Annual When this option is selected the system, using a previously selected
evaluation method �Use set Rate�, determines the rate values given at either
the payroll or employee level are to be divided by the company�s pay
frequency type to establish a current pay gross earning. Note: When the
annual pay period rate unit type is selected in order for the system to correctly
resolve another pay rate using the annual earning amount as the base earning
amount. The annual rate amount must be accompanied by the annual number
of work hours represented.

Piece When this option is selected the system, using one of the previously selected
evaluation methods determines the rate values given at either the payroll or
the employee level are to be calculated per each piece work unit input.

Payroll Level Default Rate and Unit Settings:

Rate This field may be used to input a payroll level default rate for all employees
assigned this earning type depending on the evaluation and rate period units
previously selected.

Units This field may be used to input a payroll level default unit that the default rate
may apply to, again, depending on the evaluation and rate period unit
previously selected. This field may be either hours or piece work units.

E.I. Parameters This field may be used to input a payroll level default employment insurance
insurable hours equivalency when units is a piece work unit. Eg: 1 piece
work unit takes 15 minutes to complete, therefore the �EI parm� would be .25
of an insurable hour.

Multiple Parameters:

Multiplier This field is used to enter a factor that is used to multiply the rate value of the
base earning to calculate the rate of this earning being defined.
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Field Description

Base Earning By pressing the base earning box a list of previously defined earning types
will be presented to select the appropriate earning to be considered as a base
earning to be multiplied by above factor to determine the new earning rate
value.

Rate Table Parameters:

Table This field is used to input the rate table code number where individual rates
are set up.

Row This field is used to enter the appropriate row number of the rate table for the
rate value.

Column This field is used to enter the column/step number of the rate table for the rate
value.

Accumulator This field is used to enter the appropriate accumulator code number that will
determine the corresponding rate of pay when the value in the accumulator
matches the value in the �limit� field of the rate table.

The Flags page contains fields that indicate whether or not the earning type is subject
to the various payroll source deductions and taxes.

When you select theFlags tab on the Payroll EarningUpdate the following screenwill
appear:
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The following table gives a description of the data fields:

Field Description

Earning Dollars If the box is checked the earnings will be subject to one or
more of: federal tax, CPP, EI, Quebec tax, QPP, and WCB.

Earning Hours If the box is checked the earning hours will be subject to one
or more of: federal tax, CPP, EI, Quebec tax, QPP, and
WCB.

Pay Period Allocation

(EI)

The Pay Period Allocation buttons affect the treatment of the
hours in the earning when preparing Record of Employment
forms. Please refer to the Human Resource Canada
documents to determine the treatment for the pay period
allocation of insurable hours.

Process for Statutory

Holiday Only

If this box is checked the earning will be processed for
statutory holidays only.

F The system will default settings to turn on:

Under Dollars - Federal Tax, C.P.P., E.I., WCB

Under Hours - E.I.

since this would be be the most common earning settings
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TheControl page contains a number of options for the processing of the earning type.

When you select theControl tab on the Payroll Earning Update, the following screen
will appear:
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The following table gives a description of the data fields:

Field Description

Earning Usage Control:

Must Turn On for
Employee

When this field is selected, the earning will only be used for an
employee when the earning is specifically set for that employee.

Always On for
Employee

When this field is selected, the earning will always be available for all
employees. This button will always prevent employee level
modifications of the earning rate settings.

May Turn Off for
Employee

When this field is selected, the earning is normally available for all
employees. In order for an employee not to have access to the earning
type it must be specifically disabled for the employee.

Allow Modification at
Employee Level

This field is used to determine if a rate setting can be modified for the
employee. When this box is checked the employee may have
modifications to the rate settings. Note - this check box has no effect
when the �Always on for Employee� button is selected.

Tax Calculation

Use Bonus Tax
Calculation

When this check box is ticked the amounts input for this earning will be
treated as a bonus for the tax calculation.

Contra Earning Setting:

No Contra This button turns off any automatic processing.

Employee Base This button will result in the employee�s declared base earning (please
refer to the Employee Payroll Specific information settings) being used
for the automatic processing.

Other Earning This button uses the earning specified in the �Other Earning � field for
the automatic processing.

Deduction When this button is selected a specified deductions type will be the
contra rather than another earning type resulting in an automatic pay
deduction transaction being processed on the next normal pay
calculation. This is intended to be used in the case of an advance
earning type where an auto deduction of the advance amount is to be
deducted from a subsequent normal pay.

Contra Type This field is used to input the appropriate earning or deduction code to
be used as the contra automatic processing recipient for this earning
type.
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Earning by Position

When you select earnings By Position a dialog box will be displayed to ask what
position you would like to see the earnings set up for.

After you have selected a position the earnings for the position will be displayed.

OK The OK button, or the Save option in the File menu will save any changes made in the
dialog box.

Cancel The CANCEL button, or the Exit option in the File menu will exit the dialog box
without saving any changes.

Insert The INSERT button is used to insert a new position.

Update The UPDATE button is used to update an existing position.

Delete The DELETE button is used to delete an existing position.

F After selecting a position from an existing list or inserting a new position type, the
system will ask for an earning code to be inserted or updated and will then present the
standard payroll earnings update notebook. Please refer to Earnings -Overall for a full
description of the earnings notebook.
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Contra Processing Options

The Contra Processing options are used when a payment to an employee through an
earning should automatically create a transaction to reduce a payment through another
earning, or automatically create a deduction.

The most common uses of the contra processing options are:

1. Reduce the amount of salary paid to an employee when sick pay is paid.

2. Reduce the amount of salary paid to an employee when leave time is paid.

3. Automatically create a deduction for a salary advance paid to an employee.

4. Automatically create a deduction for an expense advance paid to an employee.

Contra Processing Settings

The Contra Processing settings are set for an earning at the payroll level.

An earning may be set to generate a contra transaction for one of three items:

1. Contra to the employee�s designated base earning

2. Contra to a specific earning

3. Contra to a specific deduction

This allows the contra option to reduce an employee�s salary when unpaid leave is
taken.

An example of using the contra processing for unpaid leave is:

Earning 1 (base salary)/ 800.00 per pay (40 hour)

Earning 12 (unpaid leave)/ 0.00 per hour

Set to contra Earning 1

When a transaction is entered for Earning 12 for 6 hours.

Entered: Earning 12= 6 hours @ $0.00

This processing generates a transaction that will subtract 6 hours pay from the
employee�s salary (Earning 1)

Generated Earning 1 is 6 hours @ $20.00 =120.00
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The Employee will receive gross pay of:

Earning 1 (Base Salary)

40 Hours @ 20.00 = $800.00

-6 Hours @ 20.00 = -$120.00

Earning 2 (unpaid leave)

6 hours @ 0.00 = $ 0.00

Total Gross $680.00

An example of using the contra processing for sick leave is:

Earning 1(base salary) /$800.00 per pay (40 hours week)

Earning 11 (sick pay) rate 1 times base pay per hours set to contraEarning
1

F If an earning is amultiple of another the systemwill automatically convert from �per
pay� rates to hourly rates using the number of hours in the employee work week.

When a transaction is entered for Earning 11 for (4) hours

Entered: Earning 11=4 hours @ 20.00

The processing generates a transaction that will subtract four hours from the
employee�s salary (Earning 1)

Generated Earning 1 is - 4 hours @$20.00 =$80.00

The Employee will receive a Gross pay of:

Earning 1 (per pay) $800.00

-4 hours @ $20.00 -$ 80.00

Earning 11 4 hours @ 20.00 $ 80.00

Total Gross $800.00
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Special Processing for Advance Pay Run

Earnings that are set to contra to a deduction will be evaluated during an advance pay
run.

When this earning has a number of units, and a pay rate, and it is set to contra to a
deduction, the earning is processed during an advance pay run.

The amount specified by the earning (units times rate) is paid out to the employee.

A transaction is generated for the contra deduction for the same amount.

Because the advance pay run does not evaluate deductions, the net cheque to the
employee will be the amount of the earning.

The contra deduction transactionwill be included in the next normal pay run. Thiswill
reduce the employee�s net pay by the amount of the advance.
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Deductions

Payroll Deduction Types

What Deduction Types do I need?

Payroll Deduction Types are used to define the categories of company deductions and
benefits that will be included in the calculation of an employee�s pay.

A Deduction Type defines the calculation that will be used to determine the
deduction and benefit amounts that apply to the deduction. The Deduction Type can
also define the list of earnings, other deductions, or benefits that will be included in
the calculation.

What decides how the calculation is done?

The Suite Payroll module provides over a hundred calculation formulas that can be
used to calculate a deduction and/or benefit. Each deduction formula provides a
number of parameters that can be used to determine the results of the calculation.

Alternatively, the deduction and/or benefit can be set up as a fixed amount to deduct for
each pay. This method can be used when the actual amount is decided independently
of the values processed in the pay calculation.

Examples of Deduction Types

Field Description

Union Dues This deduction is used to calculate union dues. Normally this deduction
type will require a calculation code that will calculate some percentage
of the employee earnings that are subject to the union dues deduction.

Calculation would be a percentage of earnings. The list of earnings
would include regular and overtime wages but would not include
expense reimbursement.

Registered Pension
Plan

This deduction is used to calculate the employee contribution to a
pension plan. The deduction type will require a calculation code that
uses a list of earnings that are subject to the deduction. The calculation
code used may also calculate a benefit for the employee that is the
company portion of the contribution.

Health Insurance Plan This deduction is used to calculate the employee Heath Insurance
premium. The calculation may be based on a base rate depending on
the employee�s age and additional premiums based on the number of
dependents that the employee has.

The employee�s earnings do not have to be entered into a deduction
calculation.
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Creating The Master Deduction Types

Grand Master Suite Payroll allows you to have up to 200 different deduction types.
Each type determines a category of deductions for an employee. The Deductions
choice on the Data menu is used to access the deduction update function.

Because the GrandMaster Suite Payroll supports date-sensitive processing, several
deductions of each type may be present. Each one will cover a particular date range.
When you insert a new deduction with the same number as an existing one you must
specify a date range for the new deduction that is later than the date range in use for the
existing deduction.

TheDeductionList screen is displayedwhen you select themenu choice. The screen
appears as follows:

The window title may be either Payroll Deduction List or Global Deduction List,
depending on whether or not you are sharing the deduction with other payrolls.
(GlobalDeductions are shared between payrolls, PayrollDeductions are not shared).

OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

Cancel The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.

Insert The INSERT button is used to insert a new deduction to the list.

Update The UPDATE button is used to update an existing deduction.

Delete The DELETE button is used to delete an existing deduction.
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The INSERT button is used to add a new deduction type to the list. When this button is
pressed a dialog box will appear that asks for the deduction type number. The Insert
New Deduction screen appears as follows:

If you enter the number of an existing deduction type, that deductionwill be retrieved
to be updated.

It is recommended that the deduction codes be assigned in numeric sequence
beginning at number 1. This will improve processing and display times.

The Deduction Update screen contains a notebook with eight pages. Each of these
pages contains information that is used for processing deductions.
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TheGeneral page contains fields for describing the deduction and setting the effective
date range of the deduction type.

When you select the General tab on the Deduction Update the following screen will
appear:

The following table gives a description of the screen:

Field Description

Deduction This field displays the code number of the deduction.

Description The long description is used for reporting, and for descriptions on
screen displays.

Short The short description is used on pay statements.

From This field is used to set the starting date of the effective date range
for the deduction.

Until This field is used to set the end date of the effective date range for
the deduction.

Deduction Usage

Control

This field contains two buttons that are used to Enable or Disable
the uses of the deduction type. When the deduction type is disabled
the deduction will not be used for pay processing.
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The Fixed page contains fields that are used to input fixed amount that are used to
input fixed amounts for the deduction processing. When you select the Fixed tab on
the Deduction Update the following screen will appear:

The following table gives a description of the screen:

Field Description

Fixed Deduction

Amount This field contains the values that could be deducted for employee
for each periodor it can be set at an employees level for individually
applicable amounts.

Unit This field contains the corresponding unit values if applicable.

Fixed Benefit

Amount This field contains the values that could be recorded as a benefit to
the employee for each period. These can be set at an employee
level for individually applicable amounts.

Units This field contains the corresponding unit values if applicable.

Use Fixed Values: This field contains the override �use fixed values� check boc.

When this box is checked only those amounts appearing in the deductions and/or

benefit field at wither the payroll or employee level will be used.

Evaluate: The Evaluate box allows for a selection of periods when the deduction

processing is to take place. The evaluation periods apply whether you use fixed

amounts or the result ofa calculation for the deduction.

Per Pay When this option is selected the deduction processing will occur for
every pay. This is the system default setting.

Per Month When this option is selected the deduction processing will occur
once a month. The month that this evaluation method is to begin
must be inserted in the �Month� box. A �day� of the month can
also be inserted but if it is not the system will default to the first day
of the month.
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Field Description

Per Quarter When this option is selected the deduction processing will occur
once every 3 months. The month that begins the first quarter of the
fiscal or calendar year must be inserted in the �month� box. The
day will default to the first day of each new quarter period.

Per Year When this option is selected the deduction processing will occur
once a year. The annual �month� and �day� must be specified in
the appropriate boxes.

Pay Day of Month When this option is selected the deduction processing will occur on
the pay day of the month as specified in the �day� insert box. Pay
day is the actual pay cheque day in this case. Eg) Deduction Type-
Union Dues payable on the first of the month. Pay period was:
Start: December 15, 1997; End: December 28, 1997; Pay Day:
January 2, 1998. If the evaluate method is pay day of month with
day =1 the union deduction processing would take place and be
deducted from the January 2, 1998 cheque.

Pay Period of

Month

When this option is selected the deduction processing will occur on
the pay day falling within the pay period specified in the �day�
insert box. Eg) Deduction Type - Union Dues, payable on the first
of the month. Pay period was: Start: December 29, 1997; End:
January 11, 1998; Pay Day: January 16, 1998. If the evaluate
method is pay period of month with day =1 the union deduction
processing would take place and be deducted from the January 16,
1998 pay cheque since this is the first pay period of January 1998.
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The Calculate page is used to set the values for the calculation that will be done to
determine the amount of the deduction. When you select the Calculate tab on the
Deduction Update, the following screen will appear:

The following table gives a description of the screen:

Field Description

Calculation Code This field is used to enter the number of the calculation code that will
be used to calculate the value of the deduction. A list of calculation
codes can be displayed by pressing the F8 key when the Calculation
Code field is selected.

Parameter Table This field is used to enter the name of a parameter table. A list of the
tables already defined can be obtained by pressing the F8 key when
the Parameter Table field is selected.

Parameter Group This field is used to enter the default group (row) for the deduction
type.

Custom Parameters This field is used to determine if a Named Table or a Custom
Parameter table will be used in the calculation for the deduction type.

Table Parameters This field is used to call up a screen that is used to enter the custom
table parameters.

Item Parameters This field is used to update item parameters required by the
deduction code selected.

Exclude List This field can be used to indicate those earnings, deductions or
benefits that should be excluded from a calculation.

Selection This field is used to call up a screen that can be used to select the
earnings, deductions, or benefits that will be summarized for this
calculation code.
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The TABLE PARAMETERS button is used to call up a screen that is used to enter the
custom table parameters. The screen shows a list of the values in the parameter table.
The Custom Deduction Parameter Table appears as follows:

The values in a row of the list are updated by double-clicking on the row. This will
display a screen that is used to update the individual parameters in the row. The
employee deduction set up will select a particular row in the table to use for the
employee calculation.

The SELECTION button is used to call up a screen that can be used to select the
earnings, deductions, or benefits that will be summarized for this calculation code.
The Payroll Earnings Selection screen appears as follows:

The calculation code requirements decides the type of list thatwill be displayed. Items
in the list are selected by single-clicking on them with the mouse. Any number of
items can be selected from the list. You may also use the Include/Exclude buttons to
indicate an exclude list rather than an include list. An exclude list selects only the
items that are NOT to be included for the calculation.
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TheFlags page contains settings that are used to control the use of the deduction type.
When you select the Flags tab on the Deduction Update the following screen will
appear:

The following table gives a description of the screen:

Field Description

Benefit Subject To These fields are used to indicate what statutory deductions
that the benefit calculated by this deduction type is subject
to.

Deduction Class These fields are used to indicate the class of the deduction
for Revenue Canada tax treatment.

Distribute Benefit This field is used to specify that the benefit calculated is
included in the Journal Entry file prepared from the
payroll.
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The Control Page is used to set the conditions for the use of the deduction type by
employees. When you select the Control tab on the following screen will appear:

The following table gives a description of the screen:

Field Description

Deduction Usage Control This dialog box contains three buttons that determine the
default processing of the deduction for the employee.

Must Turn On for

Employee

This field sets the option that requires that the deduction
be enabled at the employee level before the deduction will
affect the employee�s pay.

Always On for Employee This field sets the option that the deduction will always
affect all employees pay. This option prevents the
deduction from being turned off for an employee.

May Turn Off for

Employee

This field sets the option that the deduction will affect the
employee�s pay unless the deduction is disabled at the
employee level.

AllowModification at

Employee Level

This field allows the selection of or changes to parameter
values for the calculation of the deduction. If this is not
turned on no changes to the default parameters are allowed
at the employee level.
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TheEFTDed(EFTDeduction) page allows the entry of data used for processing of the
deduction amounts by the Electronic Funds Transfer module. When you select the
EFT Ded tab on the Deduction Update the following screen will appear:

The following table gives a description of the screen:

Field Description

Deduction

Payable

This field is used to indicate that the deduction amount may be processed with
the Electronic Funds Transfer module. If this box is not checked no EFT
processing will occur for the deduction.

Immediate This field is used to determine the date to pay out the amounts.

End of Month This field is used to determine the date to pay out the amounts.

Day of Month This field is used to determine the date to pay out the amounts. When the
Day of Month button is selected the day field must contain a value to use for
the number of days or the day of the month.

Days after Pay This field is used to determine the date to pay out the amounts. When the
Days after Pay button is selected the day field must contain a value to use for
the number of days or the day of the month.

Bank These fields contain the bank account number and the name and address of
the bank that the deductions payable is drawn from. If these fields are not
present no deposit will be prepared.

Payee These fields contain the name of the payee for the amount, and a reference for
the deposit.
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The EFT Ben(EFT Benefit) Page allows the entry of data used for the processing of
the benefit amounts by the Electronic Funds Transfer Module. When you select the
EFT Ben tab on the Deduction Update the following screen will appear:

The following table gives a description of the screen:

Field Description

Benefit Payable This field is used to indicate that the benefit amount may be processed with
the Electronic Funds Transfer module. If this box is not checked no EFT
processing will occur for the benefit.

Immediate This field is used to determine the date to pay out the amounts.

End of Month This field is used to determine the date to pay out the amounts.

Day of Month This field is used to determine the date to pay out the amounts. When the
Day of Month button is selected the day field must contain a value to use for
the number of days or the day of the month.

Days after Pay This field is used to determine the date to pay out the amounts. When the
Days after Pay button is selected the day field must contain a value to use for
the number of days or the day of the month.

Bank These fields contain the bank account number and the name and address of
the bank that the benefits payable is drawn from. If these fields are not
present no deposit will be prepared.

Payee These fields contain the name of the payee for the amount and a reference for
the deposit.

F When the benefit bank account and payee information is blank the benefit deposit will
be made using the information from the EFT Ded page.
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When you choose the Selections tab on the Deduction Update, the following screen
will appear:

The following table gives a description of the screen:

Field Description

Select Positions This button is used to select positions for the deduction update.

Select Categories This button is used to select categories for the deduction update.

Select Province This button is used to select provinces for the deduction update.

Include When this check box is checked the position, category or province will
be included in the update.

Exclude When this check box is checked the position, category or province will
be excluded in the update.
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The following table outlines available deduction/benefit calculation codes:

Calculation Parameters Description

1 Fixed Dollar
amount

Ded. Amount
Ben. Amount

The default deduction code. A fixed amount
would be entered for the deduction and/or
benefit.

2 % of Selected
Earnings

Ded. Percent
Ben. Percent

A calculation based on a percentage of
selected earnings for the deduction and/or
benefit.

3 Rate * Selected
Hours

Ded. Rate
Ben. Rate

A calculation based on a rate times hours of
selected earnings for the deduction and/or
benefit.

4 Rate * Selected
Hourly Rate

Ded. Rate
Ben. Rate

A calculation based on a rate times hourly
base rate of selected earnings for the
deduction and/or benefit.

5 Not Enabled

8 % of Selected
Earnings to
deduction
maximum

Ded. Percent
Ben. Percent
Ded. YTD Max.

A calculation based on a percentage of
selected earnings for the deduction and/or
benefit. The deduction is subject to a YTD
deduction maximum.

9 % of Selected
Earnings to
deduction
maximum
(Ded Only)

Ded. Percent
Ded. YTD Max

A calculation based on a percentage of
selected earnings for the deduction only to a
maximum YTD deduction.

10 Not Enabled
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Code Calculation Parameters Description

11 Rate * Selected
Multiple Hourly Value
(Ded. only)

Ded. Rate A calculation based on a rate times the
hourly base value of selected earnings
for the deduction only. The hourly base
value is the multiple hourly rate.

12 Rate * Selected
Multiple Hourly Value
(Ben. only)

Ben. Rate A calculation based on a rate times the
hourly base value of selected earnings
for the benefit only. The hourly base
value is the multiple hourly rate.

13 Fixed Dollar Amount
up to YTD maximum
(Ded. Only)

Ded. Amount
Ded. YTD Max

A fixed amount up to a year-to-date
maximum deduction.
Can have employee parameters

14 % <YMPE +
% >YMPE
On selected earnings

% <YMPE
% >YMPE
Ben. rate of ded.

A calculation done on a pay period
basis on a percentage of earnings less
than YMPE + a percentage greater than
YMPE. The benefit is taken as a rate
times the deductions. The YMPE
amount and the number of pay periods
are used in the calculation.

15 Rate * Selected
Multiple Hourly Value

Ded. Rate
Ben. Rate

A calculation based on a rate times
hourly base value of selected earnings
for deduction and/or benefits. The
hourly base value is the multiple hourly
rate.

20 Life Insurance
Plan on
selected earnings

Ded. Rate
Ben. Rate
Multiplier
Maximum per 1000
Minimum per 1000

The premium is calculated as a rate per
thousand on the annual salary times the
multiplier (rounded up to the next
thousand). The annual salary is
determined by the selected earnings
times the number of pay periods in a
year. A minimum and a maximum
annual salary can be entered to limit the
range of the calculation.

21 % of Selected
Earnings less
CPP/QPP paid

Ded. Percent
Ben. % of Ded

A calculation based on a percentage of
selected pensionable earnings less CPP
and QPP paid. The benefit is a
percentage of the deduction.

22 % of selected
Earnings less (CPP +
QPP paid CPP Rate)

Ded. Percent
% of CPP + QPP
paid/CPP Rate
Ben. % of Ded.

A calculation based on a percentage of
selected earnings less a percentage of
CPP + QPP paid divided by CPP rate.
The benefit is a percentage of the
deduction.

24 % of Selected
Earnings (Tax, CPP,
QPP, UIC QUE Tax)
(Ded. Only)

Ded. Percent
Ded. Max YTD

A calculation based on a percentage of
selected earnings then subtracts tax,
CPP, UIC, QPP, Que tax to a year to
date deduction maximum. The
deduction cannot be negative.
Can have employee parameters.

25 % < YMPE +
% > YMPE(Ded)
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Code Calculation Parameters Description

26 % <YMPE +
% >YMPE
on selected hours
(Ded. only)

% <YMPE
% >YMPE

Deduction code developed for Sask
Teachers Superannuation Plan.
A calculation is done on a per day basis
on a percentage of the hourly rate (
selected earnings divided by hours) less
than YMPE + a percentage above
YMPE. The number of days worked in
year are 197. The YMPE amount and
the number of pay periods are used in
the calculation.

27 % Net Pay to a YTD
Maximum
(Ded. only)

% of net pay
Ded. maximum

A calculation based on a percentage
(not more than 100%) of the
employee's net payroll to a YTD
maximum deduction value. Normally
used for garnishee orders. The
deduction cannot be negative.
Can have employee parameters.

28 CPP/UIC
Company cost charge
back
(Ded. only)

NONE A calculation to charge the company's
cost of CPP and QPP paid as well as
UIC paid times the UIC rate back to the
employee.

29 % >YMPE +
% >YMPE
on selected earnings

% <YMPE
% >YMPE
Ben. % of ded.

Deduction code developed for Ontario
Hospital Pension Plan. A calculation is
done on an annual basis on a
percentage of selected earnings less
than YMPE + a percentage greater then
YMPE. The benefit is a percent of the
deduction. The YMPE amount and the
number of pay periods are used in the
calculations.

30 % <YMPE +
% >YMPE
on selected earnings

Ded % <YMPE
Ded % >YMPE
Ben % <YMPE
Ben % >YMPE

Deduction code developed for Alberta
Lap Municipal employees. A
calculation is done on a per pay period
basis as a percentage of selected
earnings less then YMPE + a
percentage greater than YMPE. The
benefit has separate percentages for
above and below YMPE. The YMPE
amount and the number of pay periods
are used in the calculation.

31 % <YMPE +
% >YMPE
on selected earnings
and FTE

% of <YMPE
% of >YMPE
Ben. rate of ded.

Deduction code developed for Alberta
Teachers Retirement.
A calculation is done on a per pay
period basis as a percentage of full time
equivalent selected earnings less than
YMPE + a percentage greater than
YMPE. The benefit is a rate times the
deduction. The YMPE amount and the
number of pay periods are used in the
calculation.

72 Can-Pay Computer Software

3 - Data



Code Calculation Parameters Description

32 Indemnity Calculation
default earnings

Ded. Rate
Ded. Percent
Weekly Maximum
Ben. % of Ded

Deduction code developed for custom
use.
A calculation is done on a percentage
of weekly salary to a weekly maximum
amount. The weekly salary is
calculated as the default earnings times
the number of pay periods divided by
52. The deduction rate is calculated on
1/10th of the weekly salary. The
benefit is up to 100% of the deduction.
If a benefit has been calculated reduce
the deduction by the amount of the
benefit.

33 Life Insurance on base
earnings

Ded. Rate
Ben. Rate
Ded. Multiplier
Ben. Multiplier
Ded. Maximum per
1000

Deduction code is used for custom use
only. The
premium is calculated as a rate per
thousand on the annual salary times the
multiplier at a separate deduction and
benefit multiplier (rounded up to the
next thousand). The annual salary is
determined by the selected earnings
times the number of pay periods in
year. A deduction maximum annual
salary can be entered to limit the range
of the deduction only. If the earning is
a multiple then only the base rate times
the hours for earnings amounts.

34 % of selected base
earnings

Ded. Percent
Ben. Percent

Deduction code developed for custom
use.
A deduction and or benefit calculation
based on a percentage of selected base
earnings. If the earning is a multiple
then only use base rate times hours for
earning amounts.
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Code Calculation Parameters Description

35 % <YMPE +
% >YMPE
(on base earnings)

% <YMPE
% >YMPE
Ben. rate of ded.

Deduction code developed for custom
use.
A calculation done on a pay period
basis on a percentage of selected base
earnings less than YMPE + a
percentage greater than YMPE. The
benefit is taken as a rate times the
deduction. The YMPE amount and the
number of pay periods are used in the
calculation. If an earning is a multiple
then only use base rate times hours for
earning amounts.

36 % of previous,
deductions and
benefits
(Sales tax)

Ded. Percent
Ben. Percent

Deduction code developed for custom
use.
A deduction and or benefit calculation
based on a percentage of previously
calculated deductions and benefits,
excluding statutory deductions.
Normally used for Ontario/Quebec
sales tax.

37 Pay Back of 5/12
UIC Rebate

Rebate Factor Deduction code developed for custom
use. A
benefit calculation based on a rebate
factor times (UIC paid times 1.4 less
UIC paid times UIC rate). Then the
deduction is the benefit times -1.

38 Weekly Indemnity on
selected hourly rate

Pay frequency
Weekly maximum
earnings
Premium
Ben % of ded

Deduction code developed for custom
use.
A calculation that takes the hourly base
rate of selected earnings times the
hours worked to get a weekly salary up
to a weekly maximum. Then multiplies
it by the pay periods to get the annual
salary. The calculation takes 2/3 of the
annual salary divided by the pay
frequency to get the weekly salary. The
deduction is then taken on 1/10th of the
weekly salary times the deduction rate.
The benefit is a percent of the
deduction.

39 Monthly Indemnity on
selected earnings

Maximummonthly
earnings
Ded. Percent
Ben %of Ded

Deduction code developed for custom
use.
A calculation that takes the selected
earnings up to the monthly maximum
then multiples it by the pay periods to
get the annual salary. The calculation
takes 2/3 of the annual salary divided
by 12 to get the monthly salary. The
deduction is then taken as a percent of
the monthly salary. The benefit is a
percent of the deduction.
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Code Calculation Parameters Description

40 Rate * Selected Hours
to Maximum hours

Ded. Rate
Ben. Rate
Maximum hours

A calculation based on the deduction or
benefit rate times the hours of selected
earnings to maximum hours for the
deduction and benefits.
Can have employee parameters.

41 (Factor * Selected
Hourly Rate) + Fixed
Amount

Factor
Fixed amount
Rounding parameter
Ben % of ded

A calculation based on a factor times
the base hourly rate of selected
earnings rounded up if specified, plus a
fixed amount. The benefit is a percent
of the deduction. The rounding is up to
the nearest dollar if the rounding
parameter is 1 and no rounding if the
parameter is 0.

42 Life Insurance
Plan
on selected hourly rate

Ded. Rate
Ben. Rate
Multiple
Maximum per
1000
Minimum per
1000

Deduction code developed for custom
use.
The premium is calculated as a rate per
thousand on the annual salary times the
multiplier. The annual salary is
determined by the hourly rate times
hours worked times the number of pay
periods in a year. A minimum and a
maximum annual salary can be entered
to limit the calculation.
Can have employee parameters.

43 % of Monthly Salary
on selected hourly rate

Ded. Percent
Ben. Percent

Deduction code developed for custom
use.
A calculation is done on a monthly
basis done as a percentage of the hourly
rate of selected earnings for the
deduction and benefit. The monthly
earnings are calculated as the hourly
rate times the pay periods divided by
12.

Can have employee parameters.

44 % <YMPE +
% >YMPE
on selected hourly rate

% <YMPE
% >YMPE
Ben % of ded

Deduction code developed for Ontario
Hospitals.
This calculation is done on a yearly
basis on a percentage of selected
earnings less than YMPE + a
percentage greater then YMPE. The
benefit is a percentage of the deduction.
The earnings are calculated by the
hourly rate times hours worked times
the pay periods. The YMPE amount
and the number of pay periods are used
in the calculation.
Can have employee parameters.
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Code Calculation Parameters Description

45 Life Insurance Plan on
selected earnings

Ded. Rate
Ben. Rate
Multiplier
Maximum per 1000
Minimum per
1000

Deduction code developed for custom
use.
The premium is calculated as a rate per
thousand on the annual salary times the
multiplier (rounded up to the next
thousand). The annual salary is
determined by the selected earnings
times the number of pay period in a
year. A minimum and a maximum
annual salary can be entered to limit the
range of the calculation.

46 Fixed Deduction
(Benefit=% of ded.)

Fixed Ded.
Ben. % of ded

Deduction code developed for custom
use.
This calculation has the deduction as a
fixed amount and the benefit as a
percent of the deduction. Note: You
may enter custom parameters, i.e.,
Employee stock purchase - employees
can buy a fixed amount of stock in the
company and the employer will split
45, 55% of the purchase as a benefit. If
the employee purchases $200 worth of
stock, the company's benefit would be
calculated as $90 (45% of $200). The
employee's deduction would be entered
as a fixed $110 amount.
Can have employee parameters.

47 % <YMPE +
% >YMPE
pensionable earnings
+ pensionable benefits

% <YMPE
% >YMPE
Ben % ded

This calculation is done on a yearly
basis on a percentage of pensionable
earnings plus any pensionable benefits
at a percentage less than YMPE + a
percentage greater than YMPE. The
benefit is a percent of the deduction.

48 Life Insurance
(on default annual
salary)

Rate Maximum per
1000

Deduction code developed for custom
use.
The premium is calculated as a rate per
1000 on the default annual salary from
optional numeric field 1 times a
multiplier of 5 (rounded up to the next
thousand). A maximum annual salary
can be entered to limit the range of the
calculation. The benefit is equal to the
deduction.

Can have employee parameters.
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Code Calculation Parameters Description

49 Long Term Disability
on default annual
salary
(Ded. Only)

Ded. Rate Deduction code developed for custom
use.
A calculation that takes the default
annual salary from optional numeric
field 1, divided by 12 for monthly
salary. The calculation takes 2/3 of the
monthly salary up to 3000 then only 1/2
of the amount above 3000. This
amount is then rounded up to the next
dollar and then multiplied by the
deduction rate divided by 200.
Can have employee parameters.

50 Short Term Disability
on default annual
salary

Ded. Rate
Weekly Maximum

Deduction code developed for custom
use.
A calculation that takes the default
annual salary for the optional numeric
field 1, divided by 52 for the weekly
salary. The calculation takes 3/4 of the
weekly salary rounded up to the next
dollar, taken only to the weekly
maximum amount entered then
multiplied by the deduction rate divided
by 40 for both the deduction and
benefit. Can have
employee parameters.

51

Rate * Selected hours
(rounded up)

Ded. Rate
Ben. Rate

Similar to calculation code 3 except
that total hours from selected earnings
are rounded up to the next highest hour
before multiplying it by the deduction
or benefit rate.
Can have employee parameters.

52 Union Deduction on
selected hours

% Gross
% Avg. Hours
Ben rate of ded Min.
Ded.

A calculation that is done if total gross
pay is greater than zero. The lesser of
a percentage of total gross pay or total
gross pay/selected hours times avg.
hours percentage. A benefit can be
calculated as a rate times the deduction.
The deduction has a minimum
deduction to limit the range of the
calculation.
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Code Calculation Parameters Description

53 Rate * FTE Ded. Rate
Ben. Rate

A calculation of a deduction and/or
benefit rate times Full Time
Equivalency for the deduction and
benefit.

54 Fixed Amount on
selected earnings
(over minimum)

Ded. Amount
Ben. Amount
Min. Earnings

A calculation takes a fixed amount for
the deduction and the benefit, if
selected earnings are greater than the
minimum earning.

55 Life Insurance on
selected earnings

Ded. Rate
Ben. Rate
Multiplier
Maximum per 1000
Minimum per 1000

A premium is calculated as a rate per
thousand on the annual salary times the
multiplier. The annual salary is
determined by the selected earnings
times the number of pay periods in a
year. A minimum and maximum
annual salary can be entered to limit the
range of the calculation.

57 Rate * number of
units

Ded. Rate
Ben. Rate
Unit Pointer (1,2)

The calculation takes the unit pointer
and uses numeric field 1 or 2, which is
multiplied by the rate for the deduction
and/or benefit

56 % <YMPE
% >YMPE
on selected earnings
(entered YMPE
amount + FTE)

% <YMPE
% >YMPE
Ben Rate of ded.
YMPE amount

A calculation done on a pay period
basis on a percentage of full time
equivalent selected earnings less than
YMPE + a percentage greater than
YMPE. YMPE can be entered as a
parameter. The benefit is taken as a
rate times the deduction. Note: Used
on Filmon Fridays. If YMPE is not
entered then it uses the standard
YMPE.

58 % of selected earnings
(to a YTD Max.)

Ded. Percent
Ded. YTD Max
Ben. Percent
Ben. YTD Max

A percentage of selected earnings for
the deduction and/or benefit to a
maximum deduction and/or benefit.
Can have employee parameters

59 % of selected earnings
(to pay period max)

Ded. Percent
Ded. Max per PP
Ben. Percent
Ben. Max per PP

A percentage of selected earnings for
the deduction and/or benefit to a
maximum deduction and/or benefit per
pay period.
Can have employee parameters

60 % <YMPE +
% >YMPE
(on selected YTD
earnings)

% <YMPE
% >YMPE
Ben. % of Ded

Deduction code developed for custom
use.
This calculation is done on an annual
basis and takes the selected year-to-date
earnings + current earnings to
determine the annual salary. The
deduction is based on a percentage less
than YMPE + percentage greater than
YMPE. The benefit is entered as a
percentage of the deduction
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Code Calculation Parameters Description

61 Life Insurance on
selected earnings

Ded. Rate
Ben. Rate
Multiplier
Maximum per 1000

The premium is calculated as a rate per
thousand on the annual salary times the
multiplier (rounded up to the next
thousand). The annual salary is
determined by the selected earnings
times the number of pay periods in a
year. The deduction is taken at the
deduction rate on the amount above the
maximum salary and the benefit is
taken on the benefit rate on the amount
below the maximum salary. If the
annual salary is below the maximum
the deduction will be zero.

62 % <YMPE +
% >YMPE (on
selected earnings and
selected hourly rates)

% <YMPE
% >YMPE
Ben. % of Ded
Vac. Percent

Deduction code is used for Ontario
Hospitals.
This calculation is done on an hourly
basis using the selected earning rate
and hours from the selected earnings to
do an hourly calculation when
available, or else it is done on a yearly
basis on earnings from the selected
earnings. If the calculation is hourly
you multiply the hourly rate by the
vacation percent, adding it to the hourly
rate. The deduction is based on a
percentage less than YMPE + a
percentage greater than YMPE. The
benefit is a percentage of the deduction.

63 Long Term Disability
on default annual
salary

Numeric Pointer
Ded. Percent
Ben. Percent
Factor

This calculation gets the default annual
salary from an optional numeric fields
and calculates the deduction and/or
benefit as a percent of the annual salary
divided by the factor.

64 % of an average rate
to a max per pay (on
selected non-zero
hours)

Ded. Percent
Ded. Maximum
Ben. Percent
Ben. Maximum

This calculation takes the total of all the
rates from the selected earnings and
divides it by the number of rates to get
the average rate. The deduction and/or
benefit is a percentage of the average
rate to a maximum deduction and/or
benefit.
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Code Calculation Parameters Description

65 Life Insurance on
default annual salary

Ded. Rate
Ben. Rate
Multiplier
Maximum per 1000
Numeric Pointer

The premium is calculated as a rate per
thousand on the annual salary times the
multiplier (rounded up to the next
thousand). The annual salary is from
the optional numeric fields. If the
annual salary is <100 and the hours of
pay are not zero, then calculate the
annual salary times the hours worked
times the pay periods. A maximum
annual salary can be entered to limit the
range of the calculation. The deduction
and benefit are calculated and divided
by 2.

66 Long Term Disability
on default annual
salary

Ded. Rate
Ben. Rate
Weekly Max
Numeric Pointer

This calculation gets the default annual
salary from the optional number fields.
If the annual salary is <100 and the
hours of pay are not zero, then calculate
annual salary times the hours of pay
times the pay periods. The annual
salary is divided by 52 for a weekly
salary then taken at 2/3 of the weekly
max. (that should already be 2/3). The
deduction and benefit are calculated as
the rate times the weekly salary then
taken at 1/10 and divided by 4.

67 Long Term Disability
on default annual
salary

Ded. Percent
Ben. Percent
Monthly
Maximum
Numeric Pointer

The default annual salary is taken from
the optional numeric fields. If the
annual amount is <100 and the hours of
pay are not zero, then calculate annual
salary times the hours of pay times the
pay periods. The annual salary is
divided by 12 for a monthly salary up
to the monthly maximum then taken at
2/3. The deduction and benefit are
calculated as a percent of the monthly
amount divided by 4.

68 % of Net pay to YTD
MAX (Ded. Only)

Ded. Percent
Ded. YTD Max
Min. Net Pay

This calculation takes the deduction
percent up to 100% and calculates the
percentage of the net pay for a positive
deduction only. If a minimum amount
of net pay is required the deduction can
only reduce the net pay to this amount.
The deduction must not exceed the
maximum YTD deduction.
Can have employee parameters.
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Code Calculation Parameters Description

69 % <YMPE +
% >YMPE
on selected hours
(Ded. Only)

% <YMPE
% >YMPE

Deduction code developed for Sask
Teachers substitutes.
A calculation done on a daily basis on a
percentage of selected earnings below
YMPE + a percentage above YMPE.
The daily rate is calculated as earning
divided by hours worked. The number
of days worked in a year is 197.

70 Fixed Union
Deduction on selected
hours (Ded. only)

Fixed Amt Below
Fixed Amt Above
Threshold Hours

This calculation is a fixed amount
deduction for hours below or equal to
the threshold and another fixed amount
deduction for hours above. The
deduction is zero if there are no hours.
Can have employee parameters.

71 Life Insurance on
hourly rate

Ded. Rate
Ben. Rate
Multiplier
Maximum per
1000
Minimum per
1000

The premium is calculated as a rate per
thousand on the annual salary times a
multiplier (rounded up to the next
thousand). The annual salary is
determined by the hourly rate of the
selected earnings times the hours
worked times the pay periods. A
minimum and maximum annual salary
can be entered to limit the range of the
calculation.
Can have employee parameters.

72 % <YMPE +
% >YMPE
on selected earnings
(and FTE)

% CPP Earnings
% CPP Exempt
Earnings
Ben. % of ded

Deduction code developed for Sask
Teachers.
This calculation is done on a daily basis
on a percentage of full time equivalent
selected earnings that are pensionable +
a percentage that are not pensionable.
The benefit is a percentage of the
deduction. The earnings are taken at a
full time equivalency. The YMPE
amount and the number of pay periods
are used in the calculation. The
number of days worked in a year is
197.

73 % <YMPE +
% >YMPE
on selected hours

% CPP Earnings
% CPP Exempt
earnings
Ben % of Ded

Deduction code developed for Sask
Teachers.
This calculation is done on a daily basis
on a percentage of selected earnings
that are pensionable + a percentage that
are not pensionable. The earnings are
divided by the hours to get the average
daily rate. The benefit is a percent of
the deduction The YMPE amount and
the number pay period are used in the
calculation . The number of days
worked in a year is 197.

Can-Pay Computer Software 81

Data - 3

D
A
TA



Code Calculation Parameters Description

74 Long Term Disability
on default annual
salary

Ded. Percent
Ben. Percent
Annual Maximum
Numeric Pointer

Deduction code developed for custom
use.
This calculation uses the default annual
salary from the optional numeric fields.
If the annual salary is <100 and the
hours of pay are not zero, then calculate
annual salary times the hours of pay
times the pay periods taken to the
maximum annual earnings. This
amount is divided by 12 to a monthly
salary then taken at 2/3. The deduction
and benefit are taken as a percentage of
that amount.

75 Life Insurance on
default annual salary

Ded. Rate
Ben. Rate
Multiplier
Maximum per
1000
Numeric Pointer

The premium is calculated as a rate per
thousand of the annual salary times the
multiplier (rounded up to the next
thousand). The annual salary is from
the optional numeric fields. If the
annual salary is <100 and the hours of
pay are not zero, then calculate the
annual salary times hours worked times
the pay periods. A maximum annual
salary can be entered to limit the range
of the calculation.

76 Life Insurance on
selected earnings

Ded. Rate
Ben. Rate
Multiplier
Maximum per 1000
Minimum per
1000

The premium is calculated as a rate per
thousand of the annual salary times the
multiplier (rounded up to the next
thousand). The rounding is on earnings
greater than 750 rounded up to the next
thousand and greater 250 to the next
five hundred. The annual salary is
determined by the selected earnings
times the number of pay periods in a
year. A minimum and maximum
annual salary can be entered to limit the
range of the calculation.

77 % <YMPE +
% >YMPE
(on selected hours)
(prorated YMPE)

% <YMPE
% >YMPE
Ben % of Ded

Deduction code developed for custom
use.
This calculation is done on a pay period
basis as a percentage of selected
earning below prorated YMPE + a
percentage above the prorated YMPE.
The benefit is a percent of the
deduction. The YMPE amount and the
number of pay periods are used in the
calculation. The prorated YMPE is
taken as the hours worked divided by
the pay hours multiplied by the YMPE
divided by the pay periods.
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Code Calculation Parameters Description

78 % of Net Pay to a max
per pay period
(Ded. Only)

Ded. Percent
Ded, Max per pay
Min. Net Pay

This calculation takes the deduction
percent up to 100% and calculates the
percentage on the net pay for a positive
deduction only. If a minimum amount
of net pay is required the deduction can
only reduce the net pay to this amount.
The deduction must not exceed the
maximum deduction per pay.

79 Rate * selected rate of
selected hours if over
minimum hours

Ded. Rate
Ben. Rate
Min. Hours

This calculation takes the deduction
and/or benefit rate times the earning
rate times the earning rate from the
selected rates if the hours from the
selected earnings are greater than or
equal to minimum hours.

80 % of (selected
earnings less
CPP/QPP/Tax/QUE
tax/EI)
(Ded. Only)

Ded. Percent
Ded. Maximum

A calculation based on a percentage of
selected earnings less Income Tax, CPP,
EI, QPP, Que Tax to a deduction
maximum. Can have
employee parameters.

81 Rate * (selected
deductions +
QPP/QUE Tax,
CPP/EI/TAX)
(Ded. Only)

Ded. Rate A calculation based on a deduction rate
of previously calculated deductions
plus CPP, QPP, Tax, Que Tax and EI
paid for the deduction only.
Can have employee parameters

82 Fixed Amount to a
YTD Max

Ded. Amount
Ded. YTD Max
Ben. Amount
Ben. YTD Max

A calculation that uses a fixed amount
for the deduction and/or benefit to the
maximum YTD deduction and/or
benefit amount. If no maximums are
specified it uses YMPE. The deduction
and/or benefit can be zero.
Can have employee parameters.

83 % <YMPE +
% >YMPE
(Ben only)
On YTD pensionable
earnings +
pensionable benefits

% <YMPE
% >YMPE

This calculation is done on a yearly
basis of pensionable earnings plus any
pensionable benefits at a percentage
less than YMPE + a percent are greater
than YMPE. For the benefit only.

84 % <YMPE +
% >YMPE
on selected earnings
(Ben. only)

% <YMPE
% >YMPE

This calculation is done on a per pay
period basis on a percentage of selected
earnings less than YMPE + a
percentage greater than YMPE for
benefit only.
The YMPE amount and the number of
pay periods are used in the calculation.

85 Rate * Selected
Earnings divided by
UIC Hours

Ded. Rate
Ben. Rate

This calculation takes a rate times the
selected earning divided by the selected
UIC hours.
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Code Calculation Parameters Description

86 Steel Workers Union
on selected earnings
and
EI Hours

Ded. Percent
Ded. Rate
Non Selected %
Ben. rate of Ded

Deduction code developed for custom
use.
If selected earnings or non-selected
hourly earnings are greater then zero
the calculation takes the lessor of a
percentage of selected earnings or a
deduction rate of selected earnings
divided by EI hours. The calculation
adds a percentage of non-selected
hourly earnings. The benefit is a rate of
the deduction make the first sentence.

87 % of selected earnings
(to a minimum)

Ded. Percent
Ded. Minimum
Ben. Percent
Ben. Minimum

This calculates a deduction and/or
benefit percent on selected earnings and
will use the minimum deduction and/or
benefit if specified.

88 Fixed Amount on
selected hours (table
of hours)

Min. Hours (8)
Ded. Amount (8)
Ben. Amount (8)

The calculation searches the table for
when the selected hours are less than
the minimum hours in that table row,
the deduction and/or benefit are the
table item fixed amounts for that row.

89 % of taxable income
and taxable benefit

Ded. Percent
Ben. Percent

Deduction code developed for
Northwest Territory special tax. This
calculation takes a percentage of the
total income and taxable benefits for
the deduction and benefit.

90 % <YMPE +
% >YMPE
(on selected earning)

% CPP Earnings
% CPP Exempt
Earnings
Ben. Rate * Ded

A calculation done on a pay period
basis on a percentage of selected
earnings that are pensionable + a
percent that are not pensionable. The
benefit is a rate times the deduction.
The YMPE amount, the basic CPP
exempt amount and the number of pay
periods are used in the calculation.

91 Group Insurance on
selected earnings

Ben. Percent
Ben. Maximum

Deduction code developed for custom
use.
This calculation takes the benefit
percent times the selected earnings to a
maximum benefit. If the benefit is less
than the benefit maximum the
deduction will be the benefit maximum
less the benefit calculated.
Can have employee parameters.

92 Group Insurance on
selected earnings

Ben. Percent
Ben. Minimum

Deduction code developed for custom
use.
This calculation takes the benefit
percent times the selected earnings. If
the benefit is less than the benefit
minimum the deduction will be benefit
minimum less the benefit calculated.
Can have employee parameters.
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Code Calculation Parameters Description

93 Equalize Dedution
and Benefit amount
list of Deductions

This calculation adds up the deduction
and benefit amounts for the deductions
in the list and creates compensating
entries to ensure the total deduction and
total benefit amount are equal.

101 Indemnity Calculation Deduction Rate

Deduction
Percentage

Maximum Earnings

Benefit Percentage
of Deduction

This code calculates a weekly salary by
multiplying the standard per pay hours
percentage in parameter 2. The value
in Parameter 3 is used as a maximum
for the weekly salary. The deduction is
calculated as 1/10 of the percentage in
parameter 1 the benefit is calculated as
a percentage of the deduction using
parameter 4.

F Codes not appearing in the preceding list are currently disabled. If an additional
deduction calculation code is required, please contact Can-Pay technical support.

Pension deduction/benefit codes: 14, 25, 26, 29, 30, 31, 35, 44, 47, 56, 60, 62, 69, 72,
73, 77, 83, 84, 90.

Indemnity deduction/benefit codes: 32, 38, 39

Disability deduction/benefit codes: 49, 50, 63, 66, 67, 74, 91, 92
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Deduction and Benefit Examples

Field Description

Deduction Calculation Code No. 1
1) Ded = Ded. Amount
2) Ben = Ben. Amount

Ded. Amount = 5
Ben. Amount = 3
1) Ded = 5
2) Ben = 3

Deduction Calculation Code No. 2
1) Ded = Earnings * Ded. Rate
2) Ben = Earnings * Ben. Rate

Ded. Percent = 5
Ben. Percent = 3
1) Ded = 1,000 * 5/100 = 50
2) Ben = 1,000 * 3/100 = 30

Deduction Calculation Code No. 3
1) Ded = Total-Hours * Ded. Rate
2) Ben = Total-Hours * Ben. Rate

Ded. Rate = .50
Ben. Rate = .30
1) Ded = 80 * .50 = 40.
2) Ben = 80 * .30 = 24.

Deduction Calculation Code No. 4
1) Ded = Hourly Rate * Ded. Rate
2) Ben = Hourly Rate * Ben. Rate

Ded. Rate = .10
Ben. Rate = .15
1) Ded = 5.40 * .10= .54
2) Ben = 5.40 * .15 = .81

Deduction Calculation Code No. 8
1) Ded = Earning * Ded. Percent
If Ded+YTD-Ded> Ded-Max-YTD
Ded + Ded-Max-YTD less YTD-DED
2) Ben = Earning * Ben-Max-Percent
If Ben = YTD - BEN > Ben-Max-YTD
Ben = Ben. Percent less YTD - BEN

YTD-DED = 90
YTD-BEN = 50
Ded. Percent = 2
Ben. Percent = 1
Ded Max YTD = 12
Ben Max YTD = 75
Ded = 1000 * 2/100 = 20
If 20 + 90 >100 Then Ded = (100-90)
Ben = 1000 * 1/100 = 10
If 10+ 50 > 75 Then Ben = (75-50)

Deduction Calculation Code No.9
1) Ded= Earnings * Deduction Percent
If Ded + YTD-Ded > Deduction Max YTD
Ded = Ded-Max-YTD less YTD-Ded
2) Ben = 0

YTD-DED = 20
Ded. Percent = 1
Ded. Max YTD = 50
Ded = 1000 * 1/100 = 10
If 10+20 >50 Then Ded = (50-20)
2) Ben = 0

Deduction Calculation Code No. 11
1) DED = MULT-HOURS * Ded. Rate
2) Ben = 0

Ded. Rate = .10
1) Ded = 85 * .10 = 8.50
2) Ben = 0

Deduction Calculation Code No. 12
1) Ded = 0
2) Ben = Mult-Hours * Ben. Rate

Ben. Rate = .10
1) Ded = 0
2) Ben = 85 * .10 = 8.50

Deduction Calculation Code No. 13
1) Ded = Deduction Amount
If Ded + YTD=DED > DED-YTD-MAX
Ded = DED-MAX-YTD less YTD-DED

YTD-DED=15.00
Ded. Amount = 7.50
Ded. Max YTD = .75
1) Ded = 7.50
If 7.50 + 15.00> Then Ded = 75-15
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Deduction Calculation Code No. 14

If Curr- Earn > (CPP-CONST/PP)
Move (CPP-CONST/PP) to below
Move CURR-EARN-BELOW to above
else move 0 to above
Move Curr-Earn to below
Ded=(below * param (1)/100) +
(above * Param (2)/100)
Ben = Ded * Param (3)

Param (1) = 5
Param (2) = 7
Param (3) = 2
35,400 /26 = 1361.54
Above = 0
Below = 1000
Ded = (1000 * 5/100) + (0 * 7/100) = 50
Ben = 2 *50 = 100
CPP-CONST=35400
PP= 26

Deduction Calculation Code No. 15

Ded= Mult-Hours * Param (1)
Ben + Mult-Hours * Param (2)

Param (1) = .10
Param (2) = .20
Ded = 85 * .10 = 8.50
Ben = 85 * .20 = 17.00

Deduction Calculation Code No. 20

Annual = Curr-Earn * PP * Param (3)
Rounded up to next thousand
If annual < Param (s) * 1000 Then
Annual = Param (5) * 1000
If Annual > Prama (4) * 1000 Then
Annual = Param (4) * 1000
Ded = Annual * Param (1) /1000
Ben = Annual * Param (2) /1000

Param (1) =.15
Param (2) =.25
Param (3) = 2
Param (4) =55
Param (5) = 25
Annual = 1000 * 26 * 2 = 52000
If 52000 < 15000 Then annual = 15000
If 5200 > 15000 then annual = 55000
Ded = 52000 * .15/10000 = 7.8
Ben = 52000 * .25/1000 = 13.00
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Accumulators

Payroll Accumulator Types

What is an Accumulator used For?

Accumulator types are used to define the method used to accumulate values based on
other values processed during the payroll calculation.

Examples of Accumulator Types

Value to Accumulate Description

Vacation Entitlements Vacation entitlements are commonly calculated at a percentage of
the earnings that are subject to vacation pay. Different base rates
apply in different provinces. For example: in Manitoba vacation
entitlements are accumulated at a rate of 4% on regular earnings.

Sick Pay Sick pay entitlements may be calculated as a percentage of the
total amount of a selected list of earnings.

Seniority Seniority is commonly calculated as the total hours worked for a
selected list of earning types.

Creating the Master Accumulator Types

GrandMaster Suite Payroll allows you to have up to 200 different accumulator types.
Each type determines a category of accumulator for an employee. The
ACCUMULATORS choice on the DATA menu is used to access the accumulator
update function.

Because the GrandMaster Suite payroll supports date sensitive processing, several
accumulators of each typemay be present. Each onewill cover a particular date range.
When you insert a new accumulator with the same number as an existing one youmust
specify a date range for the new accumulator that is later than the date range in use for
the existing accumulator.
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TheAccumulator List screen is displayed when you select theAccumulators option
from the Data menu. The Accumulator list screen appears as follows:

The window title may be either Payroll Accumulators List or Global Accumulators
List depending onwhether or not you are sharing the accumulatorswith other payrolls.
(Global Accumulators are shared between payrolls, Payroll Accumulators are not
shared).

OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

CANCEL The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.

INSERT The INSERT button is used to insert a new accumulator to the list.

UPDATE The UPDATE button is used to update an existing accumulator in the list.

DELETE The DELETE button is used to delete an existing accumulator in the list.
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The INSERTbutton is used to add a new accumulator type to the list. When this button
is pressed a dialog box will appear that asks for the accumulator type number. The
Insert New Accumulator screen appears as follows:

If you enter the number of an existing accumulator type, that accumulator will be
retrieved for update.

It is recommended that the accumulator codes be assigned in numeric sequence
beginning at number 1. This will improve processing and display times.

The Accumulator Update screen contains a notebook with seven pages. Each of these
pages contains information that is used for the processing of accumulators.
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The General page contains fields for describing the accumulator and setting the
effective date range of the accumulator type.

When you select the General tab on the Accumulator Update the following screen
will appear:

The following table gives a description of the screen:

Field Description

Accumulator This field displays the code number of the accumulator.

Description The long description is used for reporting, and for descriptions on
screen displays.

Short The short description is used on pay statements.

From This field is used to set the starting date of the effective date range
for the accumulator.

Until This field is used to set the end date of the effective date range for
the accumulator.

Accumulator

Usage Control

This field contains two buttons that are used to Enable or Disable
the uses of the accumulator type. When the accumulator type is
disabled the accumulator will not be used for pay processing.
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The Fixed page contains fields that are used to input fixed amounts for the
accumulator processing. When you select theFixed tab on theAccumulatorUpdate

the following screen will appear:

The following table gives a description of the screen:

Field Description

Fixed Values

Amount This field contains the values that should be accumulated for an
employee for each period based on the values in the Evaluation
box.

Units This field contains the values that should be accumulated for an
employee for each period based on the values in the Evaluation
box.

Use Fixed Values If this box is checked the amount/units in the fixed value fields
will be processed according to the parameters set for the evaluation
period and will disregard any calculation results.

MaximumValues

Amount This field restricts the amounts accumulated to the maximum value
in the field. If the field contains zero(blank) the accumulator is not
restricted to a maximum value.

Units This field restricts the units accumulated to the maximum value in
the field. If the field contains zero (blank) the accumulator is not
restricted to a maximum value.

YTDMaximums

Amount This field restricts the amounts accumulated to the YTD maximum
in the field. If the field contains zero(blank) the accumulator is not
restricted to a maximum YTD value.

Units This field restricts the units accumulated to the YTD maximums in
the field. If the field contains zero (blank) the accumulator is not
restricted to a maximum YTD value
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The Calculate page is used to set the values for the calculation to determine the
amounts to be added to the accumulator. When you select the Calculate tab on the
Accumulator Update, the following screen will appear:

The following table gives a description of the screen:

Field Description

Calculation Code This field is used to enter the number of the calculation code that will
be used to calculate the value to add to the accumulator. A list of
calculation codes can be displayed by pressing the F8 key when the
Calculation Code field is selected.

Parameter Table This field is used to enter the name of a parameter table. A list of the
tables already defined can be obtained by pressing the F8 key when
the Parameter field is selected.

Parameter Group This field is used to enter the default group (row) for the accumulator
type.

Custom Parameters This field is used to determine if a Named Table or a Custom
Parameter table will be used in the calculation for the accumulator
type.

Parameters This area contains fields used to call up a screen that is used to enter
the custom parameters.

Selection This area contains fields used to select the earnings, deductions, or
benefits that will be used for this calculation code.
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The PARAMETERS button is used to call up a screen that is used to enter the custom
table parameters. The screen shows a list of the values in the parameter table. The
Custom Accumulators Parameter Table appears as follows:

The values in a row of the list are updated by double-clicking on the row. This will
display a screen that is used to update the individual parameters in the row. The
employee accumulator set up will select a particular row in the table to use for the
employee calculation.

The SELECTION button is used to call up a screen that can be used to select the
earnings, deductions, or benefits that will be summarized for this calculation code.
The Payroll Earnings Selection screen appears as follows:

The calculation code requirements decides the type of list thatwill be displayed. Items
in the list are selected by clicking on themwith themouse. Any number of items can be
selected from the list. You may also use the Include/Exclude buttons to indicate an
exclude list rather than an include list. An exclude list selects only the items that are
NOT to be included for the calculation.
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The Flags page contains settings that are used to control the use of the accumulator
type. When you select the Flags tab on the Accumulator Update the following
screen will appear:

The following table gives a description of the screen:

Field Description

Journalize Accumulator This field is used to indicate that you want the values
added to or subtracted from the accumulator type to be
included in the payroll journal entry.

Print Accumulator on Cheque This field is used to indicate that you want the value of
the accumulator to be printed on the cheque stub.

Automatic Payout This field is used to indicate that you want any amounts
added to the accumulator during the pay calculation to
be immediately paid out using the prime earning set on
the Earnings Page.

Allow Negative Accumulator This field indicates that you want the accumulator to be
allowed to be negative when subtracting amounts from
that accumulator.

Set Opening Balance to Result This field is used to indicate that the opening value of
the accumulator at the beginning of an evaluation
period is set to either the results of a calculation or the
fixed values established clearing any previous balances.

Accumulator Use This field indicates the type of accumulator being setup.
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The Control Page is used to set the conditions for the use of the deduction type by
employees. When you select the Control tab on the Accumulator Update the
following screen will appear:

The following table gives a description of the screen:

Field Description

Accumulator Usage Control: This box contains four buttons that determine the

default processing of the accumulator for the employee.

Must Turn On for

Employee

This field sets the option that requires that the deduction
be enabled at the employee level before the accumulator
will affect the employee�s pay.

Always On for Employee This field sets the option that the accumulator will always
affect all employees� pay. This option prevents the
accumulator from being turned off for an employee.

May Turn Off for

Employee

This field sets the option that the accumulator will affect
the employees pay unless the accumulator is disabled at
the employee level.

AllowModification at

Employee Level

This field allows the selection of or changes to parameter
values for the calculation of the accumulator. If this is not
turned on no changes to the default parameters are allowed
at the employee level.

Evaluation: this box provides for several different types of evaluations periods

which can be selected from for determining when an accumulator will calculate.

Per Pay When this option is selected the accumulator processing
will occur for each pay period. The system automatically
defaults to this option.

Per Month When this option is selected the accumulator processing
will occur once for each month. The �month� box must
have the first month that this evaluation period will begin
entered. If no day is input to the �day/pay number box�
the system defaults to the first day of the month.
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Field Description

Pay Period of Month When this option is selected the accumulator processing
will occur on the specified �day/pay number� that has
been input.

Employee Anniversary When this option is selected the accumulator processing
will occur on the annual anniversary of each employee
according to their payroll specific dates. This is also
dependent on the accumulator usage being set accurately.

Per Quarter When this option is selected the accumulator processing
will occur once every three months. The first month of the
first quarter of the fiscal or calendar year must be specified
in the �month� box. If no �day/pay number� is specified
the system will default to the first day of the quarter.

Per Year When this option is selected the accumulator processing
will occur once a year. The first month of the fiscal or
calendar year must be specified in the �month� box. If no
�day/pay number� is specified the system will default to
the first day of the year month.

Pay Day of Month When this option is selected the accumulator processing
will occur on each specified pay day of each month. The
�day/pay number� must be input.

Company Anniversary When this option is selected the accumulator processing
will occur on the company specified anniversary date from
the payroll date notebook. This is also dependent on the
accumulator usage being set accurately.
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The Earnings page contains fields that are used to set the Prime Earning for an
accumulator type and to set up a list of additional earnings for an accumulator type.
When you select the Earnings tab on theAccumulator Update the following screen
will appear:

The following table gives a description of the screen:

Field Description

Prime Earning This field contains the earning type that will be used to pay out
values from the accumulator in most circumstances.

Additional

Earnings/Update

This field contains a list of additional earnings that can beselected
from to reduce an accumulator once the update button is pressed.
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When you choose the Selections tab on the Accumulator Update the following
screen will appear:

The following table gives a description of the screen:

Field Description

Select Positions This button is used to select positions for the accumulator update.

Select Categories This button is used to select categories for the accumulator update.

Select Provinces This button is used to select provinces for the accumulator update.

Include When this box is checked the position, category or province will be
included in the update.

Exclude When this box is checked the position, category or province will be
excluded from the update.
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Accumulator Calculation Codes

No. Option Code Description

1 % of Earnings Calculation will be performed based on selected
earnings times the employee�s rate, and the resulting
answer will be added to the accumulating balance.

2 % of Earnings (Taxed) Calculation will be performed based on selected
earnings times the employee's rate, and the resulting
answer is taxed in the current pay period, then
added to the accumulating balance.

3 % of Hours Calculation will be performed based on selected
hours times the employee's rate, and the resulting
answer will be added to the accumulating balance.

4 Fixed Amount This calculation code allows for a fixed dollar
amount to be added to the accumulator balance.

5 No Calculation No calculation is performed.

6 Fixed Hours This calculation code allows for a fixed number of
hours to be added to the accumulator balance.

7 Rate * Hrs/Norm Hrs

(Rate of Hourly Rate)

Calculation will be performed based on selected rate
times the total hours divided by normal hours, and
the resulting answer will be added to the
accumulating balance.

8 % of Earnings (Taxed, WCB) Calculation will be performed based on selected
earnings times the employee's rate, and the resulting
answer is taxed in the current pay period, subject to
WCB, then added to the accumulating balance.
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Accumulator Processing

Accumulator Treatments

Vacation Accumulator

n Vacation accumulators will track a ten (10) year history of vacation
entitlements plus the current year.

n If the vacation is not taken within a 10 year period the vacation entitlement is
retained as if it occurred for the tenth year.

n When vacation is taken the oldest vacation entitlement is reduced first.

n Vacation taken or paid out is always paid at the current rate of pay for the
employee. The rate is based on the pay rate specified for the accumulator�s
prime earning.

Re-valuation of vacation dollar amounts.

n When the vacation accumulator is processed during a pay calculation the value
of the vacation entitlement hours is calculated using the accumulator prime
earning rate. If this valuation results in a different dollar value for the vacation
entitlements in prior years, a transaction will be generated for the journal entry
that contains the dollar value change for the entitlement. The value of the
change will be allocated to the accumulators expense & liability accounts.

n When vacation entitlements is acquired as a dollar % of earnings, the hour
entitlements will be calculated based on the accumulator prime earning.

Paying out Vacation

Three transactions are available that will pay out vacation entitlements.

1. Payout all of an accumulator balance. This transaction pays out the entire
balance of an accumulator.

2. Payout part of an accumulator balance. This transaction pays out a specified
number of hours & dollars of an accumulator.

F If the dollar value paid out does not reflect the number of hours at the current rate of
pay the accumulator dollar balance will be subject to revaluation.

3. Earnings transaction for the prime earning or one of the additional earnings
specified for an accumulator.

F Method 1 or Method 3 are the preferred techniques for paying out vacation
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Paying out Vacation for Salaried Personnel

When an employee has a �permanent� number of hours set for regular wages, the
earning used for vacation taken should be set up to �contra� the regularwages earning.

When vacation is �contra� to regular wages, the amounts for vacation taken is
subtracted from regular wages.
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Distribution Tables

Distribution tables are used to define the relationship between payroll earnings,
deductions, benefits, accumulators, and statutory deductions and your general ledger
package.

A distribution table contains the general ledger codes that are associated with the
payroll earnings, deductions, benefits, and statutory deductions. These general ledger
codes are used when the payroll prepares the journal entry file for export to your
general ledger.

Each payroll has a default distribution table that is used when no other distribution
table specification is available. Distribution tables can be associatedwith individual
employees or with positions. The Employee Hours Entry data entry functions can
specify a distribution table code with each entry line.

When the pay calculation is done the amounts for earnings, deductions, benefits, and
statutory deductions are summarized by the distribution table used for the amount.
These summaries are then used to produce the journal entry file.

Distribution tables are used so that the person processing employee hours does not
have to be familiar with the company general ledger coding structure. The entry work
only requires that the nameof a distribution table be associatedwith the hoursworked.

The DISTRIBUTION TABLES choice under the DATAmenu on the payroll menu is
used to display a list of the existing distribution tables. The distribution tables screen
appears as follows:

INSERT The INSERT button is used to insert a new distribution table.

COPY The COPY button is used to make a copy of an existing table.

UPDATE The UPDATE button is used to update the distribution table that is selected

DELETE The DELETE button is used to delete a distribution table.

Can-Pay Computer Software 103

Data - 3

D
A
TA



When the INSERT button is pressed a dialog box is displayed that requests the name
of the table to insert. The Insert New Table screen appears as follows:

The Distribution Table Update screen displays the existing statutory deductions,
earnings, deductions and accumulators in a list box. This screen appears as follows:

The following table gives a description of the screen:

Field Description

Code This field contains the code of the distribution table. Several distribution
tables may be present with the same code as long as they have different
effective date ranges.

Description This field contains a description of the distribution table.

Effective Date

Range

This field allows you to enter the start and end date of the date range for
which the distribution table record will be in effect.

General Ledger

Distribution

Table

This field displays the different earnings, deductions and accumulators
present in the payroll. Beside the description of the item the general
ledger codes associated are listed.

These fields are grouped by class. The classes used are: Payroll,
Statutory, Earnings, Deductions and Accumulators.
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OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

CANCEL The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.

UPDATE The UPDATE button will update the distribution table.

An item on the list can be updated by double-clicking on the item, or by selecting the
item and then pressing the UPDATE button. The following screen will appear:

A dialog box is displayed to update the general ledger codes for each item. The
number of general ledger codes requested depends on the type of the item. Payroll
items require the entry of only a single general ledger code. Statutory items require
two general ledger codes, one for the liability, the second for the expense. Earnings
require the entry of a single general ledger code. Deductions require the entry of up to
four general ledger codes, a liability and expense for the deduction and a liability and
expense for the benefit. Accumulators require the entry of up to four general ledger
codes, a liability and expense for the accrual of the accumulator amounts and a liability
and expense for the pay out of the accumulator amounts.
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Employee Model Definition

The following submenu is available under the EmployeeModelDefinition option in
the Data menu:

Two functions are available to you here. You may:

n Define an employee model

n Update employees with a model
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Employee Model Definition

Employee Models are used to simplify the set up of employee earnings, deductions
and accumulators, and to allow the mass update of the employees in a particular class
when changes are made to the earnings, deductions and accumulators for a class of
employees.

An Employee Model contains a list of earnings, deductions, and accumulators that
have been set up for the employees in the class. When a new employee is added to the
payroll, specify the class for the employee and the employees earnings, deductions
and accumulators will be automatically set up according to the model as previously
defined.

The Employee Model Definition choice in the Data menu is used to set up and
maintain the employeemodel definitions. This choice displays a list of the employee
models that have been defined. The Employee Model List screen appears as
follows:

OK TheOK button, or the Save option in the File menu, will save any changesmade in the
dialog box.

CANCEL The CANCEL button, or the Exit option in the File menu, will exit the dialog box
without saving any changes.

INSERT The INSERT button is used to insert a new employee model.

COPY The COPY button is used to make a copy of an existing employee model.

UPDATE The UPDATE button is used to update the employee model that is selected.

DELETE The DELETE button is used to delete an employee model.

Can-Pay Computer Software 107

Data - 3

D
A
TA



When the INSERT button is pressed the following screen will appear:

The Employee Model Update screen is used to mark the earnings, deductions, and
accumulators that are assigned to employees in the model. The screen contains a
notebook with four pages. Three of the pages contain lists of the earnings, deductions
and accumulators that are used for the Employee Model. The fourth page contains
settings for several of the payroll specific information fields.

When you select the Earnings tab on the Employee Model Update, the following
screen will appear:

The following table gives a description of the data fields.

Field Description

Code This field contains a code name or number of the model
update

Description This field contains a description of the model update.

From This field contains the starting date of the Employee model
update.

To This field contains the ending date of the employee model
update.

Earnings The EARNINGS button brings up a list of existing earnings tp choose from. Select
one or more earnings that apply to the Employee Model being defined.
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Selecting the Deduct(deductions) tab will cause the following screen to appear:

Deductions The DEDUCTIONS button brings up a list of existing deductions to chose from.
Select one or more deductions that may apply to the model being defined.

Selecting the Accum(accumulators) tab will cause the following screen to appear:

Accumulators The ACCUMULATORS button brings up a list of existing accumulators to choose
from. Select one or more accumulators that may apply to the model being defined.
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Selecting the SETTING tab will cause the following screen to appear:

The following table gives a description of the data fields:

Field Description

Code This field contains a code name or number of the model
update

Description This field contains a description of the model update.

From This field contains the starting date of the model update.

To This field contains the ending date of the model update.

Rev Can This field indicates whether Revenue Canada full rate or
reduced rate applies.

Base Earning This field contains the base earning code. If you press the
F8 key while in this field, a list of existing earnings will
appear.

Position This field contains the position of the employee. If you
press the F8 key while in this field, a list of existing
positions will appear.

Distribution This field contains the name of the distribution table. If you
press the F8 key while in this field, a list of existing
distribution tables will appear.

WCB This field contains the WCB code.

WCB Province This field contains the WCB province. If you press the F8
key in this field a list of existing provinces will appear.

Stats Can These fields contains the Statistics Canada codes.

110 Can-Pay Computer Software

3 - Data



Update Employees with Model

This screen is used to update the employee settings for earnings, deductions, and
accumulators used with any changes made in the employee model. Only employees
set up with the model are affected.

The following table gives a description of the screen:

Field Description

Model This field is used to enter the model name.

Remove Types This check box is used to remove earnings, deductions and
accumulators that are not in the employee model.

F The option to Remove Types will delete types set up for the employee that are not
present in the model.
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Calendar Update

The Payroll module allows the use of special processing for specific dates through a
system calendar. This calendar may be used to specify statutory and special company
holidays. When the organization chart position requirements are used the calendar
may also be used to control the inclusion or exclusion of positions for scheduling.

The Calendar Update option brings up the following dialog box when selected:

The date can be entered by typing it in or by selecting a defined calendar date from a
list.

F8(list) A list of all the defined calendar dates will appear if the F8 key is pressed, or by
selecting the List option from the File menu. The list will appear as follows:

F If no dates have been previously defined then the list will appear empty.

The list contains the following information from left to right: date, stat holiday code,
company holiday code, excludes (a 1 character code, up to 100 of which can be
entered), and includes (a 1 character code, up to 100 of which can be entered).
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From this screen the user can insert new calendar dates (using the INSERT button),
update defined calendar dates (using the UPDATE button), or delete defined calendar
dates (using the DELETE button).

Update The OK button, or the Update option in the File menu, will allow the user to change
the data for the currently entered date. A date must be entered into the Calendar
Update Date Selection dialog box for this function to work. A dialog boxwill appear
as follows:

The following data fields require input:

Field Description

Includes This field may hold up to 100 one character codes to be flagged as included in
the schedule processing.

Excludes This field may hold up to 100 one character codes to be flagged as excluded
from the schedule processing.

Stat Holiday This field holds the code to define the date as a statutory holiday.

Company

Holiday

This field holds the code to define the date as a company holiday.

Esc (exit) The ESC key, the CANCEL button or the Exit option from the File menu will exit the
dialog box without saving changes.
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Defining a New Calendar Date

To define a new calendar date do the following:

1. Select the Calendar Update option from the Setup menu. The Calendar
Update Date Selection dialog box will appear as follows:

F If the date to be defined is already known without checking which dates have been
previously defined in the system, then enter the date directly into the Calendar Update
Date Selection dialog box, and select the OK button, or the Update option from the
Filemenu. This actionwill bypass the Calendar List Screen and bring up the Calendar
Update dialog box, therefore skip to step five. Otherwise, carry on with step two.

2. When the Calendar Update Date Selection dialog box appears select the F8

key, or the List option from the File menu to obtain a list of all defined
calendar dates. The Calendar List Screen will appear as follows:

For information about the contents of this screen, refer to Calendar Update section of
this manual on the previous page.
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3. Select the INSERT button at the bottom of the Calendar List Screen to enter in a
new calendar date. A dialog box will appear as follows:

4. Enter the date in the Insert New Date dialog box, and select the OK button.
The Calendar Update dialog box will appear as follows:

5. Within the Calendar Update dialog box enter the required information to
define the calendar date.

For information about the data fields within this dialog box see the previous
description of this dialog box in theCalendarUpdate section of thismanual, page 113.

6. Select the OK button, or the Save option from the File menu, when all the
information has been entered correctly.
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Deleting an Existing Calendar Date

To delete a previously defined calendar date follow these steps:

1. Select the Calendar Update option in the Data menu.

2. When the Calendar Update Date Selection dialog box appears press the F8 key,
or the List option from the File menu to obtain a list of all defined calendar
dates.

3. Move the selection bar to the calendar date to delete.

4. Select the DELETE button at the bottom of the Calendar List Screen.

5. A message will appear asking you to confirm the deletion. Select the YES

button to delete, the NO button to cancel the deletion process.
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Standard Work Week

Selecting the Standard Work Week option from the Data menu will bring up the
following dialog box:

The following table contains descriptions of the data fields within the dialog box:

Field Description

Days of Week This field contains the days represented by the day of the week. Sunday - 1
Monday - 2 etc.

Hours in Week This field contains the total number of hours worked in a week.

Hours by Day This table breaks out the hours worked per day. If you change the hours in a
day the total hours in the week will be updated.

OK The OK button, or the Save option from the File menu, will save any changes made in
the dialog box.

Cancel The ESC key, CANCELbutton, or theExit option from the Filemenuwill exit the dialog
box.
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Standard Earnings Use

Selecting theStandardEarningsUseoptionwill bring up the following dialog box:

The following table contains descriptions of the data fields in the dialog box:

Field Description

Payroll This field contains the name of the currently selected payroll.

Vacation This field is used to enter the earning that will be used for vacation pay.

Stat Holiday This field is used to enter the earning that will be used for statutory holiday
pay.

Sick Leave This field is used to enter the earning that will be used for sick leave pay.

Training This field is used to enter the earning that will be used for training pay.

Time Off in

Lieu

This field is used to enter the earning that will be used for time off in lieu pay.

On Call This field is used to enter the earning that will be used for on call pay.

Other Leave This field is used to enter the earning that will be used for other leave pay.
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F8 (list) The F8 key, or theList option from the File menu, will bring up a list of earning types,
as follows:

The fields shown in the list box are:

Field Description

Earning Code This code is used to identify the earning.

Earning Description This code is the description used to describe the
earning.

OK The OK button, or the Save option from the File menu, will save any changes made in
the dialog box.

Cancel The ESC key, CANCEL button, or Exit option from the File menu, will exit the dialog
box without saving any changes.
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Type Earnings When the TYPE EARNINGS button is selected the following screen will appear:

This screen is used to set up different earnings for each type of leave. When payout of
different types must be differentiated by earning type, an earning is assigned to the
leave type.

For Example: Sick leave may be paid out as personal or family sick leave.

Other Leave typesmay require different earning types for union leave, unpaid leave of
absence, or paid leave.
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Import

When the user selects the ImportFunctions option from theDatamenu, the following
screen will appear:

The following options are available to the user:

n Import Pay Hours

n Import Overrides

n Import Employee Names

n Export Employee Names

n Export Pay Hours
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Import Pay Hours

When the user selects Import Pay Hours from the Data menu, the following screen
will appear:

The following table gives a description of the data fields.

Field Description

Filename to Import This field contains the filename you want to import.

Delimited File Choosing the �Delimited� file button will use the field
position numbers on the �Delimited� tab to interpret the file
data.

Fixed Length Choosing the �Fixed Length� file button will use the field
offset and lengths on the �Fixed� tab to interpret the file data.

Skip Records with no

Earning Code

When this field is checked the pay hour import will skip
records with no earning codes.

Print Valid Imports on

Verify

When this field is checked the pay hour import will print a list
of valid imports to verify.

Skip Records with no

Import Values

When this field is checked the pay hour import will skip
records with no import value.

Default Date This field contains the default date if it is not on file.
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When the user selects theDates tab from the Import PayHours, the following screen
will appear:

The following table gives a description of the data fields.

Field Description

Date Format This field contains a list of date formats for the Payhour
Import.

Year Option The year option box contains options that specify the
handling of the year for dates in imported data.

YYYY Year The �YYYY Year� check box indicates that the import data
contains a full four digit year in any date fields.

Starting Century The �Starting Century� field is used to insert a value for
the first two digits of a four digit year.

Century Break The �Century Break� is used to set the year that will be
used to advance the century. For example a value of �20�
would make years of 1921 to 1999 and years of 2000 to
2020.
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When the user selects theDelimited tab from theDatamenu, the following screenwill
appear:

The following table gives a description of the screen.

Field Description

Field Position The field position is the number of fields starting
from the left-most data field in the file.

Example:�

4798�,10,19971001,�Plant�,7.95,42.5

Position 1 This field contains the employee number.

Position 2 This field contains the earning number.

Position 3 This field contains the date number.

Position 4 This field contains the distribution code.

Position 5 This field contains the pay rate

Position 6 This field contains the hours.

This example would be represented by the Payhour Import screen shown above.
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When the user selects the Fixed tab the following screen will appear:

Field Description

Field Position The field position is the number of bytes (characters) from the left-most
byte in the record, up to and including the first byte of the data. The
length is the number of bytes for the data.

File Data -

4798001019971001PLANT00007.9500042.50

Ý Ý Ý Ý Ý Ý

1 5 9 17 22 30

Field Description

Employee Number This field is Position 1 Length 4.

Earning This field is Position 5 Length 4.

Date This field is Position 9 Length 8.

Distribution Code This field is Position 17 Length 5.

Rate This field is Position 22 Length 8.

Hours This field is Position 30 Length 8.

This example would be represented by the Payhour Import screen shown above.
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Import Overrides

When the user selects the Import Overrides option from the Data menu, the
following screen will appear:

The following table gives a description of the data fields.

Field Description

Filename to Import This field contains the filename you want to import.

Delimited File Choosing the �Delimited� file button will use the field
position numbers on the �Delimited� tab to interpret the file
data.

Fixed Length Choosing the �Fixed Length� file button will use the field
offset and lengths on the �Fixed� tab to interpret the file data.

Type of Override to Import This allows you to select whether to import earning,
deduction, or accumulator overrides.

Skip Records with no

Transaction Code

When this field is checked the pay hour import will skip
records with no transaction codes.

Print Valid Imports to

Verify

When this field is checked the pay hour import will print a list
of valid imports to verify.

Skip Records with no

Import Values

When this field is checked the pay hour import will skip
records with no import value.
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When the user selects theDates tab from thePayhourOverride, the following screen
will appear:

The following table gives a description of the data fields.

Field Description

Date Format This field contains a list of date formats for the Payhour
Import.

Year Option The year option box contains options that specify the
handling of the year for dates in imported data.

YYYY Year The �YYYY Year� check box indicates that the import data
contains a full four digit year in any date fields.

Starting Century The �Starting Century� field is used to insert a value for
the first two digits of a four digit year.

Century Break The �Century Break� is used to set the year that will be
used to advance the century. For example a value of �20�
would make years of 1921 to 1999 and years of 2000 to
2020.
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When the user selects the Delimited tab from the Payhour Override, the following
screen will appear:

The following table gives a description of the screen.

Field Description

Field Position The field position is the number of fields starting
from the left most data field in the file.

File Data -

4798�,10,19971001,�Plant�,7.95,104.5

Position 1 This field contains the employee number.

Position 2 This field contains the number of units.

Position 3 This field contains the date number.

Position 4 This field contains the distribution code.

Position 5 This field contains the pay rate

Position 6 This field contains the amount.

This example would be represented by the Payhour Override screen shown above.
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When the user selects the Fixed tab, the following screen will appear:

The following table gives a description of the screen:

Field Description

Field Position The field position is the number of byte from the left most byte in the
record up to and including the first byte of the data. The length is the
number of bytes for the data.

File Data

4798001019971001PLANT00007.9500104.50

Ý Ý Ý Ý Ý Ý

1 5 9 17 22 30

Field Description

Employee Number This field is Position 1 Length 4.

Units This field is Position 5 Length 4.

Date This field is Position 9 Length 8.

Distribution Code This field is Position 17 Length 5.

Rate This field is Position 22 Length 8.

Amount This field is Position 30 Length 8.
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Import Employee Names

When the user selects import employee names from the Data menu the following
screen will appear:

The following table gives a description of the data fields:

Field Description

Filename to

Import

This field contains the filename you want to import.

Fixed Length Choosing the �Fixed Length� file button will use the field offset and lengths on the
�fixed� tab to interpret the file data.

Delimited File Choosing the �Delimited� file button will used the field position numbers on the
�Delimited� tab to interpret the file data.

Date Format This field contains a list of date formats for the Payhour Import.

Year Option This year option box contains options that specify the handling for the year for dates in
imported data.

Starting

Century

The �Starting Century� field issued to insert a value for the first two digits of a four
digit year.

Century

Break

The �Century Break� is used to set the year that will be used to advance the century.
For Example a value of �20� would make years of 1921 to 1999 and years of 2000 to
2020.
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When the user selects the delimited tab from the file menu the following screen will
appear:

The following table gives a description of the screen:

Field Description

Field Position This field position is the number of fields starting from the left most
data field in the file.

File Data - �4798�,10,19971001,�Plant�,7.95,42.5

Position 1 This field contains the employee number.

Position 2 This field contains the earning number.

Position 3 This field contains the data number.

Position 4 This field contains the distribution code.

Position 5 This field contains the pay rate.

Position 6 This field contains the hours.
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When the user selects the Fixed tab the following screen ill appear:

The following dialog box gives a description of the screen:

Field Description

Field Position This field position is the number of byte from the left most byte in the
record up to and including the first byte of the data. The length is the
number of bytes for the data.
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Export Employee Names

When the user selects the export employee names from the Data menu the following
screen will appear:

The following table gives a description of the data fields:

Field Description

Filename to Export This field contains the file name you want to export.

Date format This field contains a list of date formats for the Employee
Master Export.

Date Separator This option allows for a selection of a character type to
break a date field into its components.
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When the user selects the field tab from the data menu the following screen will
appear:

The following table gives a description of the data fields:

Field Description

Field Position This field position is the number of fields starting from the left most data
field in the file.
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Payhour Export

When the user selects the Pay hour export from the datamenu the following screenwill
appear:

The following table gives a description of the data fields:

Field Description

Start This field contains the starting date of the effective date range for the
Payhour export.

Filename for Export This field contains the filename you want to export.

Date Format This field contains list of date formats for the Payhour Export.

YYYY Year The �YYYY Year� check box indicates that the export data contains a
full four digit year in any date field.

Date Separator This option allows for a selection on a character type to break a date
field into its components.
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When the user selects the field tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Field Position The field position is the number of fields starting from the left most data
field in the file.
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When the user selects the select tab from the Data menu the following screen will
appear:

Select Export

Objects

This box provides additional fields selectionwhichmay also be exported. In choosing
one or more of these selection types, the system will present a screen listing of any
existing items set up in each selection type. One or more choices can be made from
each selection list presented. The selection permitted for export are:

1. Areas

2. Subareas

3. Activities

4. Subactivities

5. Position

6. Earnings

7. Reasons

The location of these export items has been defined on the fields tab.
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Groups

When the user selects the Groups menu the following screen will appear:

The user has the following options:

n Select Employee Group

n Load Employee Group

n Refresh Selection Group

n Modify Current Group

n Sort Selection Group

n Enable Employee Group

n Disable Employee Group
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Selection Groups

A selection group is a list of employees that may be used to control processing in the
Payroll, Human Resources, Scheduling, and Time Keeping modules.

A selection group is created through the Groups option on the Payroll main menu.

A selection group may be a dynamic or a fixed group.

Dynamic Groups

Adynamic group is defined by a set of conditions that determinewhich employees that
the group will consist of.

Each time the group is loaded the load process scans the employee data to determine
eachmember�s eligibility. Once loaded the group of employees is static until the group
is refreshed or loaded again.

When a dynamic group is saved only the data conditions for the list are stored.

One dynamic group definition utility is provided:

n Payroll Data Conditions - The Payroll Data condition is used to define a
selection group within a particular payroll. The definition uses a fixed set of
payroll data fields to determine membership in the group.

Fixed Groups

A fixed group is defined as a list of specific employees.

When the group is loaded the list is loaded from the storage area.

Fixed group definitions are determined by selecting employees from a list of eligible
employees. The list of employees may be from an existing group selection, all
employees, or employees in a particular payroll.
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Defining Employee Selection Groups

Employee Selection Groups may be defined in two ways:

Picking employees from a list of all employees known to a single payroll on
the system.

Selection of employees from a single payroll by setting conditions that payroll
data items for the employees must match.

The first type of selection group is a fixed list, thus the list must be maintained by the
user. Amaximumof 1000 employeesmay be present in a fixed list. The second type is
a dynamic list, therefore each time the list is loaded the employee data is compared to
the conditions that define the selection. A dynamic list may contain any number of
employees.

The system provides for saving and loading any number of the selection group types.
Only one selection group may be active at a time.

Selection Group Restrictions

Auser IDmay be restricted to the use of a single selection group. The restriction and
nameof the selection group are set through theSystemAdministration functions.

The selection group restriction feature allows the System Administrator to control
any user's access to employees to an arbitrary sub-set of all employees on the system.

When a user ID is restricted to a particular selection group only the employees in that
selection group are visible to him or her. When restricted, the user ID does not have
access to the functions that allow maintenance of the selection group definitions.

The user may remove employees from the selection group but this modification is
discarded the next time he or she refreshes the selection group or logs off the system.
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Selection Group Processing

System functions that process more than one employee at a time will use the current
selection group (loaded and enabled) to determine the employee to process.

When a screen offers anext employee option, the next employee is always provided in
the order of the current selection group. The sort order of the current selection group
may be changed through the sort selection option.

When a report is generated the employees included in the report are restricted to the
current selection group (loaded and enabled). This feature allows for easy production
of sub-set reports.

Mass update options are restricted to the employees in the current selection group
(loaded and enabled). This feature can be used to avoid repetitive data entry for
employees.

Data Conditions for Selection Groups

A dynamic selection group definition is composed of three parts:

n Include Conditions - these conditions describe the data values that the
employee must have to be considered in the selection group.

n Exclusive Conditions- these conditions describe the data values that will result
in the employee being dropped from the selection group if the included
conditions are satisfied.

n Sort Order - these data fields are used to provide the initial sort order of the
selection group.
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Selecting an Employee Group

This menu option will start up the Employee Group Selection screen. This screen
provides the user with the facilities to define and maintain Employee Groups. The
following dialog box will appear:

Once the Employee Group Selection dialog box appears, choose the method of
selection by clicking on the Selection Method option in the menu bar. The
following sub menu will appear:

If you choose Employee List, an employee selection list will appear. Select all the
employees to be in the new selection group and press the OK button. The Employee

Group Selection screen now displays the number of employees in the group, and a
status of �enabled�.
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Next, select the Save Current Selection option from the File menu. The following
dialog box will appear:

Both the group code and the description must be entered into their respective fields to
save the group. Then, select the OK button.
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When you are defining and maintaining Employee Groups the following pull down
menu is available from the File option in the menu bar. It allows you to view, clear,
modify, save, enable and disable Employee Groups.

View - to view the employee in the current group select View Current Selection

from the File menu. The following dialog box will appear:

Clear - to clear the current group selectClear Current Selection from the File menu.
The Employee Group Selection screen will now show no current groups.

Modify - to add or delete an employee from your current group select Modify

Current Selection from the File menu.
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Employee Selection List

TheEmployee SelectionList screen is presentedwhen the selection of an employee is
required. The employees that appear in the list are subject to a number of conditions:

n Current Selection Group in Effect - When a selection group is loaded and
enabled only those employees in the selection group may appear in the list.

n Current Payroll Selected -When a payroll is selected only those employees that
are assigned to that payroll may appear in the list.

F When both a selection group is present and a payroll is selected only the employees
that are present in both the selection group and the payroll may appear in the list.

The order of the employees in the list is dependent on the search technique in effect for
the user.

n Search by name will present the employees in alphabetic sequence by surname
and given name.

n Search by employee number will present the employees in employee number
sequence.

n Search by badge will present the employees in badge number sequence.

F The employees without a badge number will not appear in the list when the search by
badge technique is in effect.

The employees in the list are restricted by the value entered to search for an employee.

n Name Search will restrict the list to those employees whose last name
corresponds to the last name portion entered for the search.

n Employee Number will restrict the list to those employees whose employee
number is equal to or greater than the employee number entered for the search.

n Badge Number will restrict the list to those employees whose badge number
corresponds to the badge number portion entered for the search.
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Loading an Employee Group

The Load Employee Groupmenu option will display a list of the Employee Groups
available to the user. One of these groups may be selected for further operations. The
list will appear similar to the following:

Bydouble clicking on the nameof a group, the user can load the group or click ok.

Inserting a new

group

If the INSERT button is selected a new dialog box will appear that allows the user to
define a new employee selection group. The dialog box appears as follows:

Removing a

group

Selecting the DELETE button will remove the highlighted employee group from the
list.
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Refresh Selection Group

The Refresh Selection Group option reloads the last selection group loaded. This
option is usedwhen the selection group has beenmodified and the userwants to reload
the group to eliminate any modifications.

To refresh a selection group the user simply selects the Refresh Selection Group

option under the Groups Menu.

Modifying the Current Group

An existing employee selection group may be temporarily modified by adding or
deleting employees in the group.

When the initial group is a dynamic group the modifications will be retained until the
group is loaded again or refreshed.

The Modify Current Group option will bring up the Employee Selection Group

Modification dialog box. This option can be found on two different menus but the
results are the same. It is available if the user selects the Select Employee Group

option in the Groups menu, and in the Employee Group Selection dialog box if the
user pulls down the File menu.

The screen will appear as follows when either option is selected:
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The dialog box contains a list of the employees in the currently selected employee
group.

To delete an employee from the list, select the employee by single-clicking on that
employee, then select the REMOVE button.

Selecting the ADD button causes the Employee Name Selection screen to appear, as
shown:

If the user does not know the last name of the employee, then the user can:

n select the NEXT button to go to the following employee in the employee group
list, or

n select the PREVIOUS button to go to the previous employee on the employee
selection list, or

n select the List option from the File menu, which will create a list of all the
employees in the current employee group, from which the user can select an
employee.
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Enabling an Employee Group

The Enable Employee Group option will turn on the current employee selection
group for processing. If the group is not enabled the system will not use the group for
processing.

When the selection group is enabled the system will limit access to the employees in
the selection group. This limit applies to both update functions and report functions.

TheEnable EmployeeGroup option is available in two different menus and thus can
be done either way. The user only needs to select the option to enable the current
selection group.

n The option is available in the Groups menu.

n It is also available in the File menu of the Employee Group Selection dialog
box, with the option name Enable Use of Selection.

Disabling an Employee Group

The Disable Employee Group option in the File menu will turn off the current
employee selection group. User ID's that are forced to use a selection group cannot
access this menu choice.

TheDisable EmployeeGroup option is available in two differentmenus and thus can
be done either way. The user only needs to select the option to disable the current
selection group.

n The option is available in the Groups menu.

n It is also available in the File menu of the Employee Group Selection dialog
box, with the option name Disable Use of Selection.
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Calculation

TheCalculationmenu from the main menu bar is used to perform the various payroll
calculation functions of the GrandMaster Suite Payroll system.

The Calculation sub menu appears as follows:

The functions carried out by the Calculation menu options are:

n selection of the type of calculation to be run

n selection of the types of earnings, deductions, and accumulators to be included
in the payroll run

n calculation of the payroll

n closing of the payroll period
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How Do I Run a Payroll Calculation?

Before You Run A Payroll Calculation

Running a payroll calculation requires that you have already set up the information
required to define the payroll, the information for the individual employees in the
payroll, and have entered the transactions that apply to the pay run.

Information

Required

Description

Payroll Employer

Information

The kinds of payroll employer information that must be established are: the
pay frequency, Revenue Canada account numbers, WCB rates, Provincial
Health Rates, distribution tables, pay rate tables and electronic funds
transfer data.

Payroll Earning

Types

The payroll earning types determine the categories of earnings that will be
reported for the employees. These categories determine if the earnings are
subject to tax, CPP, EI, or other payroll taxes.

Payroll Company

Deduction Types

The payroll company deduction types determine types of deductions that
will be taken from the employee�s pay. These deduction types may include
union dues, insurance plan deductions, RRSP deductions, and garnishees.
The deduction types may also determine the benefits that may accrue to the
employee.

Payroll

Accumulator Type

The payroll accumulator type determines values that you want to
accumulate for the employees on each pay run, These accumulator types
may include vacation pay, sick pay, and seniority.

Employees in the

Payroll

Employees must be added to the payroll before they will be included in the
pay calculation.

Employee Payroll

Specific

Information

Employees must have the values set for data that affects the pay calculation
for the employee. This information includes: the taxation province,
personal exemption amount, the number of dependents that the employee
has, and additional tax amounts that the employee needs deducted.

Employee Pay

Rates

Each employee should have their pay rates set for each of the payroll
earning types.

Employee

Deduction Rates

Each employee should have rates set for company deductions that apply to
the employee.

Employee

Accumulator

Rates

Each employee should have rates set for the company accumulators that
apply to the employee.

EmployeeWork

Hours

Each hourly paid employee will have to have the number of hours worked
entered. Hours worked are entered for each of the earning types that apply
to the employee.

When employees always work a standard number of hours for each earning
type these values can be permanently set up in the Employee Earning Type
data.

Other Employee

Transactions

Other transactions can be entered for the employees for the pay run. These
include adjustments for previous pay calculations or overrides to the normal
calculations of taxes and company deductions.
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Set Calculation Type

When the user selectsSetCalculationType from theCalculationmenu, the following
screen will appear:

The following is a list of calculation types:

n Normal Calculation

n Additional Calculation

n Extra Calculation

n Reverse Previous Pay

n Advance Cheque Run

n Month End Accrual
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Normal Pay Calculation

A normal pay run is the normal calculation used to calculate the pay for employees.
After this type of pay run is closed the payroll period and the pay dateswill advance.

When the user selects the Normal Calculation option from the Set Calculation Type
sub menu, the following screen will appear:

The following table gives a description of the data fields:

Field Description

Payroll Year This field contains the year of the payroll.

Payroll Period This field contains the payroll period number within the current year.

Run Sequence This field contains the payroll sequence number.

Pay Frequency This field indicates how frequently the employees get paid, (weekly,
bi-weekly,semi-monthly or monthly).

Start This field contain the starting date of the payroll.

Ending This field contains the ending date of the payroll.

Cheque This field contains the pay date.

F The dates entered will be used for calculating the dates for the next pay run. The dates
are used to collect the transactions for the pay calculation, and to determine the
earning, deduction and accumulator settings that will be used in the pay calculation.

The payroll sequence number is a unique sequentially system assigned number that
increments for every pay calculation regardless of type.
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Additional Pay Calculation

An Additional pay run is used to calculate a pay run for employees where the values
from the pay must be combined with other pay runs in the same period to calculate
taxes.

When the user selects Additional Calculation from the Set Calculation Type, the
following screen will appear:

The following table gives a description of the data fields:

Field Description

Payroll Year This field contains the year of the payroll.

Payroll Period This field contains the payroll period number that the additional run
will be cbined with in the current year.

Run Sequence This field contains the payroll sequence number.

Pay Frequency This field indicates how frequently the employees get paid, (weekly,
bi-weekly, semi-monthly or monthly).

Start This field contains the starting date of the payroll.

Ending This field contains the ending date of the payroll.

Cheque This field contains the pay date.

F The dates entered will be used for calculating the dates for the next pay run. The dates
are used to collect the transactions for the pay calculation, and to determine the
earning, deduction and accumulator settings that will be used in the pay calculation.
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Extra Pay Calculation

AnExtra Pay run is used to calculate a pay run for the employees that does not include
any values fromNormal orAdditional pay runs in the same pay period as the extra pay.
This type of pay run would be used when the employee is receiving a vacation pay
cheque or other type of compensation that must be considered on its own for
calculation of taxes.

An extra pay run takes place in the current pay period.

When the user selectsExtraCalculation from the SetCalculationType, the following
screen will appear:

The following table gives a description of the data fields:

Field Description

Payroll Year This field contains the year of the payroll.

Payroll Period This field contains the payroll number that the extra run will be
combined with in the curremt year.

Run Sequence This field contains the payroll sequence number.

Pay Frequency This field indicates how frequently the employees get paid, (weekly,
bi-weekly, semi-monthly or monthly).

Start This field contains the starting date of the payroll.

Ending This field contains the ending date of the payroll.

Cheque This field contains the pay date.

The dates entered will be used for calculating the dates for the next pay run. The dates
are used to collect the transactions for the pay calculation, and to determine the
earning, deduction and accumulator settings that will be used in the pay calculation.
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Reverse Pay Calculation

AReverse Previous Pay run is used to reverse the effect of a pay run. This is normally
done for only one employee at a time. It can be used however,to reverse an entire pay
run if necessary.

When the user selects Reverse Previous Pay from the Set Calculation Type, the
following screen will appear:

The following table gives a description of the data fields:

Field Description

Payroll Year This field contains the year of the payroll.

Payroll Period This field contains the payroll period number within the current year.

Run Sequence This field contains the payroll sequence number.

Pay Frequency This field indicates how frequently the employees get paid.(weekly,
bi-weekly, semi-monthly or monthly).

Start This field contain the starting date of the payroll.

Ending This field contains the ending date of the payroll.

Cheque This field contains the pay date.

The dates entered will be used for calculating the dates for the next pay run. The dates
are used to collect the transactions for the pay calculation, and to determine the
earning, deduction and accumulator settings that will be used in the pay calculation.

F To select a single employee or a small sub set of all employees that require a previous
pay reversal please refer to the�Groups� section of this manual.
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Advance Cheque Run

When the user selects the Advance Cheque Run from the Set Calculation Type sub
menu, the following screen will appear:

The following table gives a description of the data fields:

Field Description

Payroll Year This field contains the year of the payroll.

Payroll Period This field contains the payroll period number within the current year.

Run Sequence This field contains the payroll sequence number.

Pay Frequency This field indicates how frequently the employees get paid, (weekly,
bi-weekly ,semi-monthly or monthly).

Start This field contains the starting date of the payroll.

Ending This field contains the ending date of the payroll.

Cheque This field contains the pay date.

The dates entered will be used for calculating the dates for the next pay run. The dates
are used to collect the transactions for the pay calculation, and to determine the
earning, deduction and accumulator settings that will be used in the pay calculation.
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Month End Accrual

AMonth EndAccrual pay run is used to generate Journal Entry data only. This type of
pay run calculates the pay for a portion of a pay period and creates journal entry data
for the expenses and accrued expenses, as well as also creating journal entry data for
the reversal of those expenses in the next financial period.

When the user selects the Month End Accrual option, the following screen will
appear:

The following table gives a description of the data fields:

Field Description

Payroll Year This field contains the year of the payroll.

Payroll Period This field contains the payroll period number within the current year.

Run Sequence This field contains the payroll sequence number.

Pay Frequency This field indicates how frequently the employees get paid, (weekly,
bi-weekly, semi-monthly or monthly).

Start This field contains the starting date of the payroll.

Ending This field contains the ending date of the payroll.

Cheque This field contains the pay date.

The dates entered will be used for calculating the dates for the next pay run. The dates
are used to collect the transactions for the pay calculation, and to determine the
earning, deduction and accumulator settings that will be used in the pay calculation.
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Earning Selection

The Earning Selection... option allows the user to select, on a payroll level, which
previously defined earning types are to be paid on the current payroll run.

F If the earning type selected contains no earnings within the specified date range then
that earning type will not be calculated when the payroll is run.

The earnings are defined through the Earnings (Payroll), or the Earnings (Global)
options within the Setup menu.

F Any newly defined earnings will automatically be included in the Selected Earnings
list and calculated with the next payroll unless the earning has been de-selected by the
user.

When the Earning Selection... option is selected, a selection list similar to the
following will appear:

The system will default to include �ALL� in its selection list unless changed for the
particular calculation. The list will revert to the default setting after a �Close�. This
applies for earnings deductions and accumulators.
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The dialog box contains two lists:

List Description

Not Included in

Calculation

This box contains the earnings not included in the calculation.

Included in

Calculation

This box contains the earnings included in the calculation.

Add>> To select an earning type, move it from the Not Included in Calculation list to the
Included inCalculation list, by highlighting the name and pressing theADD>>button.

Remove<< To deselect an earning type, move it from the Included in Calculation list to the Not
Included in Calculation list by highlighting the name and pressing the REMOVE<<
button.

Add All If all the earning types should be included in the calculation, press the ADD ALL

button.

Remove All If all the earning types should be not included in the calculation, press the REMOVE
ALL BUTTON.

OK When the user exits this dialog box by selecting theOKbutton, the systemwill place a
checkmark beside theEarning Selection...menu item to indicate that earnings have
been selected for the current pay calculation.

Esc (exit) The ESC key, CANCEL button, or Exit option from the File menu, will exit the dialog
box without selecting any earnings for the current pay calculation.
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Deduction Selection

TheDeduction Selection... option allows the user to select, on a payroll level, which
previously defined deduction types are to be deducted on the current payroll run.

F If the deduction type selected contains no deductions within the specified date range
then that deduction type will not be calculated when the payroll is run.

The deductions are defined through the Deductions (Payroll), or the Deductions
(Global) options within the Setup menu.

F Any newly defined deductions will automatically be included in the Selected
Deductions list and deducted with the next payroll unless the deduction has been
de-selected by the user.

When the Deduction Selection... option is selected, a selection list similar to the
following will appear:
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The dialog box contains two lists:

List Description

Not Included in

Selection

This box contains the deductions not included in the calculation.

Included in

Selection

This box contains the deductions included in the calculation.

Add>> To select an deduction type, move it from the Not Included in Calculation list to the
Included inCalculation list, by highlighting the name and pressing theADD>>button.

Remove<< To deselect an deduction type, move it from the Included in Calculation list to the Not
Included in Calculation list, by highlighting the name and pressing the REMOVE<<

button.

Add All If all the deduction types should be included in the calculation, press the ADD ALL

button.

Remove All If all the deduction types should be not included in the calculation, press the
REMOVE ALL BUTTON.

OK When the user exits this dialog box by selecting theOKbutton, the systemwill place a
check mark beside the Deduction Selection... menu item to indicate that deductions
have been selected for the current pay calculation.

Esc (exit) The ESC key, CANCEL button, or Exit option from the File menu, will exit the dialog
box without selecting any deductions for the current pay calculation.
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Accumulator Selection

The Accumulator Selection... option allows the user to select, on a payroll level,
which previously defined accumulator types are to be activated on the current payroll
run.

F If the accumulator type selected contains no accumulators within the specified date
range then that accumulator type will not be activated when the payroll is run.

The accumulators are defined through the Accumulators (Payroll), or the
Accumulators (Global) options within the Setup menu.

F Any newly defined accumulators will automatically be included in the Selected
Accumulators list and activated with the next payroll unless the accumulator has been
de-selected by the user.

When the Accumulator Selection... option is selected, a selection list similar to the
following will appear:
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The dialog box contains two lists:

List Description

Not Included in

Selection

This box contains the accumulators not included in the calculation.

Included in

Selection

This box contains the accumulators included in the calculation.

Add>> To select an accumulator type,move it from theNot Included in Calculation list to the
Included inCalculation list, by highlighting the name and pressing theADD>>button.

Remove<< To deselect an accumulator type, move it from the Included in Calculation list to the
Not Included in Calculation list, by highlighting the name and pressing theREMOVE<<

button.

Add All If all the accumulator types should be included in the calculation, press the ADDALL

button.

Remove All If all the accumulator types should be not included in the calculation, press the
REMOVE ALL BUTTON.

OK When the user exits this dialog box by selecting theOKbutton, the systemwill place a
check mark beside the Accumulator Selection... menu item to indicate that
accumulators have been selected for the current pay calculation.

Esc (exit) The ESC key, CANCEL button, or Exit option from the File menu, will exit the dialog
box without selecting any accumulators for the current pay calculation.
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Calculate Payroll

When you are doing a normal pay run you will usually do the calculation for all
employees on the payroll. The Calculate Payroll choice on the Calculation menu is
used to start a calculation for all employees in the payroll. Pay Calculations for a pay
sequence can be done any number of times. Each time the calculation is done the
results of the previous calculation are erased and replaced with the new calculation
results.

When this choice is selected the GrandMaster Suite Payroll Calculation screen is
displayed. This screen allows you to set some options for the pay calculation and start
the calculation.Whenyou selectCalculate Payroll, the following screenwill appear:
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REPORTS

TheReportsmenu from themainmenu bar is used to print reports containing the data
from the GrandMaster Suite payroll system.

The Reports menu appears as follows:

The report generation process will include those employees that are part of the
current employee group if one has been selected.

The Payroll Module provides two classes of reports: system defined reports and
custom reports.

The date ranges entered limit the range of the report to only those records that fall
within the selected date range.

System defined reports have a standard format. The data fields included in the report
may be modified by the user to eliminate any that are not being used.
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Standard Reports

Payroll Entry Report This is a report by date range of transactions entered.

Calculation Total Page This report prints the current pay period final totals pay register
page.

Payroll Register This report is used to print the payroll register.

Employee Pay Statements This report is used to print the employee pay statements and/or
cheques.

Cheque Register This report is used to print the cheque register.

Transaction Report This report is used to print a report of transactions for a period or
create an export file.

Customized Payroll Report This report type allows for printing of user selected non standard
additional reports.

Name & Address This report is used to print name & address report.

Employee Labels This report is used to print employee labels.

Employee Profiles This report is used to print employee profiles.

Record of Employment This report is used to print records of employment.

Journal Entry This report is used to print journal entries or to create export files.

Worker's Compensation This report is used to print the Workers� Compensation Report.

Statistics Canada This report is used to print the Statistics Canada reports.

Payroll Range Report This report prints a summarized final totals pay register page for a
range of pay periods.

Distribution Report This report is used to print all distribution tables showing their
general ledger account allocations.

Payroll Payrate Report This report is used to print the definitions of earnings, deductions
or accumulators within a payroll.

Global Payrate Report This report is used to print the definitions of global earnings,
deductions or accumulators.

Custom Report This report type is currently disabled.

Additional Modules Reserved for future development.

General Operation

The report program presents the user with a data selection screen that shows the data
fields selected according to the default parameters saved for the report.

The user may change the data field selections for the report. These changes may be
saved as the default selection for the reportwith theSaveParametersmenu choice.

The usermay select a subset of the user defined items in the system for inclusion in the
report. A maximum of one hundred items may be included in the subset.

After the appropriate selections are made the user can print the report by pressing the
PRINT REPORT button.
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Printer Setup

The Printer Setup option allows the user to select a printer, select different fonts, and
select the orientation for the print job.

The following table gives a description of the screen:

Field Description

Printer and Font Setup

Use Default Printer In most system setups there will be a printer designated as the default
printer for a particular user, commonly associated with LPT 1. When
this button is selected, GrandMaster Suite will route print jobs to the
designated default printer.

Use Default Font A default printer is most commonly set up with certain font types that
the physical printer can print. When this button is selected,
GrandMaster Suite will use one of the defaults fonts supported by the
system and the printer.

Use Report Viewer When this button is selected all reports selected will print to the
screen only.

Select Printer There may be more than one printer available to the user. When this
button is selected every time a report is called for a new window will
appear presenting a list of available printers to select from.

Select Font Since all printers support their own list of fonts, when this button is
chosen and once a selected printer has also been chosen, a new
window will appear presenting a list of fonts and sizes supported by
the particular printer.
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Field Description

Direct to Epson Printer Due to the requirement to be able to print to some custom forms or
government documents that may need to be printed on a dot matrix
printer it may, at times, be necessary to by pass the Operating
Systems print functions and route the print job directly to the printer
without interference. This can be accomplished in most cases by
selecting this field.

Direct to HP Laser

Printer

When this field is chosen the print job will be directly routed to a
laser printer by passing the Operating Systems print functions.

Default Print Settings

Portrait If this option is chosen and save,d all reports will print 8½� wide by
11� long.

Landscape If this option is selected and saved, all reports will change the
orientation on the page to 8½� long by 11� wide

Font A monospaced font is recommended for all printing, such as Courier,
Courier New or Lin printer. Courier is more commonly associated
with dot matrix printers and Courier New with laser printers . For a
list of fonts supported by your network and/or the physical printers
consult the printer properties in your printer icon.

Point Size It is recommended that a condensed print character size be used for
most reports such as 8. The cheques and/or pay statements and the
record of employment are two exceptions which may require a point
size of 12.

Printer The actual printer port location can be inserted here such as LPT 1:
In some printing setups it may be necessary to specify the physical
location of the printer. Commonly this is left blank but different
hardware configurations may require it. Consult with your
system/network specialist for assistance or information.

Form A physical printer can in some network set ups be set to print a
particular form type such as �cheques�. You may specify the form
type here for routing of your print jobs.

Save After experimentation for the best settings to suit your every day operational needs, the
save option will save the settings as defaults that will remain in effect regardless of the
report to be printed. The �Saved� setting may need to be reexamined if hardware or
network printer changes have occurred.

Use On occasion, you may find it necessary to change or adjust your saved settings to
produce a single report. The �Use� option allows you to make changes to your saved
settings but they will only be in effect during this currently logged on session. Upon
exiting from the system, the settings will revert to previously saved default settings.

Cancel The cancel option will exit without saving any changes.
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Payroll Entry Report

The Payroll Entry Report provides a report by date range of transaction entered within
that date range for earnings only. The report will provide totals of hours and dollars.
When the Payroll Entry Report is selected the following screen will appear:

The following table gives a description of the screen:

Field Description

Date Range

Start This field will default to the current period start date and can be overtyped
for a different reporting start date.

End Date This field will default to the current period end date and can be overtyped
for a different end date.

Report Fields

Detail Transaction If this option is selected the report will list each entry line for each
transaction. By not choosing this option, the system will summarize into 1
report line for each earning type.

Sort Order

Category If this option is selected the report will sort files by payroll category with
an entry field provided to input the specific category type. If no category
number is input the system will default to category 1 (from Employee
Payroll Specific Information Notebook) The report will provide category
sub totals by hours and amounts in earning type order regardless of any
additional sort order selected.

Employee If this option is selected the report will list earnings, hours and amount, in
employee order with a sub-total by employee.

Earning If this option is selected the report will list earnings, hours and amount in
earning type order.

Print Report By pressing this button your report will be routed to your printer. You may also print
the report from the �File� Menu.

Cancel The Cancel option will exit the screen without producing the report.
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Calculation Total Report

The Calculation Total Report will print the current pay period results of the pay
calculation in a final total single page. No year to date amounts will appear.

When the user selects theCalculationTotalReport the following screenwill appear:

Payroll Date, Year, Period and Type:

The Pay Period End Date, Tax Year, Period Number and Type of Calculation will
appear in this box advising of the period that the report will be produced for.

Print By choosing this option the report will be prepared. You may also print from the File
menu.

Print To Printer - This option directs the output to a printer.

Screen - This option directs the output to the screen for review purposes.
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Payroll Register

The Payroll Register option provides a complete description of all calculations
performed for each employee, showing:

n Employee Name and Address

n Current and Year-to-Date values for Gross Wages, Deductions, Benefits,
Current Net Pay, Insurable Earnings

n Accumulators

When the user selects Payroll Register, the following dialog box appears:

The current Pay Period EndingDate, Tax year, PeriodNumber and type of Calculation
will appear in this box. This boxwill showonly the �NotClosed� pay period. Youmay
choose to print a calculated but not finalized. Ie: �Closed� pay register by not

�selecting a payroll run.�

Sort Order

Selections

The sort order options for the report allow for the following sort orders:

n Employee Name

n Employee Number

n Social Insurance

n City

n Province

Can-Pay Computer Software 177

REPORTS - 6

R
E
PO

R
T
S



n Category No.

Report Field

Selection

A data field is selected for the report when the box to the left of the field has a check
mark.

The report field selection allows for inclusion of the following data fields:

Field Description

Address When this field is selected the address will be printed on the
report.

SIN When this field is selected the social insurance number will be
printed on the register.

Print All Employees YTD When this option is selected all employees with earnings in the
current tax year regardless of payroll status will be printed on
the report. These may or may not have current earnings for
the pay run selected for the report.

No Page Break When

Printing the Sub-Totals

When this option is selected the print job will be continuous
with no page skips inserted when a subtotal page is produced
as in the case of a category sort, for example

Print Earnings Summary

Subject to Stats

When this option is selected additional lines will appear on the
report showing, Taxable Earnings YTD, Canada Pensionable
Earnings YTD, Employment Insurance Earnings YTD,
Income subject to Workers Compensation YTD, Income
Subject to Payroll Tax YTD. Since these fields add additional
print lines to the report but are commonly the same it is
recommended that this option be selected only periodically for
review purposes.

Select Pay Run When this option is selected a list box will appear displaying
all previously closed pay runs. This option allows for printing
a pay register at any time once a pay period has been closed.
When a pay period has been closed it becomes history and
may be printed and reprinted any number of times.

Print To The Print To selection allows the user to print to either the printer or to the screen.

F It is important to be aware of the pay period status that you wish to print a pay register
for. If the period has been closed you must use the �Select Pay Run� option to obtain
the desired results. If no pay run is selected the system will produce a report for a
current open pay run which may result in a blank Pay Register Report.

Printer Register This option will cause the report to be prepared and printed either to the screen or a
printer.

File Menu You may also print from the File menu and you may choose to Save your report
selection parameters.

Cancel The Cancel option will exit without producing the report
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Employee Pay Statements with Cheques

Payroll Statements - A pay statement is a current statement of a person�s pay for that
pay period. Each province has it�s own legislation related to the information required
on the pay statement.

When the user selects Employee Pay Statements with cheques the following screen
will appear:

Sort Order The Payroll Statements lets the user sort by the following fields:

n Name

n City

n Payroll Category Number

n Employee Number

n Province

n Social Insurance Number

n Distribution Code

Print Options The YTD values can be turned on or off.

Titles on Stubs The Titles on the Stubs can be printed in the case of a blank statement form or not
printed for preprinted custom forms.

Select Employee The Select Employee button allows the user to select a single employee.
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When the user selects the Company tab the following screen will appear:

The following table gives a description of the printable fields available for the pay
statements section.

Field Description

Company Name When this field is checked it will appear on the stub. The boxes beside
the field are used to enter the row, column number and length of the
field.

CompanyMessage When this field is checked it will appear on the stub. The boxes beside
the field are used to enter the company message row, column number
and length of the field.

Period Ending When this field is checked it will appear on the stub. The boxes beside
the field are used to enter the period ending date row, column number
and length of the field.

Cheque Date When this field is checked it will appear on the stub. The boxes beside
the field are used to enter the cheque date row, column number and
length of the field.

F Offset is the row number (up/down orientation)

Column is the starting column position number from left (side to side orientation)

Length is the number of characters to be printed for each field

The System has been preset with standard default settings at the time of installation
which may or may not apply in your circumstances. It is recommended that a sample
be printed and adjustmentsmade prior to attempting to print your first pay statement.
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TheHeading Sub-Menu tab provides amethod of inputting titles and their position for
the fields selected for printing from the previous main tab.

The following screen will appear when the headings sub-menu tab is chosen:

The following table gives a description of the screen:

Field Description

Company Name When this field is checked it will appear on the stub. The
boxes beside the company name are used to enter the row,
column number and length of the field. The empty box at the
bottom of company name is used to enter the heading title.

Period Ending When this field is checked it will appear on the stub. The
boxes beside period ending are used to enter the row, column
number and length of the field. The empty box at the bottom
of period ending is used to enter the heading title.

Cheque Date When this field is checked it will appear on the stub. The
boxes beside the cheque date are used to enter the row,
column number and length of the field. The empty box at the
bottom of cheque date is used to enter the heading title.
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The following screen will appear when Employee Tab is chosen:

The following table gives a description of the screen:

Field Description

Cheque Number When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Employee

Number

When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Employee Name When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Employee

Message

When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

S.I.N. When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Birth Date When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Distribution When this field is checked it will appear on the stub. The boxes .beside the field
are used to enter the row, column number and length of the field.

Category When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Employee

Address

When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Position When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.

Cheque Date When this field is checked it will appear on the stub. The boxes beside the field
are used to enter the row, column number and length of the field.
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When the user selects the Heading 1 Sub-Menu tab from the Employee Tab of the
Payroll Statements Report the following screen will appear:

The Headings 1 Sub-Menu tab provides a method of inputting titles and their position
for the fields selected for printing from the previous main Employee tab.

The following table gives a description of the screen:

Field Description

Cheque Number When this field is checked, this title will appear on the
stub. The boxes beside the cheque number are used to
enter the row, column number and length of the field.
The empty box below the check box is used to enter the
heading title.

Employee Number When this field is checked, this title will appear on the
stub. The boxes beside the employee number are used
to enter the row, column number and length of the field.
The empty box below the check box is used to enter the
heading title.

Employee Name When this field is checked , this title will appear on the
stub. The boxes to the right of employee number are
used to enter the row, column number and length of the
field. The empty box below the check box is used to
enter the heading title.

Social Insurance Number When this field is checked, this title will appear on the
stub. The boxes to the right of the social insurance
number are used to enter the row, column number and
length of the field. The empty box below the check box
is used to enter the heading title.

Birth Date When this field is checked, this title will appear on the
stub. The boxes to the right of birth date are used to
enter the row, column number and the length of the
field. The empty box below the check box is used to
enter the heading title.
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When the user selects the Heading 2 Sub-Menu tab from the Employee Tab of the
Payroll Statements Report the following screen will appear:

The Heading 2 Sub-Menu tab provides a method of inputting titles and their position
for the fields selected for printing from the previous main Employee tab.

The following table gives a description of the screen:

Field Description

Class Code Not used

Position Code When this field is checked, this title will appear on the stub. The
boxes to the right of position code are used to enter the row, column
number and length of the field. The empty box below the check box is
used to enter the heading title.

Distribution Code When this field is checked, this title will appear on the stub. The
boxes to the right of distribution code are used to enter the row,
column number and length of the field. The empty box below the
check box is used to enter the heading title.

Category Code When this field is checked, this title will appear on the stub. The
boxes to the right of category code are used to enter the row, column
number and length of the field. The empty box below the check box is
used to enter the heading title.

Cheque Date When this field is checked, this title will appear on the stub. The
boxes to the right of the check date are used to enter the row, column
number and length of the field. The empty box below the check box is
used to enter the heading title.
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When the user selects the Earning tab from the Payroll Statements Report the
following screen will appear:

The following table gives a description of the screen:

Field Description

Earning Row This field is used to indicate the row number location
where the earnings will begin printing.

Description When this field is checked the short name of each
earning will be printed on the stub. The boxes beside
the description are used to enter the column number
and length of the field.

Rate When this field is checked the rate that applies for
each earning will be printed on the stub. The boxes to
the right of the rate are used to enter the column
number and length of the field. Allow 5 decimal
places.

Hours When this field is checked the number of hours
associated with each earning will be printed on the
stub. The boxes to the right of hours are used to enter
column number and length of the field. Allow for 5
decimal places.

Current When this field is checked the current amount being
paid for each earning will be printed on the stub. The
boxes to the right of the current are used to enter
column number and length of the field.

Year to Date When this field is checked, the year to date amount for
each earning will be printed on the stub. The boxes to
the right of year to date are used to enter the column
number and length of the field.
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When the user selects the Heading 1 Sub-Menu tab from the Earning Tab of the
Payroll Statements Report the following screen will appear:

The Heading 1 Sub -Menu tab provides a method of inputting titles and their position
for the fields selected for printing from the previous Earning tab.

The following table gives a description of the screen:

Field Description

Description When this field is checked,this title will appear on the stub.
The boxes to the right of the description are used to enter the
row, column number and length of the field. The empty box
below the check box is used to enter the heading title.

Rate When this field is checked, this title will appear on the stub.
The boxes to the right of rate used to enter the row,column
number and length of the field. The empty box below the
check box is used to enter the heading title.

Hours When this field is checked, this title will appear on the stub.
The boxes to the right of hours are used to enter the row,
column number and length of the field. The empty box below
the check box is used to enter the heading title.
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When the user selected the Heading 2 Sub-Menu tab from the Earning tab of the
payroll statements report, the following screen will appear:

The Headings 2 Sub-Menu tab provides a method of inputting titles and their
position for the fields selected for printing from the previous Earning main tab.

The following table gives a description of the screen:

Field Description

Current Amount When this field is checked, this title will appear on the stub.
The boxes to the right of current amount are used to enter the
row, column number and length of the field. The empty box
below the check box is used to input the Heading title.

Year To Date When this field is checked, this title will appear on the stub.
The boxes to the right of year to date are used to enter the
column number and length of the field. The empty box
below the check box is used to enter the heading title.

Column Heading When this field is checked, this title will appear on the stub.
The boxes to the right of column heading are used to enter
the row, column number and length of the field. The empty
box below the check box is used to input the overall heading
title such as �Earnings�.
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When the user selects the Deduction tab from the Payroll Statements report the
following screen will appear:

The following table gives a description of the screen:

Field Description

Deductions Row This field is used to indicate the row number where the deductions will
begin printing.

Description When this field is checked , the short name of each deduction will be
printed on the stub. The boxes beside the description are used to input
the column number and length of the field.

Current When this field is checked, the current amount being deducted for each
deduction will be printed on the stub. The boxes to the right of current
are used to input the column number and length of the field.

Year to Date When this field is checked, the year to date amount for each deduction
will be printed on the stub. The boxes to the right of year to date are
used to enter the column number and length of the field.

Benefit When this field is checked, the current amount for each benefit will be
printed on the stub. The boxes to the right of benefit are used to input
the column number and length of the field.

Benefit YTD When this field is checked, the year to date amount for each benefit will
be printed on the stub. The boxes to the right of benefit YTD re used to
enter column number and length of the field.

F Currently, benefits and benefits YTD print on the right hand side of deductions. The
system defaults the position of these fields to that location and will not be able to print
below the deductions. If benefits are to be printed on a pay statement, it is suggested
that the orientation of the page be set to landscape mode in the printer setup. If no
custom form is being used. It may be necessary to turn off (Do not Select/Check)
Benefits and Benefits YTD printing at this time.
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When the user selects theHeading 1 Sub-Menu Tab of the Deduction Tab from the
Payroll Statements Report the following screen will appear:

The Headings 1 Sub-Menu tab provides a method of inputting titles and their position
for the fields selected for printing from the previous Deduction main tab.

The following table gives a description of the screen:

Field Description

Description When this field is checked, this title will appear on the stub.
The boxes to the right of description are used to input the
row, column number and length of the field. The empty box
below the check box is used to enter the heading title.

Current Amount When this field is checked, this title will appear on the stub.
The boxes to the right of current amount are used to input
the row, column number and length of the field. The empty
box below the check box is used to enter the heading title.

Year To Date Amount When this field is checked, this title will appear on the stub.
The boxes to the right of year to date amount are used to
input the row, column number and length of the field. The
empty box below the check box is used to enter the heading
title.

Column Headings When this field is checked, this title will appear on the stub.
The boxes to the right of column heading are used to enter
the row, column number and length of the field. The empty
box below the check box is used to input the overall heading
title such as �Deductions�.
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When the user selectsHeading 2 Sub-Menu tab of the Deduction tab the following
screen will appear:

The following table gives a description of the screen:

Field Description

Benefit Amount When this field is checked, this title will appear on the stub. The boxes
to the right of the benefit amount are used to input the row,column
number and length of the field. The empty box below the check box is
used to enter the heading title.

Benefit YTD Amount When this field is checked, this title will appear on the stub. The boxes
to the right of benefit YTD amount are used to enter the row, column
number and length of the field. The empty box below the check box is
used to enter the heading title.
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When the user selects the Accumulator tab from the Payroll Statements Report the
following screen will appear:

The following table gives a description of the screen:

Field Description

Accumulators

Row

This field is used to indicate the row number where the accumulators
will begin printing.

Description When this field is checked, the short name of each accumulator will be
printed on the stub. The boxes beside the description are used to enter
the column number and length of the field.

Hours When this field is checked, the number of hours associated with each
accumulator will be printed on the stub. The boxes to the right of
hours are used to input the column number and length of the field.

Amount When this field is checked the amounts associated with each
accumulator will be printed on the stub. The boxes to the right of
amount are used to enter column number and length of the field.

F The printing of each accumulator is at the users discretion and works in conjunction
with the �Flags� settings for each of the accumulators; for example, from a list of 10
active accumulators, only 2 have been selected for printing on the Pay Statement.

F The printing of the selected accumulators as number of hours or dollars is dependent
on the calculation code set up for the accumulator and the accumulators usage control
setting.
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When the user selects the Headings Sub-Menu tab of the Accumulator tab the
following screen will appear:

TheHeadings SubMenu tab provides amethod of inputting titles and their position for
the fields selected for printing from the previous Accumulator main tab.

The following table gives a description of the screen:

Field Description

Description When this field is checked, this title will appear on the
stub. The boxes to the right of description are used to
input the row, column number and length of the field. The
empty box below the check box is used to enter the
heading title.

Hours When this field is checked, this title will appear on the
stub. The boxes to the right of hours are used to input the
row, column number and length of the field. The empty
box below the check box is used to enter the heading title.

Year to Date Amount When this field is checked, this title will appear on the
stub. The boxes to the right of year to date amount are
used to enter the row, column number and length of the
field. The empty box below the check box is used to input
the heading title.

Column Headings When this field is checked, this title will appear on the
stub. The boxes to the right of column heading are used to
enter the row, column number and length of the field. The
empty box below the check box is used to input the overall
heading title such as �Accumulators�.
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When the user selects theTotals tab from the Payroll Statements Report the following
screen will appear:

The following table gives a description of the screen:

Field Description

Net Pay When this field is checked, this amount will appear on the stub. The boxes to
the right of net pay are used to input the row, column number and length of the
field.

Total Deduction When this field is checked, this amount will be printed on the stub. The boxes
to the right of total deduction are used to input the row, column number and
length of the field.

Total Deduction YTD When this field is checked, this amount will be printed on the stub. The boxes
to the right of total deduction YTD are used to input the row, column number
and length of the field.

Gross Pay When this field is checked, this amount will be printed on the stub. The boxes
to the right of gross pay are used to input the row, column number and length
of the field.

Gross YTD When this field is checked, this amount will be printed on the stub. The boxes
to the right of gross YTD are used to enter the row, column number and length
of the field.

Arrears When this field is checked, this amount will be printed on the stub. The boxes
to the right of arrears are used to enter the row, column number and length of
the field.

Arrears to Date When this field is checked, this amount will be printed on the stub. The boxes
to the right of arrears to date are used to enter the row, column number and
length of the field.

E.I. Hours When this field is checked, this number will be printed on the stub. The boxes
to the right of E.I. Hours are used to input the row, column number and length
of the field.
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E.I. Hours to Date When this field is checked, this number will be printed on the stub. The boxes
to the right of E.I. hours to date are used to enter the row, column number and
length of the field.

When the user selects the Heading 1 tab of the Total tab the following screen will
appear:

The Headings 1 Sub-Menu tab provides a method of inputting titles and their position
for the fields selected for printing from the previous Totals main tab.

The following table gives a description of the screen:

Field Description

Net Pay When this field is checked , this title will appear on the stub. The
boxes to the right of net pay are used to input the row,column
number and length of the field. The empty box below the check
box is used to enter the heading title.

Total Deductions When this field is checked, this title will appear on the stub. The
boxes to the right of the total deduction are used to input the row,
column number and length of the field. The empty box below the
check box is used to enter the heading title.

Total Deduction YTD When this field is checked, this title will appear on the stub. The
boxes to the right of the total deduction YTD are used to enter the
row, column number and length of the field. The empty box below
the check box is used to input the heading title.

Gross Pay When this field is checked, this title will appear on the stub. The
boxes to the right of gross pay are used to enter the row, column
number and length of the field. The empty box below the check
box is used to input the heading title.

Gross Pay Year to Date When this field is checked, this title will appear on the stub. The
boxes to the right of the gross pay year to date are used to input the
row,column number and length of the field. The empty box below
the check box is used to enter the heading title.
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When the user selects theHeading 2 Sub-menu tab from the Total tab the following
screen will appear:

The Heading 2 Sub-Menu tab provides a method of inputting titles and their position
for the fields selected for printing from the previous �Totals� main tab.

The following table gives a description of the screen:

Field Description

E.I. Hours When this field is checked, this title will appear on the stub. The
boxes to the right of E.I. hours are used to input the row, column
number and length of the field. The empty box below the check box
is used to input the heading title.

E.I. Hours to Date When this field is checked, this title will appear on the stub. The
boxes to the right of E.I. hours to Date are used to enter the row,
column number and length of the field. The empty box below the
check box is used to input the heading title.

Arrears Amount When this field is checked, this title will appear on the stub. The
boxes to the right of arrears amount are used to enter the row,
column number and length of the field. The empty box below the
check box is used to enter the heading title.

Arrears to Date When this field is checked, this title will appear on the stub. The
boxes to the right of arrears to date are used to enter the row,
column number and length of the field. The empty box below the
check box is used to enter the heading title.
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When the user selects the Cheque tab from the Payroll Statements Report the
following screen will appear:

The fields selected from this page will print the employee�s current pay values on the
cheque portion of the form.

The following table gives a description of the screen:

Field Description

Company Name If the cheque is not a preprinted form, the company�s name can be printed
on the cheque portion of the form when this field is checked. The boxes to
the right of company name are used to input the row, column number and
length of the field.

Company Address The company�s address can be printed if this field is selected. The boxes to
the right of company address are used to input the row, column number and
length of the field.

Cheque Date The date of the cheque will be printed if this field is selected. The boxes to
the right of cheque date are used to enter the row, column number and
length of the field.

Cheque Number When this field is selected for printing, the cheque number will be printed
on the cheque portion. The boxes to the right of cheque number are used to
input the row, column number and length of the field.

Amount - Alpha The amount of the cheque to be issued will be printed in full words, such

as five hundred and twenty-three dollars, when this field is selected. The
boxes to the right of amount - alpha are used to input the row, column
number and length of the field.

Amount -Numeric The amount of the cheque to be issued will be printed as numbers when
this field is checked. The boxes to the right of amount-numeric are used to
input the row, column number and length of the field.

Employee Name The employees name will be printed on the cheques when this field is
selected. The boxes to the right of employee name are used to input the
row, column number and length of the field.
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Field Description

Employee Address The employee address can also be printed on the cheque when this field is
selected. The boxes to the right of employee address are used to enter the
row, column number and length of the field of the first line of the address.

Starting Cheque

Number

This field is used to input the starting cheque number of the series to be
printed on the cheque, if that field is selected. This cheque number will
also appear on the cheque register as the system assigns the next sequential
number to each cheque as it is produced.

Cheque run to

Replace EFT run

On occasion it may be necessary to produce cheques to replace a direct
deposit transfer that was not successful either for all employees or an
individual, or there may be an extra/additional/advance run where cheques
are produced and are not commonly part of a direct deposit schedule. This
can be accomplished by checking this field.

When the user selects the Layout Sub-Menu tab the following screen will appear:

The Layout Sub-Menu Tab provides some additional option choices and allows the
user to specify the cheque form size. The following table gives a description of the
screen:

Field Description

Printing Options

Stubs Only This option allows for the printing of payment statement stubs only and
could be used in the situation where handwritten cheques are being
produced but the cheque numbers must be tracked on the cheque register.

Cheques Only This option allows for the printing of cheques only where pay statements
are printed separately on a custom form.

Both This option allows for the printing of the cheque and pay statement stub
per employee on a single form. Where direct deposit transfers are not
used the both setting is the most commonly selected.

Page Layout
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Field Description

Stub First This option allows for the specification of the orientation of the form to
be printed where the pay statement stub is at the top of the form.

Cheque First This is the alternate selection where the cheque is at the top of the form.

Form Size

Number of Cheques per

Form

This option allows the user to indicate the number of cheques to be
printed per form.

Number of Lines per

Cheque

This option allows the user to indicate the number of printable lines there
are on the cheque portion per form.

Number of Lines per Form This option allows the user to indicate the number of pay statement stubs
to be printed per form.

Number of Lines per Stub This option allows the user to indicate the number of printable lines there
are on the pay statement stub portion per form.

Number of Body Lines per

Stub

This option allows the user to indicate the number of lines specified
previously that can be printed per form.

Number of Offset lines per

Page

This option allows the user to indicate at what row number the printable
area begins if the printer has a pre-set default position past head of form
or if the form has a box or frame drawn around its outside parameter.

Number of Lines per Form This option allows for the specifications of the form length in lines. A
standard continuous feed cheques w/stub form is 42 lines, for example. A
Standard Laser printable cheque w/stub form is 63 lines, for another
example.

F We have found that in order to have consistent positioning for the next form you may
find it helpful to reduce the �number of lines per stub� by 1.
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When the user selects the Printer tab the following screen will appear:

In some circumstances it may be necessary to by pass the printer set-ups options and
select specific printing options for the pay statements w/cheques. This may be done
through the printer tab. The following table gives a description of the screen:

Field Description

Printer The actual printer port that the printer is assigned to is inserted here.
LPT1: or LPT2:

Font A monospaced font is recommended, such as courier or line printer, for
insertion in this field. It is important to know what font types are
supported by your printer.

Font Size A font size that will allow for the printing of all of the selected fields
should be inserted here. Commonly, this would be a font size of 12.

Direct Printer Output

(Epson Type)

It is, on occasion, necessary to direct the output for a print job by-passing
the Operating Systems print functions and send the print job directly to a
printer. By selecting this option the pay statements w/cheques can be
directed to a dot matrix printer.

Direct Printer Output

(Hp Laserjet)

By selecting this option the pay statements w/cheques can be directed to a
laser printer.

Disable Hardware

form Control

In the case of some dot matrix printers, the printer may reposition for what
it senses as a head of form based on the perforation between forms. This
may throw the cheque forms printing out of alignment for continuous feed
forms. By selecting this option the printers form feed is disabled and the
printing of the pay statements w/cheques can proceed. This option setting
cannot be saved and must be reset every run.

F It may not be necessary to input on this page or choose any of the options available. It
is recommended that a �Print Sample� be attempted with the normal printer set up
options first ,with the exception possibly, of the font size selection. The font size can
be changed on the �Printer Setup� and set to be �Used� during the printing of pay
statements w/cheques. It will then revert to its default �Saved� settings at the end of
the users log on session.
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Pay Statements w/cheques - General information for Pay Statement

w/cheque

Under theFileMenu selection options are available thatwill be of interest to the user:

1. Print Statements - There is a print option choice here as well as the �Print�
button at the bottom of the notebook which is the command to begin the
printing of paystatements w/cheques.

2. Default Format - To cancel any previous changes to reporting field positions
and re-set to the default original settings this option can be selected.

3. Save Parameters - Once the user has made appropriate changes to the initial
default settings that allow for printing to their custom cheque/statment form
they may select this save option to save their changes. Saving the parameters
in one selected payroll will save the formatting for any other payrolls on the
system.

4. Exit - the Exit or Cancel button will exit the program without saving any
changes.

Also there are two other options which are important to a satisfactory result of the
printing pay statements w/cheques.

5. Print Sample - This option allows the user to see the results of the changes
specified by printing one, sample at a time. To test for correct form alignment
and continuous feed, print two samples in a row without adjusting the form in
the printer. The sample cheque printed will be the first cheque from the pay
run selected.

6. Select Pay run - Pay Statements w/cheques must be run from a closed pay
period (history). It is important to select the correct period that you wish to
print cheques/statements for. If no pay run is selected the system defaults to
print the most recent closed pay run.
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Employee Pay Statements - Statements EFT/Stubs

The system allows the user to print pay statements only where Direct Deposit,
Electronic Funds Transfer is used to pay the employees of the company. Please refer to
Pay Statements w/cheques of this manual for a complete description of the printing
options available. The pay statements w/cheques and statement EFT/Stubs are
identical with the exception of one notebook page. The �Cheque� tab in pay
statements w/cheques is replaced by the �EFT� tab for Statements EFT/Stubs.

The following is a description of the fields on the screen when the EFT tab is
selected.

Field Description

Form Sizes

Number of Stubs per

Form

This option allows the user to specify the number of stubs that
can be printed on a pay statement form.

Number of Lines per

Stub

This option allows the user to specify the number of lines
printable per stub.

Number of Body Lines

per Stub

This option allows the user to indicate the number of lines
specified previously that can be printed per stub form.

Number of Offset Lines

per Page

This option allows the user to indicate at what row number the
printable area begins on that stub form.

Bank Account Information

Bank Account Numbers This option allows the user to select to print the bank account
number(s) for each employee on the pay statements EFT/Stubs.

Print Stubs

EFT Only This option allows the user to select pay statements for an EFT
Direct Deposit type of a payment form.

EFT and Cheque Stubs This option allows the user to select pay/statements to print
where the payment type was mix an of EFT and Cheques.
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F The Layout Sub-Menu tab should be reviewed when only pay statements EFt/Stubs
are being printed so that the information contained on the layout page is consistent
with the information selected on the EFT main tab.

Cheque Register

The Cheque Register is a list of all cheques issued during a pay run.

When the user selects the cheque register the following screen will appear:

Sort Order

Selections

TheSort order selections for the report allows for the following sort order selections:

n Sequence Number - Sequence Number is the system assigned transaction
sequence number more commonly associated with EFTS.

n Cheque Number - Cheque Number is the user assigned cheque number.

Print To The Print To selection allows the user to print to the following:

n Printer

n Screen

Selection Option The Selection Option allows the user to print

n Void - Void cheques are those cheques which have been printed but may have
had to be re-printed for some reason. The system automatically flags the first
series of cheques as void.
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n Last Issued - This option is to specifically select the last pay run of cheque
printed in contrast to the last pay period issued which may include several pay
runs.

n Both - The user may select both the last pay run but also all cheques marked as
void by the system.

Processing Option This option allows the user to select the type of payment processed to be reported in the
cheque register report.

n Eft -When this option is selected only the EFT items will be reported in system
generated sequence number order.

n Cheques -When this option is selected only the cheque itemswill be reported in
either sequence number or cheque number order depending on the sort criteria
selected.

n Both - When this options is selected all EFT and Cheque Items will appear
together in one report sorted in the order chosen previously.

Select Payroll This allows the user to print a cheque register for a particular pay run. If no pay run is
selected the systemwill default to the pay run pay sequence number that appears at the
top of the initial selection screen.

Print Report Initiates the report printing according to the selections made and options chosen.
Printing can also be initiated from the File menu.

Cancel The Cancel button or exit from the File menu will exit from the screen without
producing the report.

File Menu In addition to the Print and Cancel functions the user is also able to save the Report
Parameters Selected.
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Transaction Report

TheTransactionReport prints a report of selected transactions entered for the payroll
in the given date range by the sort order selected.

When the user selects Transaction Report the following screen will appear:

The following is a description of the fields on the screen and their use:

Field Description

Current Pay Run (Not Closed): The system will display the current calculated but not yet closed pay

run by period end date, tax year, run type, pay run number and pay sequence number. It will allow

the user to choose:

Include To include the transactions from this run in the subsequent report.

Exclude To exclude the transactions from this run in the subsequent report.

Only To report only the transactions from this run in the subsequent report. A pay run start
and end period is not required if this option is chosen.

Pay Run Selection: The system allows the user to select a starting pay run and ending pay run either

�Including� or �Excluding: the current pay run.

Select Start When the user selects this option a list will appear displaying all previously closed
�History� pay runs in order to choose the report�s starting run number.

Select End When the user selects this option a list will appear displaying all previously closed
�History� pay runs in order to choose the report�s ending run number.

Date Range Selection: The system also provides the user with a method to select transactions from a

certain date range for the report.

From If this is the method that the user wishes to use, the starting date should be entered in
this field in YYYYMMDD format.

To The ending date of the date range should be entered in this field in YYYYMMDD
format.

By Pay Run The user must specify the selection option that has been chosen, with by pay run
requiring a starting and ending pay run number for the subsequent report.

By Date Range This option requires that the user has chosen and inserted the date range to be reported.
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When the user selects the Sort tab from the Transaction Report the following screen
will appear:

Sort Order The sort order field lets the user sort by one of the following choices:

n Transaction Date

n Employee Name

n Pay Sequence

n Category

n Transaction Type

n Employee Number

n Pay Period Number

Totals By The �Totals By� allows the user to specify the type of totals that will be printed. The
user can select to have totals by one of the following choices:

n Date

n Employee

n Pay Sequence

n Transaction Type

n Transaction Code

n Pay Period Number

F The Totals By should be the same as the sort type with the exception of category sort
which will automatically total by category as well.

Can-Pay Computer Software 205

REPORTS - 6

R
E
PO

R
T
S



Summary Totals

Only

When this option is selected a single summary total line for the transaction will appear
for the sort type. If this option is not selected every detail transaction line will be
printed.

When the user selects the Transaction tab from the Transaction Report the following
screen will appear:

The following table gives a description of the report:

Field Description

All The All button will turn on all types of transactions to be printed on the
report.

None The None button will turn off all types of transactions on this screen and is a
method of removing previously saved selections.

Normal This Normal column indicates the normal input or generated transactions. By
turning on one of the transaction types in this column the transaction report
will print standard transactions for the specified type.

Current The two columns under this title will report the current period transactions by
type selected.

Override Indicates pay period override transactions by transaction type.

Adjustment Indicates current period adjustment transactions by transaction type.

YTD The two columns under this title will report those transactions by transaction
type that were input to modify the year to date balances.

Override Indicates year to date override transactions by transaction type.

Adjustment Indicates year to date adjustment transactions by transaction type.
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The Transaction types that can be selected for reporting are:

n Earnings

n Deductions

n Benefits

n Statutory Deductions

n Statutory Benefits

n Accumulators

There are additional accumulator transactions that can be reported as well, such as:

n Pay out Part

n Payout All

n Entitlement Adjustment

n Internal Adjustment

Can-Pay Computer Software 207

REPORTS - 6

R
E
PO

R
T
S



When the user selects the Fields tab from the Transaction Report the following screen
will appear:

Transaction

Fields

When the user wants a Transaction field to appear on the report click on the box to the
left of the field you want to appear on the report. The transaction fields that can be
reported are:

n Transaction Type

n Rate

n Hours

n Date

n Amount

n Reason

n Code

n Flag

n Pay Period

n Pay Year

n Pay Sequence

n Position

n Area

n Activity

n Sub Area

n Sub Activity

n Distribution
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n Reference

F In order for the rate field to appear on the report, Summary Totals Only on the Sort tab
must be turned off.

Employee Fields In Addition to the transaction reporting fields, there are other fields associated with
each employee which can also be selected for the report. Those fields are:

n Employee Number

n Social Insurance Number

n Category with a field to specify which category

n Birth Date

n Sex
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When the user selects theReport tab from theTransactionReport the following screen
will appear:

The Report tab allows the user to specify where the report will print and whether an
export file should also be created. The following options are available:

Print To Allows the user to produce the transaction report as a printed report or to appear on the
screen for review.

Options Allows the user to specifywhether the transactions selectedwill produce a report only,
an export file only or both.

Page Break Allows the user to specify whether there should be a page break after each sort total or
not.

Export Data Allows the user to select the Export File�s Date format.

210 Can-Pay Computer Software

6 - REPORTS



When the user selects the Select tab from the Transaction Report the following screen
will appear:

The Selects tab allows the user to specify a selected list of transaction types by
employee. IF no selections are made at this time the system will report for all
employees all transactions of the type selected on the transaction tab. By choosing
any one of the options listed here a list of existing codes will be presented to choose
from. The choices available are to:

n Select an individual �Employee�

n Select from a list of �Earnings�

n Select from a list of �Deductions�

n Select from a list of �Accumulators�

There also exists a range of transactions types to choose from which are:

n Unprocessed Transactions Only - Items entered but not included in calculation
yet.

n Entered Hourly Transactions Only - Items entered through hours entry
technique

n All Requested Transaction - All items of every kind according to all parameters
selected.
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When the user selects the Export Tab from the Transaction Report Menu the
following screen will appear:

The user is provided with the fields which can be used for export. Each field to be
exportedmust carry a number starting from the leftmost data field in the file. Enter the
position of the field in the output record. Use zero to turn off the field for Export.

F The File Menu allows for the saving of the parameters selected for the Transaction
Report
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Customized Report

TheCustomizedReports provides the user with amethod of creating their own reports
in addition to the system standard reports. These created reports may be printed or
exported to another system such as a spreadsheet for further manipulation or both
printed and exported at the same time. The Customized reports are generated from
data contained in closed (history) pay runs. The Customized Report can provide a
report spanning several pay runs. The Customized Reports allows for several
variations of a similar report based on user requirements.

The following screen will appear when the Customized Reports screen is selected:

From theReports Tab of theCustomizedReport the following options are presented:

Field Description

Starting Payroll Selection

Select Start By pressing this button a list of closed pay runs will be displayed to choose the
starting pay run for the report.

Ending Payroll

Selection

By pressing this button a list of closed pay runs will be displayed to choose the
ending pay run for the report.

Print To

Printer The users may direct the report to a printer.

Screen The user may direct the report to be viewed on the screen.

Actions

Report The user may select for a report only.

Both The user may select for a report and an export file to be created at the same
time.
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Export The user may select for an export file to be created only.

When the user selects the Sort tab from the Customized Report the following screen
will appear:

A number of sort options are available for each report generated. These sort options
are:

n Category Number - With a field to enter Category Number desired.

n Employee Name

n Revenue Canada Account Number, ie: Full Rate Business Number

n Employee Number

n Tax Province

Report Sub Totals At least one of the totals fields must be checked in order for the report to produce the
desired results. The total field selected is dependent on the reports selection criteria.
These total fields indicate to the system that summary total lines are required for the
report. The sub-total fields selection are:

n Total Earning Fields

n Total Deduction Fields

n Total Accumulator Fields

Print Reprot

Field

Horizontal

This is a printing option to reorient the report to a horizontal layout
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When the user selects the Select tab the following screen will appear:

The option exist to select a report based on certain parameters. The usermay select:

Select Employee To choose a report for one employee

Select Earnings A list of all earning types will be presented to choose one or several for the report.

Select Deductions A list of all Company Deduction types will be presented to choose one or several for
the report.

Select

Accumulators

Alist of all accumulator typeswill be presented to choose one or several for the report

Select Statutory

Deductions

A list of all statutory deduction will be present to choose one or several to be excluded
for the report.

F The system defaults to include all statutory deductions in any report unless they are
specifically excluded.
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When the user Selects theField tab from the Customized Report the following screen
will appear:

Employee Data

Fields

The user may select the fields that are desired on the report. The box to the left of the
field name indicates that the required report data field is checked. The box to the right
of the field name is used to indicate the fields order of export position number.
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When the user selects the Results 1 tab from the Customized Report the following
screen will appear:

Field Description

Earning Fields

Current Hours If this field is checked and earning type has been selected, the
current hours for the report�s pay run range will be printed/exported.

Current Amount If this field is checked and the earning type has been selected, the
current amount for the report pay run range will be printed/exported.

YTD Hours If this field is checked and an earning type has been selected, the
YTD hours for the reports pay run end date will be printed/exported.

YTD Amount If this field is checked and an earning type has been selected, the
YTD Amount for the report�s pay run end date will be
printed/exported.

Current Rate If this field is checked and an earning type has been selected and
employee�s have had earnings of this type for the report�s pay run
range, the current rate will be printed/exported. Note: The system
will calculate the current rate based on earnings and does not report
the employee�s fixed rate. This will produce an average current rate
of pay which may differ with an employee�s fixed rate depending on
the current transactions.

YTD Rate If this field is checked and an earning type has been selected and the
employee has had earnings of this type, the average YTD rate will
be calculated and printed/exported.

Deduction Fields Including Stat�s
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Field Description

Current Deductions If this field is checked and a deduction type has been selected, the
current deduction amount for the report�s pay run range will be
printed/exported.

YTD Deductions If this field is checked and a deduction type has been selected, the
YTD deduction amount for the report ending run date will be
printed/exported.

Current Benefits If this field is checked and a deduction type has been selected, the
current benefit amount for the reports pay run range will be
printed/exported.

YTD Benefits If this field is checked and a deduction type has been selected, the
YTD Benefits amount for the report�s ending run date will be
printed/exported. Note: The Statutory deductions will be default
also be included in the Report unless specifically excluded from the
selections.

Accumulator Fields

Accumulator Hours If this field is checked an accumulator type has been selected, the
number of accumulated hours for the report�s pay run range will be
printed/exported.

Paid Hours If this field is checked and an accumulator type has been selected,
the number of paid out hours for the reports pay run range will be
printed/exported.

Balance of Hours If this field is checked and an accumulator type has been selected.
The balance of hours remaining in the accumulator at the end of the
report�s pay run range will be printed/exported.

Accumulator Amount If this field is checked and an accumulator type has been selected.
The amount of accumulator dollars for the report�s pay run range
will be printed/exported.

Paid Amount If this field is checked and an accumulator type has been selected,
the paid out amount for the report pay run range will be
printed/exported.

Balance Amount If this field is checked and an accumulator type has been selected,
the balance of dollars remaining in the accumulator at the end of the
report pay run range will be printed/exported.
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When the user selects theResult 2 tab of the Customized Report the following screen
will appear:

The boxes to the left of the field name are used to indicate that these should be
printed/exported. The boxes to the right of the field name are used to induce the order
of export position number.

The following table gives a description of the screen:

Field Description

Pay Summary Amount Fields: There exists the possibility of reporting additional summary

data for the report.

Current Gross If this field is checked the current gross earnings will appear on the
report/export field.

Current Net IF this field is checked, the current net earnings will appear on the
report/export field.

Arrears If this field is checked. The current arrears will appear on the
report/export file.

YTD Gross If this field is checked, the YTD Gross earnings will appear on the
report/export file.

YTD Net If this field is checked, the YTD net earnings will appear on the
report/export file.

YTD Arrears If this field is checked, the YTD arrears outstanding will appear on the
report/export file.
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Description Fields: For export file production only. The printing of a report will include all

descriptions by default. If the export file also requires the description fields to be exported

the user must specify the export order for: Earning Type, Deduction Type and Accumulator

Type.

When the user selects theFormula tab of the Customized Report the following screen
will appear:

On occasion it is necessary to manipulate the data coming from the payroll files and
perform some simple mathematical functions, such as combining certain data fields.
This may not be desirable in the payroll system but may be necessary for other
reporting requirements. The system provides for this requirement in a limitedmanner.
Complex calculation and recombination�s cannot be handled on this formula tab but
simple functions do exist to provide further flexibility
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When the user selects the Variable 1 Sub-Menu tab on the Customized Report the
following screen will appear:

When the user selects the Variable 2 Sub-Menu tab of the Customized Reports the
following screen will appear:

F There does not currently exist a method of inserting a custom report name on the
Customized Reports produced. This feature will be available in a later release of the
software

F The report parameters can be saved under the File menu but must be reselected for
each new report produced. A method of saving individual report parameters
associated with a named report will be available in a later release of the software.
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Examples of Customized Report

A: How do I get a Report of RRSP Employee and Employer Contributions for

February 1998?

1. Select Payroll Name

2. Go to Reports on Payroll Main Menu, Select Customized Reports

3. Select starting pay run number falling within February 1998

4. Select Ending pay run number falling within February 1998

5. Select to print report r view on the screen

6. Select for Report Only, export only or both

7. Go to Sort Tab, select sort order - Employee Name

8. Select Deduction fields from Report sub totals

9. Go to Select Tab, select deductions - RRSP from list, OK

10.Select Stat. Deductions, highlight all and press exclude, OK

11.Go to Employee Data fields - for Report Only - Click once for each field you
wish printed. Employee Name, Social Insurance Number

12.Go to Results 1 Tab, select Current Deductions and Current Benefits

13.Press Result Report

B: How do produce a Report of the Balance of Vacation hours owing to all

employee;s for each department supervisor to review?

1. Select Payroll Name

2. Go to Reports on Payroll main menu, Select customized reports.

3. Select starting pay run number - most recent closed.

4. Ending Pay run number will default to same as start.

5. Select to print Report or view on the screen

6. Select for Report

7. Go to Sort tab, Select sort order - Category Number 1

8. Select Accumulator fields from report sub-totals

9. Go to Select Tab, select accumulators - choose Vacation Accumulator(s) form
list - OK

10.Go to Fields Tab, Employee Data Fields to choose from: Click once for each
field you wish printed. Employee Number, Employee Name

11.Go to Results 1 Tab, Select Accumulator Fields - Balance of hours or Balance
or both
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12.Press Result Report

C: How Do I get a Report of hours worked and Rate of pay in Mar h 1998 by all

employee by province?

1. Select Payroll Name

2. Go to Reports on the Payroll Main Menu, Select Customized Reports

3. Select Starting pay run number in March 1998

4. Select Ending pay run number in March 1998

5. Select to Print Report or View on the screen

6. Select for Report

7. Go to Sort Tab, Select Sort Order - Tax Province

8. Select Earnings Fields from Report sub-totals

9. Go to Select Tab, Select Earnings - choose earning code(s) from List ,OK

10.Go to Fields Tab, select Employee Data fields to be printed. Click once for
each choice. Employee Number, Employee Name, Category, Tax Province

11.Go to Results 1 tab. Select Earnings Fields -Current Hours, Current Rate

12.Press Result Report

13.Remember that the system calculates the current average rate of pay. If an
employee has had no earnings of the type selected no rate of pay will appear
on the report.
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Name and Address Report

The Name and Address report option prints a listing of the Employee name and
addresses.

This function allows the user to select the data fields to include in the report, the name
and address layout, and to select a single employee for the report.

The dialog box for theName&Address Report option in the report menu appears as
follows:

Saving... The selections made by the user can be saved by selecting the Save Parameters in the
File menu.
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Report Fields

Selection

A data field is selected for the report when the box to the left of the field has a check
mark.

The report field selection allows for the inclusion of the following 25 data fields:

Field Description

Name When this field is checked the name of the employee in the name and address report will be printed.

Surname When this field is checked the surname of the employee in the name and address report will be
printed.

Given Name When this field is checked the given name of the employee in the name and address report will be
printed.

Start Date When this field is checked the starting date of the name and address report will be printed.

End Date When this field is checked the ending date of the name and address report will be printed.

Medical When this field is checked the medical number of the employee will be printed.

Family Med. When this field is checked the family medical number of the employee will be printed.

Home Phone When this field is checked the home phone number of the employee will be printed.

Address 1 When this field is checked the address 1 of the address will be printed.

Address 2 When this field is checked the address 2 of the address will be printed.

City When this field is checked the city will be printed.

Province When this field is checked the province will be printed.

Postal Code When this field is checked the postal code will be printed.

Alt. Phone When this field is checked the alternate phone number will be printed.

Number When this field is checked the employee number will be printed.

S.I.N. When this field is checked the S.I.N. of the employee will be printed.

Sex When this field is checked the sex of the employee will be printed.

Treaty When this field is checked the treaty number of the employee will be printed.

Band When this field is checked the band number/name of the employee will be printed.

Birth Date When this field is checked the employee�s birth date will be printed.

Category When this field is checked the employee�s assigned category will be printed.

Medical

Reference

When this field is checked the employee�s additional medical reference number will be printed.
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Layout 1

Selection

The dialog box for the Name and Address Report layout appears as follows:

Defaults The default selections can be redisplayed by selecting the default selections in the file
menu. If you wish to always use the defaults, select the Save Parameter option in the
File menu.
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Layout 2

Selection

The second dialog box for theNameandAddressReport layout appears as follows:

Defaults The default selections can be re-displayed by selecting the default selections in the
file menu. If you wish to always use the defaults, select the Save Parameter option
in the File menu.
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In order to design a report layout you must specify the following 3 things:

n Off-Set

n Column

n Field Length

Off-Set This is the line offset used for printing the name and address information. Eg) If you
want this field to print on the first line of this name and address information use an
off-set of zero. If it is to follow on the second line use an off-set of 1. Youmay have as
many off-sets as you need to print all the fields you have selected.

Column This is the character position on the print line for the name and address information.
Eg) If the field is to start 5 spaces in from the left hand margin enter a 6 in the column
field. The column numbers are only limited by the number of characters you can print
on each line of your selection page.

Field Length This is the number of characters that make up the field. Eg) Employee number is 10
characters long. If you want to see the entire employee number enter 10 in the field
length. If you are doing the date which is 10 characters you may choose to print only
the last 5 giving you mm/dd. The date field is the only field that takes the characters
from the right hand side.
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Sizes Selection The following dialog box for the Name and Address Report appears as follows:

The default number of characters contained in each field are displayed on the report
field sizes. TO change any of the field lengths, highlight the field�s length and
overtype with a new value.

Can-Pay Computer Software 229

REPORTS - 6

R
E
PO

R
T
S



Select Report

Selection

The dialog box for the Name and Address Report appears as follows:

Single Employee

Option

To choose a single employee option for the Name and Address report select the Select
Employee option.

Page Break for

Report

This report allows you the option to print each employee on a separate page. Select the
page break yes field. When this is selected the box to the left of the field has a check
mark.

Print To You may choose to print the report to your screen or to a printer.

File Menu Under the File menu option, you may save the report parameters, print or exit.
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Name and Address Label

The Name & Address Label option prints an employee name and address label.

This function allows the user to select the data fields to include in the label, the name
and address layout, and to set up the label layout.

The dialog box for the Name & Address Label option in the report menu appears as
follows:

Saving... The selections made by the user can be saved by selecting the Save Parameters in the
File menu.
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Report Fields

Selection

A data field is selected for the label when the box to the left of the field has a check
mark.

The report field selection allows for the inclusion of the following 25 data fields:

Field Description

Name When this field is checked the name of the employee in the name and address label will be printed.

Surname When this field is checked the surname of the employee in the name and address label will be
printed.

Given Name When this field is checked the given name of the employee in the name and address label will be
printed.

Start Date When this field is checked the starting date of the name and address label will be printed.

End Date When this field is checked the ending date of the name and address label will be printed.

Medical When this field is checked the medical number of the employee will be printed.

Family Med. When this field is checked the family medical number of the employee will be printed.

Home Phone When this field is checked the home phone number of the employee will be printed.

Address 1 When this field is checked the address 1 line of the address will be printed.

Address 2 When this field is checked the address 2 line of the address will be printed.

City When this field is checked the city of the employee will be printed.

Province When this field is checked the province of the employee will be printed.

Postal Code When this field is checked the postal code of the employee will be printed.

Alt. Phone When this field is checked the alternate phone number of the employee will be printed.

Number When this field is checked the employee number will be printed.

S.I.N. When this field is checked the S.I.N. of the employee will be printed.

Sex When this field is checked the sex of the employee will be printed.

Treaty When this field is checked the treaty number of the employee will be printed.

Band When this field is checked the band number/name of the employee will be printed.

Birth Date When this field is checked the employee�s birth date will be printed.

Category When this field is checked the employee�s assigned category will be printed.

Medical

Reference

When this field is checked the employee�s additional medical reference number will be printed.
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Layout 1

Selection

The second dialog box for theNameandAddressLabelLayout appears as follows:

Defaults The default selections can be re-displayed by selecting the default selections in the
filemenu. If youwish to always use the defaults select theSaveParameter option in
the File menu.
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Layout 2

Selection

The second dialog box for theNameandAddressLabelLayout appears as follows:

Defaults The default selections can be re-displayed by selecting the default selections in the file
menu. If you wish to always use the defaults select the Save Parameter option in the
File menu.
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In order to design a label layout you must specify the following 3 things:

n Off-Set

n Column

n Field Length

Off-Set This is the line offset used for printing the name and address information. Eg) If you
want this field to print on the first line of this name and address information use an
off-set of zero. If it is to follow on the second line use an off-set of 1. Youmay have as
many off-sets as you need to print all the fields you have selected.

Column This is the character position on the print line for the name and address information.
Eg) If the field is to start 5 spaces in from the left hand margin enter a 6 in the column
field. The column numbers are only limited by the number of characters you can print
on each line of your selection page.

Field Length This is the number of characters that make up the field. Eg) Employee number is 10
characters long. If you want to see the entire employee number enter 10 in the field
length. If you are doing the date which is 10 characters you may choose to print only
the last 5 giving you mm/dd. The date field is the only field that takes the characters
from the right hand side.
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Sizes Selection The following dialog box for the Name and Address Label appears as follows:

The default number of characters contained in each field are displayed on the report
field sizes. To change any of the field lengths highlight the fields length and overtype
with a new value.
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Label Selection The following dialog box for the Label appears as follows:

In laying out the label the other things the program needs to know is:

1. The number of lines your label will hold. A standard label is 8 lines long.

2. The line the label information will start on. This means that after the heading
fields are printed the label information will start on which line number.

F Label Legend - You can specify if the legend will be printed above or to the left of the
label information.

Print Sample

Label

This will print a sample label for you to verify the line up of your label.
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Employee Profile Report

When the user selects the Employee Profile Report from the Reports menu the
following screen will appear:

Data Field A data field is selected when the box to the left of the field has a check mark.
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The data field selection for the report allows for the inclusion of the following data
fields:

Field Description

Name When this field is checked the name of the employee will be printed.

Start Date When this field is checked the starting date of the employee will be printed.

Birth When this field is checked the birth date of the employee will be printed.

Home Phone When this field is checked the home phone number of the employee will be
printed.

Alt Phone When this field is checked an alternate phone number of the employee will be
printed.

Fam. Medical When this field is checked the employee�s family medical number will be
printed.

Address 1 When this field is checked the employee�s address will be printed.

Address 2 When this field is checked the an additional address will be printed.

City When this field is checked the city the employee lives in will be printed.

Province When this field is checked the province the employee lives in will be printed.

Postal Code When this field is checked the postal code of the employee will be printed.

Badge When this field is checked the badge number of the employee will be printed.

Number When this field is checked the employee�s number will be printed.

S.I.N. When this field is checked the employee�s social insurance number will be
printed.

Sex When this field is checked the sex of the employee will be printed.

Position When this field is checked the position of the employee will be printed.
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When the user selects thePayroll tab from the Employee Profile Report the following
screen will appear:

The following table gives a description of the screen:

Field Description

Payroll Status This field contains the employee�s current status and will print if
selected.

Revenue Canada This field will display full or reduced rate designation and will print if
selected.

W.C.B. Level When this field is checked the WCB rate code assigned will be printed.

Health Code Level When this field is checked the payroll tax rate code assigned will be
printed.

Stat Canada Code When this field is checked the Statistics Canada Code assigned will be
printed.

Standard Hours When this field is checked the employee�s standard work week hours
will be printed.

Bank Account 1 If this field is checked the employee�s bank account number for direct
deposit will be printed.

Bank Account 2 If this field is checked the employee�s second bank account number will
be printed.

Bank Account 3 If this field is checked the employee�s third bank account will be
printed.
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When the user selects the Amount tab from the Employee Payroll Profile Report the
following screen will appear:

The following table gives a description of the pay period report fields:

Field Description

Starting Date When this field is checked the starting date of the selected pay period
will be printed.

Ending Date When this field is checked the ending date of the selected pay period
will be printed.

Cheque Date When this field is checked the cheque date of the selected pay period
will be printed.

Run Number When this field is checked the pay period run number of the selected
pay period will be printed.

Run Type When this field is checked the type of run of the selected pay period
will be printed. ie: Normal

Run Sequence When this field is selected the system assigned run sequence number
of the selected pay period will be printed.

Gross Pay When this field is selected a single gross pay summary total from the
selected pay run will be printed.

Deductions When this field is checked a single company summary total
deductions amount from the selected pay run will be printed.

Benefits When this field is checked a single company summary total benefits
amount from the selected pay run will be printed.

Net Pay When this field is checked a single net pay summary total from the
selected pay run will be printed.

Insured Earnings When this field is selected a single summary insurable earnings total
from the selected pay run will be printed.

Units When this field is checked a single summary units total from the
selected pay run will be printed.
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Hours When this field is checked a single summary of actual hours total from
the selected pay run will be printed

When the user selects the Sort tab from the Employee Payroll Profile Report the
following screen will appear:

The sort order selection for the report allows for the following sort order selections:

n Employee Name

n Province

n Statistics Canada Code

n Employee Number

n Badge Number

n Employee Status
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When the user selects the Select tab from the Employee Payroll Profile Report the
following screen will appear:

ate Range

Selection

To limit the range of the report the starting and ending dates may be entered. If both
dates are zero the entire report will be printed. If only the ending date is zero the
reportwill print from the starting date until the end of the current reporting period.

Select Employee

Selection

To choose a single employee option for theEmployee ProfileReport select the Select
Employee Option.

Select Positions To choose a single position option for the Employee Profile report select the Select
Positions option.
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When the user selects the Report tab from the Employee Payroll Profile Report the
following screen will appear:

Page Break

Selection

The page break selection for the report allows for the insertion of page breakswhen the
program encounters a break on the sort key.

Print to Selection The Print to selection for the report allows for the report to be printed to the printer or
on the screen.

Print Pay Run

Details

The user may select the option of printing all detail lines pertaining to the selected pay
run for each employee.
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Record of Employment

A Record of Employment (ROE) must be issued by employers within five calendar
days after an employee�s interruption of earnings or the day the employer becomes
aware of the interruption. This document is used by Human Resources Development
Canada (HRDC) to determine whether a person qualifies for Employment Insurance
benefits, how much he or she will receive and the length of time the benefits will be
received.

When the user selects the Record of Employment from the Reports menu the
following screen will appear:

This screen contains a list of employees. To choose the employee for the ROE
highlight the employee and select the OK button.

To prepare a new Roe for an Employee. Choose INSERT. The Employee Name
selection box will appear:

To select an employee type in the surname, or do a next or previous. Once you have
verified your selection press OK.
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When the user selects the OK button from the Name in Payroll screen the following
screen will appear:

The Employee ROE Update Screen is used to print a ROE.

The following table gives a description the data fields:

Field Description

Serial Number This field is used to input the serial number of the ROE
form.

Amended Serial No. This field is used to enter in the serial number of a
previously issued ROE that is being replaced.

Company This field is displays the name of the company.

Address This field is displays the address of the company.

Revenue Canada

Account

This field is displays the business number used to report
payroll source deductions for the employee. This field
can be overtyped.

Pay Period This field displays one of the pay period frequency
types from the chart provided on the reverse of the
ROE. This field can be overtyped.

With the exception of the amended serial number field, these fields will be filled in
from existing data. Any field can be over typed for changes.
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When the user selects the 8-9 Tab on the Record of Employment the following screen
will appear:

The following table gives a description of the data fields:

Field Description

Employee Number This field will display the employee�s assigned payroll
employee number.

S.I.N. This field contains the employee�s social insurance number.

Employee Name This field contains the employee�s name.

Address This field contains the employee�s address.

Postal Code This field contains the employee�s postal code.
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When the user selects the 10-14 tab on theRecord ofEmployment the following screen
will appear:

The following table gives a description of the data fields:

Field Description

First Day Worked This field is used to enter in the first actual day of
employment or the first day the employee returned to
employment after an absence for which a previous ROE was
issued.

Last Day of which Paid This field is used to enter the last day for which the employee
was paid.

Final Pay period Ending

Date

This field is used to enter the final pay period for which the
employee has earnings.

Occupation This field is used to enter a short description of the employees
position for statistical purposes.

Recall Date This field is used to enter the date the employee can be
recalled.

1996 Weeks and Insurable Earnings: These fields will contain the appropriate data for

1996 if applicable. This filed will remain blank if period is greater than the maximum

reportable period of 53 weeks.
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When the user selects the 15 tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Total Insurable Hours This field displays the total insurable hours for the number of
pay periods according to the chart on the reverse side of the
ROE. This field may be changed

Total Insurable Earnings This field is the total insurable earnings for the number of pay
periods according to the chart on the reverse side of the ROE.
Changes to this field are permitted.
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When the user selects theHour Sub -Menu tab from the 15 tab the following screen
will appear:

The following table gives a description of the data fields:

Field Description

Hours Break Down These fields are used to enter the first insurable hours paid on or
after January, 1997. Report any 1996 insurable periods only in
block 18.
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When the user selects the Hours Continued Sub-Menu tab from the 15 tab the
following screen will appear:

The following table gives description of the data fields:

Field Description

Hours Breakdown Last Part These fields are used to enter the first insurable
hours paid on or after January, 1997. Report any
1996 insurable periods only in block 18.
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When the user selects theEarningSub-Menu tab from the 15 tab the following screen
will appear:

The following table gives a description of the data fields:

Field Description

Insurable Earnings This field is used to enter any gaps in service for the required period
of report.
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When the user selects the 16 tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Reason Codes These fields are used to check the reason for the
interruption of earnings.

Contact Name and

Phone

A contact name and phone number can also be
inserted. The first Record of Employment issued by
the GrandMaster Suite Payroll will require that this
field will be entered. Subsequent Records of
Employment will default to this name and phone
number unless modified.
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When the user selects the 17 tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Vacation Pay This field is used to enter the amount of any vacation pay paid or
owing to an employee on the interruption of earnings.

Statutory Holidays This field is used to enter the date and amounts owing or paid for
any statutory holidays that occurs after the date entered in block
11.

Other Monies This field is used to enter any other amounts or payments owing
to an employee after the interruption of earnings. Eg) Severance
pay, retiring allowances, wages in lieu of notice, lump sum and
on going pension payments, bonuses and retroactive wage
increases.
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When the user selects the 18-22 tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Comments This field is used to enter any information or comments that might be helpful
to prevent telephone calls from HRDC for further clarification.

Paid Leave This field is used to enter the amount for the employee if eligible for an
employer paid sick, maternity, parental or adoption leave, or if entitled to
payments under a wage loss indemnity plan. Enter the payments start date
and the weekly or daily rate.

Issuer

Information

This field is used to check if you want the communication in English or
French.

Telephone This field is used to enter the ROE issuer�s telephone number.
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Journal Entry

When the user selects the Journal Entry option, a report containing all general ledger
transactions pertaining to a payroll (or group of payrolls) is created. The information
on the report can also be exported to a file for direct interface with an accounting
software package.

When the user selects the Journal Entry from the Report menu the following screen
will appear:

Starting Payroll

Selection

By pressing the start button a list of all closed (history) pay runswill be presented. The
Journal Entry starting pay run can be chosen from this list.

Ending Payroll

Selection

By pressing the End button the list of the closed (history) pay runs will be presented.
The Journal Entry ending pay run range can be chosen from this list.

Print To Allows the user the option of printing to the printer or to the screen.
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When the user selects the Sort tab the following screen will appear:

The following table gives a description of the screen:

Field Description

Sort Order

G/L Code The Journal Entry can be selected to sort by the General Ledger codes as the
primary sort. The G/L Codes will appear in numeric order. When this option
is selected the sub-totals by G/L total is the default system setting for sub-total
fields printed/exported. Note: Although the system defaults at start up to the
G/L code sort order you must actively select it to turn on the default
sub-totalling.

Distribution G/L The Journal Entry can be selected to sort by G/L Code within a Distribution
Table. All Earnings, Deductions, Accumulators expense and liabilities can be
sorted within the appropriate department/distribution cost centre if this set up
applies. When this option is selected the sub-totals by G/L code within
distribution totals is the default system setting to the sub-total fields
printed/exported.

G/L Type The Journal Entry can be selected to sort by type of G/L allocation. When this
option is selected the sub-totals by G/L total within type totals is the default
system setting for the sub-total fields printed.

Distribution Type The Journal Entry can be selected to sort by the distribution type. When this
option is selected the sub-totals by type within the distribution totals is the
default system setting for the sub-total fields printed/exported.

Sub-Totals: The sub-totals revert to a system default setting based on the sort order selection

made. In addition a sub-total by employee can be obtained within the sort order and

sub-total selections already chosen.

Additional Options

Print Details At times it may be necessary to print all Transaction Detail to support the G/L
code and distribution table allocations. Selecting the print details option will
print every detail item within the pay run range selected for the report. If this
option is not checked the system will produce a single summary line within the
sort order selected criteria.
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Field Description

Page Break This is an option available to turn on page breaks within sort order
sub-totalling selections.

Use Employee

Default

The option exists to override transaction input distribution and have the system
allocate all transactions according to each employee�s base distribution tables.

Print All Hours This option should be selected if the user requires the total number of all hours
associated with each earning to be printed/exported.

Print Net Hours This option exists to select a net number of all hours associated with each
earning to be printed/exported including adjustments and credits in a single
total number with entered hours.

When the user selects the export tab the following screen will appear:

The following table gives a description of the screen:

Field Description

Format Allows the user to select the financial accounting system format that the Journal
entry is exporting to:

File The file name that is being exported should be entered in this field.

Generate Export

File

Selecting this option causes the system to generate the export file in accordance with
the sort order and accounting system format selected.

Append to File Selecting this option will direct the system to generate an additional export file and
add it to an existing export file.

Export Data: Some accounting/financial systems require the period processing dates to be part of

the import batch information. GrandMaster Suite Payroll System allows for this information to

become part of the Journal Entry Export File.

Fiscal Year The 4 digit year of the fiscal period can be entered in this field.

Fiscal Period Up to 2 digit fiscal period/voucher month can be entered in this field.

Posting Date The date of the file export/import can be entered here in YYYMMDD format.
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When the user selects CSV1 Sub-Menu tab on the Export tab on the Journal Entry
Report the following screen will appear:

The boxes to the right of the data field names are used to input the field position on the
Export file.

When the user selects theCSV2Sub-Menu tab on theExport tab on the Journal Entry
Report the following screen will appear:

The boxes to the right of the data field names are used to input the field position on the
Export file.

The fields labeled Literal 1 to 4 are used to input the field position and a value thatmay
be exported to the finacial/accounting system.
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Payroll Payrate Reports

The Payroll Payrate Reports menu from the menu bar is used to print payrate reports
from the payroll data.

The Payroll Payrate Reports menu appears as follows:

F Payroll Payrate Reports

n Payroll Earning Report

n Payroll Deduction Report

n Payroll Accumulator Report

n Payroll Earning Report

Please refer to theGlobal PayrateReports in thismanual formore information on these
reports.
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Global Payrate Reports

The Global Payrate Reports menu from the menu bar is used to print Pirate reports
from the payroll data.

The Global Payrate Reports menu appears as follows:

F Global Payrate Reports

n Global Earning Report

n Global Deduction Report

n Global Accumulator Report

n Global Earning Table Report
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Global Earning Report

The Global Earning Report option prints a listing of the Earning Payrates for each
employee, payroll or global payroll depending on the menu choice.

This function allows the user to select the date range for the report, the data fields to be
included in the report, when to page break, and to select the earning & position to be
included in the report.

If a single employeewas selected before running this program only that employeewill
be printed. The employee name will be shown after the report title at the top of the
window when only one employee is selected.

The dialog box for theGlobal Earning Report option in the reports menu appears as
follows:

Saving... The selectionsmade by the user can be saved by selecting theSaveParameters option
in the File menu.
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Date Range

Selection

To limit the range of the report the starting and ending date may be entered. If both
dates are zero the entire report will print from the starting date until the end of the
report.

Report Fields

Selection

A data field is selected for the report when the box to the left of the field has a check
mark.

Field Description

Earning When this field is checked the earning code for the global earning will
be printed.

Description When this field is checked the long description for the global earning
will be printed.

Status When this field is checked the status for the global earning will be
printed.

Rate When this field is checked the rate for the global earning will be printed.

Rate Units When this field is checked the unit of the rate for the global earning will
be printed.

Rate Type When this field is checked the type of rate for the global earning will be
printed.

Date From When this field is checked the date the earning is effective from for the
global earning will be printed.

Date Until When this field is checked the date the earning is effective until for the
global earning will be printed.

Short Desc. When this field is checked the pay statement description for the global
earning will be printed.

Unit Amount When this field is checked the earning unit amount for the global
earning will be printed.

Base When this field is checked the base earning to calculate multiples on or
for the global earning will be printed.

Multiplier When this field is checked the multiplier for the global earning will be
printed.

Control Flag When this field is checked the control flag for the global earning will be
printed.

Mod. Lower Level When this field is checked the message if the earning is modifiable at a
lower level for global earning will be printed.

Alternate Desc. When this field is checked the alternate description for the global
earning will be printed.

Taxable Amounts When this field is checked the taxable amount for the global earning will
be printed.

Taxable Hours When this field is checked the taxable hours for the global earning will
be printed.

G/L Distribution When this field is checked the G/L distribution for the global earning
will be printed.
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Page Break

Selection

If the box to the left of yes has a checkmark the reportwill start each earning object.

Select Earnings

Selection

To choose earnings to the Global Earning Report select the select earnings object.

For instructions on how to select earnings refer to the Common Selection Screen
chapter of this manual.

Select Positions

Selection

To choose selected positions for the Position Assignment Report select the Select
Positions object.

For instructions on how to select positions refer to the Common Selection Screen
chapter of this manual.

If you have selected positions the message Exclude Selections or Include Selections
will be displayed beside the selection buttonwhen you return to the select report object
dialog box.
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Global Deduction Report

The Global Deduction Report option prints a listing of the Deduction Payrates for
each employee, payroll or global payroll depending on the menu choice.

This function allows the user to select the date range for the report, the data fields to be
included in the report, when to page break, and to select the deduction to be included in
the report.

If a single employeewas selected before running this program only that employeewill
be printed. The employee name will be shown after the report title at the top of the
window when only one employee is selected.

The dialog box for theGlobal Deduction Report option in the reports menu appears
as follows:

Saving... The selectionsmade by the user can be saved by selecting theSaveParameters option
in the File menu.
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Date Range

Selection

To limit the range of the report the starting and ending date may be entered. If both
dates are zero the entire report will print from the starting date until the end of the
report.

Report Fields

Selection

A data field is selected for the report when the box to the left of the field has a check
mark.

Field Description

Deduction When this field is checked the deduction for the global deduction will be printed.

Position When this field is checked the position for the global deduction will be printed.

Description When this field is checked the description for the global deduction will be printed.

Deduction Status When this field is checked the deduction status for the global deduction will be printed.

Deduction Type When this field is checked the deduction type for the global deduction will be printed.

Journal Entry Flag When this field is checked the journal entry flag for the global deduction will be printed.

Cheque Flag When this field is checked the cheque flag for the global deduction will be printed.

Calculation Flag When this field is checked the calculation flag for the global deduction will be printed.

Date From When this field is checked the date the deduction is effective from for the global deduction
will be printed.

Date Until When this field is checked the date the deduction is effective until for the global deduction
will be printed.

Short Description When this field is checked the pay statement description for the global deduction will be
printed.

Calculation Code When this field is checked the calculation code for the global deduction will be printed.

Calculation Table When this field is checked the calculation table for the global deduction will be printed.

Custom When this field is checked the custom for the global deduction will be printed.

Calculation Class When this field is checked the calculation class for the global deduction will be printed.

Elements When this field is checked the elements for the global deduction will be printed.

Always Enable When this field is checked the always enable for the global deduction will be printed.

Mod. Lower Level When this field is checked the message if the deduction is modifiable at a lower level for the
global deduction will be printed.

Taxable Amounts When this field is checked the taxable amounts for the global deduction will be printed.

Taxable Hours When this field is checked the taxable hours for the global deduction will be printed.

Fixed Deduction When this field is checked the fixed deduction for the global deduction will be printed.

Fixed Benefits When this field is checked the fixed benefits for the global deduction will be printed.

G/L Distribution When this field is checked the G/L distribution for the global deduction will be printed.

Page Break

Selection

If the box to the left of yes has a check mark the report will start a new page for each
deduction object.
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Select Deductions

Selection

To choose deductions to the to the Global Deduction report select the select deduction
object.

For instructions on how to select deduction refer to the Common Selection Screen
chapter in this manual.

Global Accumulator Report

TheGlobal Accumulator Report option prints a listing of the Accumulator Payrates
for each employee, payroll or global depending on the menu choice.

This function allows the user to select the date range for the report, the data fields to be
included in the report, when to page break, and to select the accumulator to be included
in the report.

If a single employeewas selected before running this program only that employeewill
be printed. The employee name will be shown after the report title at the top of the
window when only one employee is selected.

The dialog box for the Global Accumulator Report option in the reports menu
appears as follows:

Saving... The selectionsmade by the user can be saved by selecting theSaveParameters option
in the File menu.
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Date Range

Selection

To limit the range of the report the starting and ending date may be entered. If both
dates are zero the entire report will print from the starting date until the end of the
report.

Report Fields

Selection

A data field is selected for the report when the box to the left of the field has a check
mark.

Field Description

Accumulator When this field is checked the accumulator code for the global accumulator will be printed.

Description When this field is checked the description for the global accumulator will be printed.

Acc. Status When this field is checked the acc. status for the global accumulator will be printed.

Paid Status When this field is checked the paid status for the global accumulator will be printed.

Max. Amts When this field is checked the max. amts for the global accumulator will be printed.

Fixed Amts When this field is checked the fixed amts for the global accumulator will be printed.

G/L Dist When this field is checked the g/l dist for the global accumulators will be printed.

Date From When this field is checked the date the accumulator is effective from for the global
accumulator will be printed.

Date Until When this field is checked the date the accumulator is effective until for the global
accumulator will be printed.

Short Desc When this field is checked the pay statement description for the global accumulator will be
printed.

J.E. Flag When this field is checked the J.E. flag for the global accumulator will be printed.

Neg. Flag When this field is checked the Neg. flag for the global accumulator will be printed.

Payout Flag When this field is checked the payout flag for the global accumulator will be printed.

Cheque Flag When this field is checked the cheque flag for the global accumulator will be printed.

Control Flag When this field is checked the control flag for the global accumulator will be printed.

Mod. Lower Level When this field is checked the message if the accumulator is modifiable at a lower level for
global accumulator will be printed.

Alternate Description When this field is checked the alternate description for the global accumulator will be printed.

Selections When this field is checked the selection for the global accumulator will be printed.

Parameters When this field is checked the parameters for the global accumulator will be printed.

Default Earnings When this field is checked the default earnings for the global accumulator will be printed.
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Page Break If the box to the left of yes has a check mark the report will start each accumulator
object.

Select

Accumulator

Selection

To choose accumulators to the Global Accumulator Report Select the Select
Accumulator object.

For instructions on how to select accumulators refer to the Common Selection Screen
chapter of this manual.
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YEAR-END PROCESSING

The year end process will extract T4, T4A, and Relevé 1 information from the payroll
database, and allow the user to clear YTD amounts. This year-end information is kept
in a separate file for additional editing and processing. The Year-Endmenu appears as
follows:

During the year-end process, the user will be prompted to confirm the decisions made
by the system regarding placement of earnings, deductions, and benefits. Check your
Employer's Guide To Source Deductions to verify year-end processing decisions.

N In most provinces, a Workers' Compensation report is required at year-end. Refer to
the Workers Compensation section in the Creating Reports chapter for information
on generating a Workers' Compensation report.

The Year-End functions integrated into GrandMaster Suite reflect the current
specifications as outlined by Revenue Canada. When Revenue Canada updates
information pertaining to year-end calculations, these changeswill be integrated into
the GrandMaster Suite January update.

Can-Pay Computer Software 269

YEAR-END PROCESSING - 7

Y
E
A
R
E
N
D

PR
O
C
E
SS

IN
G



Type of Pension Adjustment

F - Fixed Monthly

Benefit

This calculation is based on the months of employment during the current year times
the user-given benefit amount.

An employee is credited $25.00 per month for each completed month of service.

P - Percent of

Contributions

This calculation uses the employee's year-to-date Pension Contribution (deduction
plus company benefit) times a user-supplied percentage.

An employee is credited with 2.00% of the total contributions to his pension plan.

I - Integrated

with

C.P.P./Q.P.P

This calculation uses pensionable earnings times a user-supplied percentage for
earnings below Yearly Maximum Pensionable Earnings (YMPE) and a second
user-supplied percentage for earnings above YMPE. Any earning between $75,000
and $86,111 are excluded from the calculation.

An employee is credited with 1.4% below YMPE and 2.0% above YMPE.

M - Money

Purchase Plan

This calculation is the combined total of the employee deduction and the company's
contribution to the employee's pension plan.

F We strongly recommend that the user thoroughly review the GrandMaster Suite
PensionAdjustment calculation, especially in special situations such as rehires during
the year, adjustments for prior years service, sabbatical leave, etc. We also strongly
recommend that you contact your actuaries in all matters regarding Pension
Adjustment!
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Creating T4\T4A�s

The following screen will appear when the user selects creating T4/T4A�s:

The following table gives a description of the screen:

Field Description

Pay Year

Pay Period

Pay Sequence

Pay Ending Date

Cheque Date
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When the user selects the Earnings Tab the following screen will appear:

When the user selects the Deductions Tab the following screen will appear:
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T4/T4A Data Report

The following screen appears when teh T4\T4A Data Report is chosen:

The following table gives a description of the screen:

Field Description

Tax Year

Revenue Canada

Number

Employee Number

Revenue Canada

Totals

Employee Name

Can-Pay Computer Software 273

YEAR-END PROCESSING - 7

Y
E
A
R
E
N
D

PR
O
C
E
SS

IN
G



Edit T4/T4A Data

When the user selects Edit T4 and T4a data the following screen will appear:

The following table gives a description of the screen:

Field Description

Tax Year

Name Order

Within Revenue Canada Number

Limit to Current Payroll

Number Order

Starting Employee

274 Can-Pay Computer Software

7 - YEAR-END PROCESSING



Print T4 Statment

When the user selects the T4 statement the following screen will appear:

The following table gives a description of the screen:

Field Description

Tax Year

Sequence

Laser Printer Forms

Continous Forms

By name

By Number

By Category

Category

Magnetic Media Filing

Print Laser Copy One

Top Margin

Right Margin

Direct I/O Epson

Direct I/O Hp Laser

Printer

Bin 1

Bin 2

Bin 3

Can-Pay Computer Software 275

YEAR-END PROCESSING - 7

Y
E
A
R
E
N
D

PR
O
C
E
SS

IN
G



T4 Magnetic Filing

When the user selects T4 magnetic filing the following screen will appear:

The following table gives a description to the screen:

Field Description

Tax Year

Test

Original

Replacement

Multiple

Company

Statement

Output File Name

Transmitter

Number

Contact Name

Contact Phone #

Name 1

Name 2

Address 1

Address 2

City

Province

Postal

276 Can-Pay Computer Software

7 - YEAR-END PROCESSING



Can-Pay Computer Software 277

YEAR-END PROCESSING - 7

Y
E
A
R
E
N
D

PR
O
C
E
SS

IN
G



.



EMPLOYEE INFORMATION

The Employee menu from the main menu bar is used to either access the Employee
menu bar, enter hours worked for employees, or to add a new employee. The
Employee menu bar allows the user to apply/remove payroll settings, previously
defined at the global or payroll level, to/from individual employees.

The Employee menu appears as follows:

The options available to the user are:

n add an employee

n hours entry

n employee data entry and updates
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Add an Employee

Adding employees to the payroll can be done from either the Add Employee option
under the Payroll Employee menu, or by choosing the Add An Employee option
under the File menu item on the Employee menu.

TheAdd anEmployee function displays a screen that allows you to enter the name of
a person that may not be in the payroll. The following screen will appear:

When you enter the surname of an employee or the first 3 or 4 characters of the
surname in the Name field of this screen, the system searches for a person with that
name in the payroll. If this name is found a screen is displayed showing any names
that are a close match to the name entered.

When you are first setting up a payroll you will usually see a screen that does not
contain any names. The screen appears as follows:

If the screen does contain the name of the person that you want to add to the payroll,
select the name by clicking on the line the person appears in, and press the OK button
to select the person.
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Update The UPDATE button is used to call up the selected person�s record for changes to the
existing data.

Delete The DELETE button is used to mark the selected person for removal from the file.

Insert The INSERT button is used to add a new person to the file. You will normally do this
when adding a new person to the payroll.

The screen used to add a new person contains a notebook of 5 pages. Each page
contains fields for data about the person being added to the file. The screen appears as
follows:
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The Address page of the notebook appears as follows:

The following table contains a description of the fields in the screen:

Field Description

Surname This field contains the surname of the employee.

Given Name The given name of the employee is entered into this field.

Address 1 The Address Line 1 field is used to enter in the address of the employee.

Address 2 Line 2 is used as an extra address field if the space is needed.

City This field contains the city in which the employee lives.

Province The province of the employee must be entered into this field. Note: The
employee�s tax province will default to the address province unless it is
changed on the payroll specific notebook that follows.

Postal Code This field is for entering the employee's postal code.
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The ID page of the notebook appears as follows:

The following table contains a description of the fields in the screen:

Field Description

S.I.N. If the social insurance number is not valid the system will issue an error
message when the OK button is clicked, and will ask for the field to be
corrected. If the social insurance number is blank the system will issue a
warning message, but will allow you to continue (as in the case where the
employee has not yet been issued a S.I.N.). The payroll administrators should
ensure that all employees have valid social insurance numbers.

Badge Number The badge number of the employee is contained in this field. Using a badge
number is optional.

Treaty Number If the employee has a treaty number, it may be entered in this field.

Band Name This field is used to enter in the band name of employee, if applicable.

Employment Dates

Original Start This field is used to record the initial employment start date. Normally, once
this field is completed it would not be changed in the event that an employee
may leave and return. This date will indicate the original start date for tracking
purposes. The rehire date(s) are recorded elsewhere.

Last

Termination

This field is used to record the most current termination or it will be
automatically filled in with the issuance of a record of employment for an
employee.
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TheMedical page appears as follows:

The following table contains a description of the fields in the screen:

Field Description

Medical

Number

An employee's medical number can be entered in this field.

Family

Number

The employee's family medical number can be entered in this field.

Reference

Number

The employee's reference number can be entered in this field.
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The Personal page appears as follows:

The following table contains a description of the fields in the screen:

Field Description

Birth Date The birth date of the employee should be entered into this field in
YYYY/MM/DD format.

Sex Either �M� for male, or �F� for female is used to enter in the employee's sex in
this field. Data can be entered into this field using the pull down menu.

Home The home phone number of the employee can be entered into this field.

Alternate An alternate phone number used to reach the employee may be placed in this
field.
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The Notes page appear as follows:

The notes page of the notebook contains the following data fields:

n The screen contains 10 fields that each contain a 10-character code.

n These codes are defined in the code validation updatewith the description of the
user defined code

n These can be any codes that you want to use to identify additional anecdotal
information about the employee, such as; St. John - St. Johns Ambulance first
aid.

Pressing the OK button when you are finished filling out the notebook will confirm
that this is the employee you want to add to the payroll.
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Assign Employee Number

The Assign Employee Number screen will then appear:

The Employee Number must be unique within the payroll. If the number has been
assigned to another employee an error message will be displayed. The employee will
not be added until a unique employee number is assigned. The screen also contains a
field to enter the Employee Model Code. When you use an employee model the
system will automatically fill in the data fields specified in the model and set up the
Earning, Deduction andAccumulator types that are specified in themodel. The use of
Employee Models can greatly reduce the work of setting up employees. If the
EmployeeModel is not used the functionwill establish an employee and youwill have
to fill in all the data fields and enable the Earning,Deduction andAccumulator types in
Detail. Pressing the OK button will add the employee to the payroll.
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Payroll Specific Information

After the Employee is added to the payroll the notebook to enter the payroll specific
employee data will be displayed. The Payroll Specific Information notebook is
automatically displayed when adding a new employee. This screen appears as
follows:
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Payroll Specific Information

The Payroll Specific information screen contains a notebook with nine pages. Each
page is used to enter data for the payroll.

The Status page is used to enter several fields that are used to define the status of the
employee in the payroll. The Status tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen.

Field Description

Employee Number The unique number assigned to the employee to identify him or
her on this payroll.

Payroll Status This field contains the employee status on this payroll. It can be
one of : Active, On Leave, Terminated, Special, Last Pay, Deleted
or Laid off, from a drop down menu.

Rev Can Account This field contains the Revenue Canada Account (or Business
Number) under which statutory deductions for this employee are
to be remitted to Revenue Canada. The description of the account
will be displayed from a drop down menu.

Tax

Province This field contains the province of employment, or the province in
which the employee is taxed. This field is defaulted to be the
province from the employee�s home address unless changed.

Calculation This field determines the calculation of the payroll. It can be any
one of: Normal, No Federal Tax, Fixed amount of Tax, Percent of
Taxable, Balance net pay amount from a drop down menu.

Override This field is used to indicate specific tax rates or amounts if a tax
calculation method is selected which is different than normal or no
federal tax.
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The Base tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen:

Field Description

Base

Earning This field contains the normal default earning
code number for this employee.

Distribution This field contains the normal default distribution
table code that this employee costs of wages is
assigned to.

Position This field contains the position of this employee.

Model This field contains the model the employee has
been assigned to.

Statistics Canada

Code This field contains the Statistics Canada code
(hourly/salary/other), for the employee.

Zone This field contains the Statistics Canada assigned
zone number, that can be used to sort the
Statistics Canada Report.

Full Time

Frequency

This field is used in conjunction with scheduling
to determine the full time equivalency for this
employee in this payroll. The system will default
to 1, if no other figures are entered.
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The Tax tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen.

Field Description

Net Claim The Net Claim Amount found on the employee's TD1 Claim
form. The system sets a default setting of the current base
exemption.

Additional Tax Indicates the amount of additional tax to be deducted for the
employee at the employee�s request.

Additional Allowances

Remote Allowance An allowance for persons living in a designated area, as per
Revenue Canada guidelines.

Other Allowances Special tax allowance for persons living in a designated
area, as per Revenue Canada guidelines.

Labour Credit (LCP) This field is used to enter the amount of the LCP credit.

Other Federal Amount This field is used to enter the amount of other federal tax
credits.
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The Stat�s tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen.

Field Description

Exempt C.P.P. If this field is checked if the employee is C.P.P.
exempt.

Age The employee�s age, display only.

Birth Date The employee�s date of birth, display only.

Over Amount This field can be used to insert a permanent CPP
override amount to be deducted each pay run.

Exempt E.I. If this field is checked, the employee is E.I. exempt.

Dependents The number of dependents (such as, children under
the age of 18, or disabled) for this employee.
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The Prov�s (Provinces) tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen.

Field Description

W.C.B. Information

WCB Province This field contains the province code and description,
default setting from employee�s name and address.

WCB Rate Code This field contains the rate level to use for the Workers
Compensation calculation using rate table set at payroll
level.

Health Information

Health Province This field contains the province code and description,
default setting from employee�s name and address.

Health Type This field will allow you to select the type of calculation.
The choices are to use a fixed rate or select a code level.

Health Rate Code If the type of calculation is by code level this field
contains the level of rate code to use.

Health Rate If the type of calculation is by rate this field contains the
fixed rate for the health tax calculation.

Quebec Information

Net Claim The net claim amount for the employee. The system sets
a default QD1 amount as current base exemption.

Additional Indicates the amount of additional tax to be deducted
from the employee for Quebec Tax remittance.

Other Other allowed tax credits can be inserted here.
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Override This field is used to enter the percentage or amounts to be
used in the employee�s tax calculation if other than
normal is specified.

Override Calculation This field determines the tax calculation type for the
employee.

The EFT tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen.

Field Description

Bank Format This field contains the bank profile type code assigned for
issuer�s bank. F8 will present a list of defined bank profiles.

Turn OFF Direct

Deposit

If this field is checked the EFT function is turned off for this
employee.

Turn OFF Printing of

Pay Cheque

If this field is checked the employee�s pay cheque will not
print.

Employee Level

Message

A specific message for this employee which will print on the
pay statements
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The EFT screen has secondary tabs. They are as follows:

n Bank 1 - First Bank

n Bank 2 - Second Bank

n Bank 3 - Third Bank

The information to be entered for each bank is as follows:

Field Description

Account This field contain the bank account number. The employee�s
bank account number should be entered as 5 digit transit
number, 3 digit bank ID number and then the account number.

Name This field contains the name of the bank.

Address This field contains the address of the bank.

City This field contains the city the bank is in.

Province This field contains the province the bank is in.

Postal This field contains the postal code of the bank.

Maximum This field contains the maximum amount of deposit for this
account.

Turn off this

account

If this field is checked this account is not to be used.
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The CAT (category) tab of the notebook appears as follows:

These 10 category codes allowyou to set up codes to sort on, or to select employees by.
These codes are user defined and may be set up in Code Validation Update. (F8)

The Category codes can be 10 characters long. An example of its use could be to
assign Category 1 the department number or name. When a report offers a sort choice
by category you could useCategory 1 and the reportwould sort by department number.

If you are recently converted fromourGrandMaster I or II payroll product, the first 5 to
7 categories will already have familiar data in these fields from the conversion.

Category 1 = For GM I & GMII Department numbers that the employee belonged to will be
in this field.

Category 2 = General ledger account number for this employee

Category 3 = For GMII, sub-account number for this employee

For GMI, Position Name or Number for this employee

Category 4 = For GMII, Position Name or number for this employee

=For GMI, Employment Canada designation of full rate/parttime or reduced
rate/ full time.

Category 5 = For GMII, Employment Canada designation as full rate/part time or reduced
rate/full time.

= For GMI, Company Code

Category 6 = For GMII only, Optional field �A� Contents

Category 7 = For GMII only, Optional Field �B� Contents
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TheWeek tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen:

Field Description

Days of the Week This field contains the days represented by the day of the
week. Sunday - 1 Monday - 2 etc.

Hours in a Week This field contains the total number of hours worked in a
week for this employee.

Hours by Day This table breaks down the hours worked per day. If you
change the hours in a day the total hours in the week will
be updated.

F If no entries are made on this page of the notebook, the system will assume a standard
workweek to beMonday to Friday inclusivewith 40 hours in theweek and 8 hours in a
day
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The Dates tab of the notebook appears as follows:

The following table provides a description of the data fields within this screen:

Field Description

Initial Hire Date This field contains the first day the employee worked as part of this
payroll.

Rehire Date This field contains the date that an employee has returned to work for the
company.

Last Date This field contains the last day the employee worked as part of this
payroll. Note: Upon rehire this date must be deleted. Employment
periods history is maintained in the record of employment file.

Anniversary Date This field is used to enter the month and day of the employee�s annual
anniversary date.

Vacation

Anniversary

This field is used to enter the month and day of the employee�s annual
vacation evaluation start date.

Holiday Anniversary This field is used to enter the month and day of the employee�s annual
holiday evaluation start date. This could be used to indicate the first
statutory/company holiday that the new employee is entitled to receive
as paid.

Sick Anniversary This field is used to enter the month and day of the employee�s sick day
evaluation start date.

OK TheOK button , or the Save option from the File menu, will save any changesmade in
the dialog box.

Cancel The ESC key, CANCEL button, or the Exit option from the File menu, will exit the
dialog box without saving any changes.
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This Miscellaneous Tab of the Notebook appears as follows:

The following table provides a description of the data fields within this screen:

Field Description

Dates This heading indicates three date fields that can be used to
enter additional date information, such as group insurance
issuance date, initial pension contribution date, etc.

Numbers This heading indicates three numeric fields that can be used to
enter additional numeric information, such as additional units
purchased through group insurance.

Text Field This heading indicates eight additional 10 character
alpha-numeric fields that can be used to input additional
information, such as pension plan number, group insurance
plan number and I.D., union code numbers, etc.

F In the event that you are familiar with or are recently converted from our
GrandMaster II payroll product, these fields will have data that was resident in the
�Additional Miscellaneous Fields� records of each Employee�s �Personal� data.
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Earnings by Employee

Once the new Employee�s Payroll Specific Data Information has been completed and
the user saves the entire notebook, as part of the add an employee function still, the
system will automatically go to the Earnings by Employee screen.

If a model has been assigned to the new employee a list of earnings will be present that
had been previously selected for that model.

If a model was not assigned to the new employee the list of earnings will be blank and
each earning type that is appropriate to this employee must be inserted.
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When the user selects the UPDATE button from the Earnings for Employee screen,
the Employee Earning Update screen will be shown. The first page, the Desc

(Description) tab, appears as follows:

The following table gives a description of the data fields:

Field Description

Earning This field displays the code number of the earning previously
assigned at payroll level.

Description This field displays the description of the earning previously
described at the payroll level.

From This field is used to set the starting date of the effective date
range for the earning.

Until This field is used to set the ending date of the effective date range
for the earning.

Position This field is used to establish the position for the earning as it
applies to the employee. If the employee holds two positions that
have two different pay rates, the position 1 can be inserted. An
�Additional� earning of the same code for �Position 2� can be
added for this employee.

Earning Usage

Control

This allows you to turn on or turn off the earning for an
employee.

F If No effective dates are inserted the earning as established here is in effect. If an
additional earning of the same type is added with a new effective date the original
earning record will have an ending date of one day prior to the new effective start date
inserted by the system and will be turned off on that end date. A history of the
employee�s pay rates can be maintained in this way and can be displayed on the
earning list for the employee if the �Show Dates� option is selected under the File
menu.
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F If no position is inserted it is assumed only 1 pay rate is in effect for this employee.

When the user selects the Rate tab, the following screen will appear:

The settings for the deduction of the evaluation method and frequency have been
completed at hte payroll level. Please refer to Earnings - Overall or By Position at the
payroll level in this manual for a detailed description of these default settings.

The Rate tab of the earning notebook at the employee level is normally used to enter
the specific rate for this employee.

Example:An example of an hourly rate would be to insert the hourly rate value in
the rate box with no units being assigned. The preset definition would be
�Use Set Rate� by �Hour�

Example:An example of biweekly salary rate would be toinsert the biweekly gross
pay rate value in the rate box with 75 or 80 base hours being inserted in
the units box. The preset definitions would be �Use Set Rate� by �Pay
Period�.

Example:An example of annual salary rate would be to insert the annual gross
salary pay rate value in the rate boxwith (75 base hours x 26 pay periods)
1950 base hours being inserted in the units box. The preset definitions
would be �Use Set Rate� by �Annual�.

Example:An example of pay rate being selected from a rate table would be to insert
the rate table name that applies to this employee in the rate table
parameters field with the specific row and column being inserted or an
accumulator code being insertedwhich establishes the limit factor for the
pay rate table. The preset definition would be �Use Rate Table� by
�Hour�.
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When adding an new employee, if the model definition was used, the earnings list that
appears would have at least the one earnig type which is the base earning for hte
emplyee. By highlighting the base earnings and selecting update the new employee�s
rate of pay can be inserted. In completing the rate and unit boxes for the employee
approximately for the base earning, all other earnings on the list should be resolved
automatically based on their definitions and dependency on the �Base� Earning
Values.

Ifmodelws not used to set up a new employee the usermust �Insert� each earning type
allowed for htis employee filling inthe rate on the �Base� earning type.

Deductions by Employee

Upon completion of the earnings list for add a new employee the user, by selectingOK
or Cancel, signifies an end to earnings assignments and the ystem will present the
deduction list be employee automatically for completion.

If a model has been assigned to the new employee a list of deductions will be present
that had been previoulsy selected for that model. The user will �Update� the
deductions to input the applicable specific rate and amounts. If a model was not
assigned to the new employee the list of deductions will be blank and each deduction
type that is appropriate to this employee must be inserted.
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Deductions (Employee)

When the user selectsDeductions from the EmployeeDataMenu the following screen
will appear:

Insert The INSERT button allows the user to insert a new deduction, for the employee.

Additional TheADDITIONALbutton allows the user to add an additional effective date range for
an existing deduction, for the employee.

Update The UPDATE button allows the user to update a deduction, for the employee..

Delete The DELETE button allows the user to delete a deduction, for the employee.
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When the user selects the UPDATE button from theDeduction for Employee screen
the following screen will appear as follows:

TheGeneral page contains fields for describing the deduction and setting the effective
date range of the deduction type.

The following table gives a description of the data fields:

Field Description

Deduction This field contains the code number and description of the
deduction.

From This field is used to set the starting date of the effective date
range for the deduction.

Until This field is used to set the end date of the effective date range
for the deduction.

Deduction Usage

Control

This field contains two buttons that are used to enable or
disable the uses of the deduction type. When the deduction
type is disabled, the deduction will not be used for pay
processing.

F The Deduction type has been defined at the payroll level. The evaluation period,
whether the deduction uses fixed value or is a result of a calculation, whether the
benefit is taxable, has all been determined at the payroll level. For a detailed
description of deduction types and their uses, please refer to Deductions at the Payroll
Level in thismanual. Normally, at the Employee Level the effective dates, fixed value
amounts or calculation code parameters are all that is required.
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The Fixed page contains fields that are used to input fixed amounts for the deduction
processing. When you select the Fixed tab on the Deduction Update the following
screen will appear:

The following table gives a description of the data fields:

Field Description

Fixed Deduction

Amount This field is used to input the fixed value amount to be
deducted from the employee according to evaluation
parameters defined at the payroll level.

Unit This field is used to input a units value if appropriate.

Fixed Benefits

Amount This field is used to input the fixed value amount to be paid by
the employer on behalf of the employee according to
evaluation parameters defined at the payroll level.

Units This field is used to input a units value if appropriate.

Use Fixed

Amounts

This field is used to indicate that fixed values are to be used
and can override any results of a calculation code processing.
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The Calculate page is used to set the values for the calculation that will be used to
determine the amounts to be used for the deduction. When you select the Calculate tab
on the Deduction update the following screen will appear:

The following table gives a description of the data fields:

Field Description

Calculation Code This field displays the number of the calculation code that will be
used to calculate the value of the deduction.

Parameter Table This field displays the name of a parameter table.

Parameter Group This field is used to enter the default group (row) for the deduction
type.

Custom Parameters This field is used to replace a parameter table if a unique value is to
be the calculation factor.

Table Parameters This field is used to call up a screen in order to enter the custom
table parameters.

Selection This field is used to call up a screen that can be used to select the
earning, deductions, or accumulators that will be summarized for
this calculation code if different than those predefined.
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Once the Deductions for an employee have been completed, the user, by selecting OK
or Cancel at the deduction list screen, signifies an end to deduction assignments. The
system will present the accumulator list by employee automatically for completion.

If amodel has been assigned to the new employee a list of accumulatorswill be present
that has been previously selected for that model. The user will �Update� the
accumulators to input the specific rates applicable.

If a model was not assigned to the new employee the list of accumulators will be blank
and each accumulator type that is appropriate to this employee must be �Inserted�.

Accumulators (Employee)

When the user selects Accumulators from the Employee Data menu the following
screen will appear:

Insert The INSERT button allows the user to insert a new accumulator.

Additional TheADDITIONALbutton allows the user to add an additional effective date range for
an existing accumulator.

Update The UPDATE button allows the user to update an accumulator.

Delete The DELETE button allows the user to delete an accumulator.
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When the user selects the UPDATE button from the Accumulators for Employee

screen the following screen will appear:

The General page contains fields for describing the accumulator and setting the
effective date range of the accumulator type.

The following table gives a description of the data fields:

Field Description

Accumulator This field contains the code number and description of the
accumulator, defined at the payroll level.

From This field is used to set the starting date of the effective date range for
the accumulator.

Until This field is used to set the end date of the effective date range for the
accumulator.

Accumulator Usage

Control

This field contains two buttons that are used to enable or disable the
use of the accumulator type. When the accumulator type is disabled
the accumulator will not be used for pay processing.
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The Fixed tab of the notebook contains fields that are used to input fixed amounts for
the accumulator processing. When fixed amounts are used the amounts given will be
processed for each pay period. When you select the Fixed tab on the Accumulator
Update the following screen will appear:

The following table gives a description of the data fields:

Field Description

Fixed Values

Amount This field contains the amounts that should be accumulated for an
employee for each period.

Unit This field contains the value, in units, that should be accumulated
for an employee for each period

Use Fixed

Amounts

When this field is checked the fixed value amounts will calculate
during each pay period.

Payout

Accumulator

When this field is checked the accumulator will pay out after each
calculation during each pay period.

Maximums

Amount This field restricts the amounts accumulated to the maximum net
value in the field. If the field contains zero (blank) the
accumulator is not restricted to a maximum value.

Unit This field restricts the units accumulated to the maximum net
balance value in the field. If the field contains zero (blank) the
accumulator is not restricted to a maximum value.

YTDMaximums

Amount This field is used to input an annual maximum dollar value that is
allowed to accumulate. The value input in the YTD amount
restricts the amount added to the accumulator for the year, and
disregards any deductions form the accumulator during the year.
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Unit This field is used to input an annual maximum unit/hour value that
is allowed to accumulate. The value input in the ytd unit restricts
the unit/hours added to the accumulator for the year and
disregards any deductions from the accumulator during the year.

The Calculate page is used to set the values for the calculation that will be used to
determine the amounts to be added to the accumulator. When you select theCalculate
tab on the Accumulator Update the following screen will appear:

The following table gives a description of the data fields:

Field Description

Calculation Code This field displays the number of the calculation code and the
description that will be used to calculate the value to add to the
accumulator.

Parameter Table This field displays the name of a parameter table, if one is
assigned.

Parameter Group This field is used to enter the default group (row) for the
calculation type.

Custom Parameters This field is used to determine if a Named table or a Custom
Parameter table will be used in the calculation for the
accumulator type.

Parameters This field is used to call up a screen that is used to enter the
custom parameters. �Custom Parameters� must be checked to use
this feature.

Selected List This field is used to call up a screen that can be used to select the
earnings, deductions or accumulators that will be summarized for
this calculation code, if different than those set at the payroll
level.
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Add a New Employee - End Cycle

Upon completion of the accumulator assignment the user may select OK or Cancel
from the accumulator list screen and will be returned to the main payroll level menu
screen. The add a new employee cycle has been completed upon exiting the
accumulator list.

The add a new employee cycle has incorporated several steps into a single process. In
adding a new employee the user has:

n Identified the Employee - Employee Update Menu

n Placed the Employee in a payroll - Payroll Specific Information Menu

n Assigned Earnings and Pay Rates - Earnings Menu

n Assigned Deductions and Specific Rates - Deductions Menu

n Assigned Accumulators and Specific Rates - Accumulators Menu
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Hours Entry

TheEmployeeHoursEntry screen from themain Payroll LevelMenu is used to enter
in the employees� hours worked. This function from the main payroll level menu
would normally be used in the case where there is more than one employee to enter
hours for.

The following screen will appear:

ToSelect anEmployee to enter hours for the usermay type in the surname or employee
number depending on the default search technique set or by pressing �Next
Employee� or �Previous Employee�. When the correct employee appears in the
screen, press the Enter Time button.

The following screen will appear:

The Earning Time Entry screen is used to enter hours for the employee.
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The following table gives a description of the data fields:

Field Description

Employee This field contains the name of the employee.

From This field contains the starting date of the pay period.

To This field contains the ending date of the pay period.

Earning Entries This list box displays a line for each line of the hours
entered for the date range above.

Date This field is used to enter the day date in YYYYMMDD
format.

Earning This field is used to enter the earning code.

Hours This field is used to enter the hours the employee
worked.

Position This field contains the employee�s position, if assigned.

Rate This field contains the employee�s rate of pay and can be
overtyped.

Distribution This field is used to record specific distribution codes for
hours entered if they are different than the employee�s
default distribution.

F8(List) Selecting the F8 key when your cursor is in the earning field will bring up a list of
earnings. The list will appear similar to the following:
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When the user selects the Options drop down menu on the Earning Time Entry

screen, the following choices become available:

TheFields toUse option allows you to turn on and off certain entry fields such as area,
sub area, activity and sub activity. If the date is turned off as an entry field the system
will auto fill with the period end date.
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Employee Menu...

TheEmployeeMenu... option under the Employeemenu allows the user to update an
individual employee's payroll-related information.

F A payroll must be selected to have access to the Employee Menu... option. If one is
not, the system will prompt the user to select a payroll.

When the Employee Menu... option is selected the following screen with a different
menu bar will appear:

Once an employee has been selected his/her name will appear in the title bar of the
screen. If no employee has been selected themessage �NoEmployee Selected�will be
displayed in place of the name.

F The employee that appears at the top of the screen is said to be the current employee.
All modificationsmade in any dialog box under the EmployeeMenu bar apply only to
the current employee.

An employee must be selected in order to enter information into any options from the
Employee Menu screen.
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File

The File menu of the Employee Menu screen appears as follows:

The options in the File menu allow the user to:

n select the next employee in the list

n select the previous employee in the list

n to select an employee

n to deselect a previously selected employee

n to call up a list of employees who are in the currently selected payroll

n add an employee

n select a payroll

n set search technique

n exit back to the Payroll main menu
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Select an Employee

When the user selects Select Employee from the File menu, the Name in Payroll

screen appears as follows:

Next The NEXT button, orNext Employee option from the File menu, will select the next
employee listed in the payroll according to the search technique set.

Previous ThePREVIOUSbutton, orPreviousEmployee option from the Filemenu, will select
the previous employee listed in the payroll according to the search technique set.

Deselect The Deselect option from the File menu exits from the previously selected employee
and returns the user to the Employee level menu will �No Employee� Selected.

OK When you press the OK button whatever is listed in the name field will be selected. If
you have entered only a partial name, number or badge (depending on the search
setting), the system will select the employee which most closely matches or will
display a list of employees to choose from.

Exit The EXIT button, or the Exit option in the File menu, will exit the screen without
selecting any employee.
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Employee List

When the user selects the Employee List option from the File menu, a list of current
employees in the payrollwill appear. TheName inPayroll screen appears as follows:

In order to select an employee, youmust highlight the employee youwant to select and
then press the OK button.
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Add an Employee

The system allows for the insertion of a new employee from the File Menu of the
Employee Menu as well as from add employee option on the main payroll menu.

For a complete description of the add and Employee cycle please refer to add an
employee option frommain payroll level menu at the beginning of this chapter in this
manual.

Select a Payroll

The system allows for the selection of a payroll from two locations; under FileMenu at
the main Payroll Level or under File menu at thte Employee Level menu.

Please refer toChapter Two - Filemenuof thismanual for amore detailed description

Set Search Technique

The System allows for the selection of a default search technique from two locations;
under File Menu at the main payroll level menu or under file menu at the Employee
Level menu.

Please refer toChapter Two - Filemenuof thismanual for amore detailed description

Exit Employee

By selecting the exit employee option under File Menu at the employee level, the
system will return the user to the main payroll level menu.

F It should be noted that �Exiting Employee� is not the same action as �deselecting an
employee� and the results are different �Deselection� ensures that no employee is in
place at the Employee Level Menu. �Exiting� takes you from the Employee Level
Menu to theMain Payroll Level but the last selected employee remains in residence at
the Employee Level until replaced by another employee selection or deselected.
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Profile Query

The Payroll Profile serves as a query function that will display all known Payroll Data
concerning a specific employee in one notebook. The advantage to this format is that
you may view the information in one location rather than having to access several
different menu options for the same information.

Once you have selected an Employee�s Payroll Profile you have the option of
changing date ranges to show other than the immediate current data, selecting a
specific pay run�s Payroll Data, printing a profile report,updating some data fields for
this employee or you may select a different Employee�s Profile.

The first page of the Profile Notebook will display Employee basic information. It
combines several pages of the �Employee Update� data into one single screen with
one sub menu display.

The following screen will appear:
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The following table gives a description of the data fields:

Field Description

From This field will display the current starting date that the data represents.

To This field will display a 30 day end date for the data represented. Note:
Under the File Menu option a show dates selection can be made which
can be used to change the date ranges.

Name This field displays the full name of the selected employee.

Address This field displays the full address of the selected employee including
the postal code.

Phone This field contains the phone number of the employee.

Alternate

Phone

Number

This field contains an alternate phone number for the employee.

Badge This field displays the selected employee�s current assigned badge
number. Note: The badge number may be different than the employee�s
payroll number.

Birth Date This field contains the birth date of the employee.

Band/Treaty If the employee has either a band number or treaty number or both they
will be displayed here appropriately.

S.I.N. This field contains the social insurance number of the employee.

Sex This field contains the sex of the employee.

Update The Employee Payroll Profile Notebook allows for changes to bemade to the selected
Employee�s data by using the �Update� function button found at the top right hand
corner. By pressing the update button the appropriate screens will be called up for
changes to be entered. By selecting OK to Save those changes on the appropriate
screens, you will be returned to your starting point on the selected Employee�s Profile
page with the changes reflected immediately on the profile.
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When the Notes Sub-Menu tab is chosen the following screen will appear:

This screen will list any �Notes� (codes and descriptions) that have been assigned to
the selected employee.

Update The UPDATE button will take you to theEmployee Update screen, and upon exiting
the update you will be returned to the Employee Profile.

The Second tab of the Profile notebook will display the selected employee�s Payroll
information, incorporating several pages of the �Payroll Specific Information� data
into one single screen with sub menu displays.

When the Emp (Employee) tab is chosen from the Profile notebook, the following
screen will appear:
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The following table gives a description of the data fields:

Field Description

Employee Number This field displays the selected Employee�s assigned Employee number.

Payroll Status This field displays the selected Employee�s current status.

Rev. Canada Account This field displays the employment insurance rate category that the
selected employee has been assigned

Full Time Equivalency This field will display the assignment of the equivalent to full time
position rating. Note: This system will default during processing to 1
full time equivalency rating if this field has not been previously
assigned.

First Day This field will display the selected Employee�s original start date.

Last Day This field will display the selected Employee�s termination date if
applicable.

Employee Message This field will display the last current employee�s message which will
appear on the current pay statement.

Base The following fields will provide the basic assignment for the selected
employee for the base default payroll settings.

Earning This field displays the base earning code type that has been assigned to
the selected employee.

Model This field displays the model code type that may have been assigned to
the selected employee.

Position This field displays the base position type that has been assigned to the
selected employee.

Distribution This field displays the base default distribution table that has been
assigned to the selected employee.

Bank Format This field displays the company�s bank defined format when the EFT
module is in use.

Direct Deposit This field displays whether the selected employee has been set up for
direct deposits.

Update TheUPDATEbuttonwill take you to the Payroll Specific Information screen and upon
exiting the update you will be returned to the Employee Profile.
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When the Stat�s Sub-Menu tab is selected a screen will appear showing the selected
Employee�s Statutory Deductions Parameters.

The following table gives a description of the data fields:

Field Description

Tax Province This field will display the tax Province that has been assigned to the selected
employee. When an employee is first entered into the system the tax
province defaults from the employee�s home address. The tax province can
be changed to reflect the province where the employee works if it is different
from the employee�s home province.

Type of

Calculation

This field will reflect the type of statutory tax deduction chosen for the
selected employee:

A) Normal Tax Calculation is defined as the most common tax calculation
method where the TD1 amount is figured into the formula. The system
defaults to normal tax calculation at the time of setting up a new employee.

B) No Federal Tax is defined as a tax calculation method where the federal
tax is not included in the statutory deduction formula.

C) Fixed Amount of tax is defined as a tax calculation method where the
TD1 amount is not included in the Statutory Deduction formula and the
results of the calculation are overridden by a specified fixed amount.

D) Percent of Taxables is defined as a tax calculation method where the TD1
amount is not included in the Statutory Deduction formula and the results of
the calculation are overridden by a specified percentage of the gross taxable
earnings.

E) Balance Net Pay amount is defined as a Tax calculation method where
the TD1 amount is not included in the Statutory Deduction and where the
CPP & EI are calculated in the normal manner on the gross earnings but
where a specified net pay is set to pay out with the difference between gross
pay and net pay distributed to other deductions such as group insurance and
the remaining amount set to Federal Tax.
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Field Description

Override This field will reflect any amount or percentage that has been referenced by
the type of calculation chosen. In the case of a �Fixed Amount of Tax�
calculation type this field will display the specified dollar amount of tax to
be taken on each pay calculation for the selected employee. Eg) 430.00
dollars. If the calculation tax type chosen is �Percent of Taxables� this field
will display a specified percentage for the selected employee. Eg) 43.00% If
the tax calculation type is �Balance Net Pay Amount� the override field will
display the specified net pay in dollars for the selected employee Eg)
$430.00.

Net Claim This field will display the net TD1 Claim that has been specified for the
selected employee. The system will default to the base exemption amount
allowed by Revenue Canada for the current tax year for the selected
employee ie: 1998 TD1 amount is $6456.00.

Additional Tax This field displays any tax to be deducted from the selected employee�s gross
taxable earnings in addition to the statutory tax deduction calculation as
requested by the employee.

Remote This field displays any remote allowance which may apply for the selected
employee�s tax calculation.

Other This field displays any other tax credit which may apply for the selected
employee�s tax calculation.

LCP This field displays any labour credit which may apply for the selected
employee�s tax calculation.

Other Federal

Amount

This field displays any additional federal tax credits which may apply for the
selected employee�s tax calculation.

EI Parameter This field will display the selected employee�s EI status ie: will show if
employee is exempt from employment insurance premiums.

CPP Parameter

and Over

Amount

This field will display the selected employee�s Canada Pension Plan Status.
If the selected employee is below the age of 18 years or over the age of 70
years, no CPP Premiums will be deducted and the field will display the
message Age Exempt. If the employee is marked as exempt on set up, this
field will display the message CPP exempt. There also exists the option to
override the normal CPP premium calculation with a specified amount.
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When the Prov (Province) Sub-Menu tab is selected a screen will appear showing the
selected employees additional parameters concerning provincial regulations which
may apply.

The following table gives a description of the screen:

Field Description

Type of Calculation This field will reflect the type of Quebec Statutory Tax Deduction method
chosen for the selected employee.

A) Normal Tax Calculation is defined as the most common tax calculation
method where the QD1 amount is figured into the formula. The system
defaults to a normal tax calculation at the time of setting up a new employee.
The method of calculating Quebec tax only becomes effective if the
employee�s tax province has been designated as Quebec.

B) No Quebec Tax is defined as a tax calculation method where the Quebec
tax is not included in the statutory deduction formula.

C) Fixed Amount of Tax is defined as a tax calculation method where the
QD1 amount is not included in the statutory deduction formula and the
results of the calculation are overridden by a specified fixed amount.

D) Percent of Taxables is defined as a tax calculation method where the
QD1 amount is not included in the statutory deduction formula and the
results of the calculation are overridden by a specified percentage of the
gross taxable earnings.

E) Balance of net pay amount is defined as a tax calculation method where
the QD1 amount is not included in the statutory deduction and where the
QPP and EI are calculated in the normal manner on the gross earnings but
where a specified net pay is to pay out, with the difference between gross
pay and net pay distributed to other deductions such as group insurance and
the remaining amount set to Quebec tax.

Override This field will reflect any amount or percentage that has been referenced by
the type of calculation chosen for the selected employee. This field will
display as a fixed dollar amount or percentage.
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Field Description

Net Claim This field will display the selected employees net QD1 claim The system
will default to the base exemption amount allowed by Revenue Canada for
the current tax year for the selected employee, ie; 1998 QD1 amount is
$8250.00.

Additional Tax This field displays any Quebec Tax to be deducted from the selected
employee�s gross taxable earnings in addition to the Quebec Statutory tax
deduction calculation as requested by the employee.

Other This field displays any other tax credits which may be allowed for the
Quebec Tax Calculation.

Province This field displays the Province in which the selected employee�s earnings
are to be reported for Workers� Compensation.

Rate This field displays the rate according to Workers� Compensation assignment
for the selected employee.

Province This field will display the province that has been assigned for the selected
employee where the payroll tax is in effect.

Type This field will display the type of calculation method which can be used to
calculate the payroll tax for the specified employee.

Code This field will display the rate code position on the rate table set up for the
indicated province for the specified employee.

Rate This field will display the assigned rate for the appropriate provincial payroll
tax for the specified employee.

Update The UPDATE button will take you to the Payroll Specific Information screen, and
upon exiting the specific information you will be returned to the Employee Profile.
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When theMiscellaneous Sub-Menu tab is selected, a screen will appear showing the
selected employee�s assigned standard work week, number and type of dependents
and assigned Statistics Canada settings as well as pertinent dates.

The following table gives a description of the screen:

Field Description

Days of the week This field may display the days of the week that the selected
employee has been assigned to work, with 1 representing
Sunday. If the assignment has been left blank the system
assumes Monday up to and including Friday as a normal work
week for this employee.

Hours in a Week This field displays the total number of hours that have been
assigned as a normal standard work week for the selected
employee or it may display the number of EI insurable hours
by week that have been assigned to the selected employee, if
however, the EI insurable hours and the standard work week
have been left blank for the selected employee the system will
assume a standard 40 hours per week

Hours by Day This display indicates the hours in each day that have been
assigned to the selected employee for the standard work week.
If this has been left blank the system will assume 8 hours a
day.

Employee Anniversary

Dates

This display indicates the various anniversary dates that can be
assigned for the selected employee.

Anniversary Date This field displays the month and day of the selected
employee�s annual anniversary date. This field would in
normal circumstances, be the same month and day as the initial
hire date and could be used for annual employee performance
reviews.
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Field Description

Vacation Anniversary This field displays the month and day of the selected
employee�s annual vacation evaluation start date.

Holiday Anniversary This field displays the month and day of the selected
employee�s annual holiday evaluation start date.

Sick Anniversary This field displays the month and day of the selected
employee�s sick day evaluation start date.

Dependents This display indicates whether the selected employee has
made an additional claim for dependents and the type of
dependent.

Total This field displays the total number of dependents that the
selected employee may have made an additional claim for.
This field, if filled in, will be used in the selected employees
statutory tax calculation providing an additional credit in
addition to the TD1 claim amount.

Under 18 This field displays the selected employee�s number of total
dependents that are under the age of 18 years old.

Disabled This field displays the selected employee�s number of total
dependents that are disabled.

Other This field displays the selected employee�s number of total
dependents that do not fall in to the previous two categories
but who can be legitimately claimed as dependents.

Statistics Canada This display indicates the Statistics Canada category and zone
that the selected employee may be assigned to.

Code This field displays the category of either hourly or salary type
that has been assigned for the selected employee.

Zone This numeric field displays the zone that the selected employee
has been assigned to for Statistics Canada reporting purposes.
The zone may be defined by the user to be the various
reporting breakdowns other than the category type that may be
required by Statistics Canada.

Update The UPDATE button will take you to the Payroll Specific Information screen, and
upon exiting the specific information you will be returned to the Employee Profile.
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When the Category Sub-Menu tab is selected a screen will appear showing the
selected employees assigned payroll specific categories. The category code and
descriptions will appear on the screen.

Update The UPDATE button will take you to the Payroll Specific Information screen and,
upon exiting the specific information you will be returned to the Employee Profile.
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When theBank Sub-Menu tabs are selected a screen will appear showing the selected
employee�s direct deposit bank information if it is being used for each completed bank
detail screen. Each employee can have a maximum of 3 bank accounts where each
payroll deposit can be disbursed to.

When any one of the Bank 1, Bank 2, or Bank 3 Sub-Menu tabs is chosen a screen
similar to the following will appear:

The following table gives a description of the screen:

Field Description

Account This field displays the selected employee�s bank account number in the
accepted format of 5 digit transit number, 3 digit bank I.D. number followed by
the Bank Account number.

Name This field displays the selected employee�s bank�s name.

Address This field displays the selected employee�s bank�s street address.

City This field displays the selected employee�s bank�s city location.

Province This field displays the selected employee�s bank�s province location.

Postal Code This field displays the selected employee�s bank�s postal code.

Maximum This field displays the selected employee�s specified amount to be transferred
to each bank if the multiple bank option has been chosen. If the multiple bank
option has been implemented a maximum amount from the calculated net pay
can be directed to be deposited to the first bank, with a second maximum set
for the second bank and the maximum would remain blank for the third bank
for the net pay remaining.

Update The UPDATE button will take you to the Payroll Specific Information screen and,
upon exiting the specific information you will be returned to the Employee Profile.
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The third tab of the Profile Notebook will display the selected employee�s payroll
history.

When the Payroll tab is chosen from the Profile notebook, the following screen will
appear:

The following table gives a description of the screen:

Field Description

Payroll This field displays the payroll name and description that the payroll
information for the selected employee is extracted from

Payroll Date,

Year, Period

and Type

This field displays the most recent payroll identification available for the
selected employee indicating the payroll date, taxation year, run number, type
of run and sequence number that the pay summary data was extracted from.

Pay Summary: This screen will present a summary of the most recent pay available for

the selected employee according to the payroll date, year, period and type of pay

calculation as indicated.

Gross Pay This field displays a summary line of all earnings for the selected employee in
current and year to date amounts.

Net Pay This field displays a summary line of the net earnings for the selected
employee in current and year to date amounts.

Deductions This field displays a summary line of all deductions - statutory and company
for the selected employee in current and year to date amounts.

Benefits This field displays a summary line of all benefits associated with the selected
employee�s pay in current and year to date amounts.

Arrears This field displays the outstanding arrears for the selected employee. The
current field will display any arrears amounts generated within the viewed pay
run. The YTD field will display the net outstanding arrears balance. The
arrears, if allowed (see Payroll Information at Payroll Level) are system
generated transactions not input transactions, therefore, the Profile Payroll
Query will indicate only current changes, either debit or credit and the net
affect on the balance.

WCB This field will display the system calculated Worker�s Compensation amount
for the selected employee in current and year to date fields.
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Health This field will display the system calculated health and education/ payroll tax
amount for the selected employee in current and year to date fields.

When the Details Sub-Menu tab is chosen, the following screen will appear:

The Details sub menu page provides the details of all Earnings, Company Deductions
and Accumulators transactions that have been reported in the summary lines on the
payroll main tab.

When the Fed(Federal) Sub-Menu tab is chosen the following screen will appear:

The Federal sub-menu page provides the detail of the statutory deductions made for
the selected pay run indicating as well those benefits and deduction classes present in
this pay run which affected the tax calculation.
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When the Que(Quebec) sub menu tab is chosen the following screen will appear:

TheQuebec sub-menu pagewill indicate the separate Quebec tax andQPPwhichmay
apply.
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The fourth tab of the Profile Notebook will display the selected employee�s earnings
types and definitions.

When the Earn (Earning) tab is chosen the following screen will appear:

Update The UPDATE button will take you to a list of Earnings applicable to the employee.
The Earnings for screen appears as follows.
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The fifth tab of the Profile Notebook will display the selected employee�s deduction
types and definitions.

When the Ded (Deductions) tab is chosen the following screen will appear:

Update The UPDATE button will take you to a list of deductions and, upon exiting the
deductions you will be returned to the Employee Profile.
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The sixth tab of the Profile Notebook will display the selected employee�s
accumulator types and definitions.

When the Accum (Accumulators) tab is chosen the following screen will appear:

Update The UPDATE button will take you to a list of accumulators and, upon exiting the
accumulators you will be returned to the Employee Profile. The screen appears as
follows:

330 Can-Pay Computer Software

8 - EMPLOYEE INFORMATION



The seventh tab of the Profile Notebook will display the selected employee�s current
year�s E.I. Details and the previous years hours and dollars as a summary line.

When the E.I. tab is chosen the following screen will appear:
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Data

The Data menu from the Employee Menu screen appears as follows:

The options available to the user through the data menu are:

n updating employee information

n entering payroll specific information

n defining earnings, deductions, and accumulators at the employee level

n entering hours worked by employees

n reviewing transactions entered for an employee

n setting up pay advances

n setting up pay period overrides

n making adjustments

n setting the payout accumulator

n entering YTD adjustments and overrides

n entering EI adjustments and overrides
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Employee Update

Select the Employee Update option to insert new data or change existing data for an
employee already in payroll. A notebook will be presented with pages containing,
Name & Address. I.D. such as Social Insurance Number, Medical Number, Personal
Data, such as Birth Date or Notes.

For a more detailed description of this notebook please refer to add an employee at the
beginning of this chapter in this manual.

Save The OK button, or the save option from the File Menu , will save any changes made
within the Employee Update screen.

Cancel The Cancel button or the Exit option from the file menu will exit from the Employee
Update screen without saving any changes.

Payroll Specific Information

Select the Payroll Specific Information option to insert new data or change existing
data for an employee already in payroll. A notebook will be presented with pages
containingEmployee�s payroll status and tax province, base earning type, distribution,
position of the employee, TD1 claim amount and any additional tax to be taken, CPP
and EI Statutory parameters, Workers� Compensation and Payroll Tax Rates,
Employee Bank Information for direct deposits, Employee�s Category Assignments,
StandardWorkWeek Data, important employee dates and miscellaneous information
for that employee.

For a more detailed description of this notebook please refer to add an employee at the
beginning of this chapter in this manual.

Save The OK button or the Save option from the File menu will save any changes made
within the Payroll Specific Information screen.

Cancel The Cancel button or the exit option from the File menu will exit from the Payroll
Specific Information screen without saving any changes
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Earnings

The Earnings sub menu of the Data menu appears as follows:

The functions available to the user are to define earnings by either of:

n Employee

n Employee Position
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Earnings (Employee) - Employee

Select Earnings by Employee or Employee Position to add a new earning, change
existing earning type or delete/disable a previously assigned earning for an existing
employee in payroll.

For a more detailed description of Earnings by Employee, please refer to �Add an
Employee� at the beginning of this chapter in this manual.

The following is a brief overview of earnings.

When the user selectsByEmployee from the Earning submenu of the EmployeeData
Menu, the following screen will appear:

Insert The INSERT button allows the user to insert a new earning for the employee.

Additional TheADDITIONALbutton allows the user to add an additional effective date range for
an existing earning for the employee.

Update The UPDATE button allows the user to update an earning for the employee.

Delete The DELETE button allows the user to delete an earning for the employee.
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Earnings (Employee) - Employee Position

Selecting the Employee Position option brings up the Position Master Update
Selection screen. This screen appears as follows:

The position namemust be entered into this dialog box. This can be done by typing the
position name in or selecting it from a list of position names.

F8 (list) Selecting the F8 key, or theList option from the Filemenu,will bring up a list of all the
defined position names. The list will appear similar to the following:

If no position codes have been previously defined the list will be empty.

The screen will list the position codes with their description to the right.

From this screen the user can insert new position codes (using the INSERT button),
update defined position codes (using the UPDATE button), or delete defined position
codes (using the DELETE button).
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Update The UPDATE button is used to make changes in previously defined position codes.
The position codemust first be entered into the position code field. The dialog boxwill
appear as follows:

The following data fields require input:

Field Description

Code This field contains the code name of the position

Description This field contains the description of the position.

Class This field contains the class code of the position.

Pay Table This field contains the pay table used for the position.

Start Date This field contains the starting date used for the position.

End Date This field contains the ending date used for the position.

Distribution This field contains the G/L distribution of the position.

Esc (exit) TheESCkey,CANCELbutton, or theExit option from theFilemenu,will exit the dialog
box.
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Deleting an Existing Position Code

To delete a previously defined position code follow these steps:

1. Select the Position Update option in the Position Menu.

2. When the Position Master Update Selection dialog box appears select the F8
key,or the List option in the File menu to obtain a list of all defined position
codes.

3. Move the selection bar to the position code to delete.

4. Select the Delete button at the bottom of the Position List Screen.

5. A message will appear asking you to confirm the deletion. Select the YES
button to delete, or the NO button to cancel the deletion process.
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Deductions (Employee)

Select Deductions by Employee to add a new deduction, change existing deduction
data, create an additional deduction or delete/disable a previously assigned deduction
of an existing employee in payroll.

For a more detailed description of Deductions by Employee, please refer to �Add an
Employee� at the beginning of this chapter in this manual.

The following is a brief overview of deductions.

When the user selectsDeductions from the EmployeeDataMenu the following screen
will appear:

Insert The INSERT button allows the user to insert a new deduction, for the employee.

Additional TheADDITIONALbutton allows the user to add an additional effective date range for
an existing deduction, for the employee.

Update The UPDATE button allows the user to update a deduction, for the employee..

Delete The DELETE button allows the user to delete a deduction, for the employee.
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Accumulators (Employee)

Select Accumulators by Employee to add a new accumulator, change existing
accumulator data, create an additional accumulator or deleted/disable a previously
assigned accumulator for an existing employee in payroll.

Please refer to �Add an Employee� at the beginning of this chapter in this manual for a
more detailed description of accumulators.

A brief overview of accumulators follows:

When the user selects Accumulators from the Employee Data menu the following
screen will appear:

Insert The INSERT button allows the user to insert a new accumulator.

Additional TheADDITIONALbutton allows the user to add an additional effective date range for
an existing accumulator.

Update The UPDATE button allows the user to update an accumulator.

Delete The DELETE button allows the user to delete an accumulator.
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Enter Hours

The system allows for the data entry of hoursworked by employee from two locations,
under employee at main payroll level or under data at the employee level menu.

For additional information about hours entry see the beginning of this chapter in this
manual.

The following screen will appear:

The Earning Time Entry screen is used to enter hours for the employee.

The following table gives a description of the data fields:

Field Description

Employee This field contains the name of the employee.

From This field contains the starting date of the pay period.

To This field contains the ending date of the pay period.

Earning Entries This list box displays a line for each line of the hours
entered for the date range above.

Date This field is used to enter the worked day date in
YYYYMMDD format.

Earning This field is used to enter the earning code.

Hours This field is used to enter the hours the employee
worked.

Position This field contains the employee�s position, if assigned.

Rate This field contains the employee�s rate of pay and can be
overtyped.
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Distribution This field is used to record specific distribution codes for
hours entered if they are different than the employee�s
default distribution.

F8(List) Selecting the F8 key when your cursor is in the earning field will bring up a list of
earnings. The list will appear similar to the following:

When the user selects the Options drop down menu on the Earning Time Entry

screen, the following choices become available:

TheFields toUse option allows you to turn on and off certain entry fields such as area,
sub area, activity and sub activity. If the date is turned off as an entry field the system
will auto fill with the period end date.
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Transactions Entered

Transactions entered is a query function that allows for the review of transactions
entered for a specific employee and their disposition, such as processed or by-passed.
If a transaction has been by passed in a calculation it normallymeans that there is a pay
period override transaction with the same earning, deduction or accumulator code.
Processed transaction indicates that a payroll calculation has been performed.

When the user selects the Transactions Entered option from the Employee Data
menu the following screen will appear:

OK, Cancel The OK and Cancel button will exit from the transaction entered screen.

Insert Disabled

Update Disabled

Delete TheDELETE button allows the user to delete a transaction and is recommended in the
case of an input error prior to a pay recalculation and close.
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Pay Advances

When the user selects Pay Advances from the Employee Data menu, the following
screen will appear:

The following options are available to the user:

n Pay Advance

n Advance Deduction

n Formore detailed description of PayAdvances andAdvanceDeductions please
refer to Chapter Three - Earnings Sub-Heading in this manual
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Pay Advances

When the user selects Pay Advances from the Employee Data menu, the following
screen will appear:

F8 (List) When the user presses the F8 key while the cursor is in the Earning field, a list of
earnings will appear as follows:
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Advance Deduction

This function is used to define which deductions will be taken from an employee�s
advance pay. When the user selects Advance Deduction the following screen will
appear:

F8 (List) When the user selects the deduction field and presses the F8 key, a list of deductions
will appear. The screen appears as follows:

You may select only the deduction from this list that is a contra against the advance
earning type bymoving the cursor (highlight) to that line, and pressing theOKbutton.
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Pay Period Overrides

ThePayPeriodOverridesmenu from theEmployeeDatamenu, appears as follows:

The options available to the user through this menu are to override any of:

n Earnings

n Deductions

n Benefits

n Accumulators

n Statutory Deductions

n Statutory Benefits

F It should be noted that selecting a pay period override as a transaction type will
override and replace any Earning, Deduction, Benefit, Accumulator, Statutory
Deduction or Statutory Benefit of the same code in the same pay run.
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Earnings

When the user chooses Earnings from the Pay Period Overrides menu, the following
screen will appear:

The Earning Transaction Entry screen is used to override earnings.

The following table gives a description of the data fields:

Field Description

Employee This field contains the employees name.

Earning This field contains the earning code.

Date This field contains the date of the earning
override.

Units This field contains the number of hours for the
override.

Rate This field contains the rate of pay.

Amount This field contains the extended amount.

Reference This field contains the reference number.

Distribution This field contains the distribution table name.

F8 Selecting the F8 key, when your cursor is in the earning field, will bring up a list of
earnings. The list will appear similar to the following:
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Deductions

When the user choosesDeductions from the Pay PeriodOverridemenu, the following
screen will appear:

The following table gives a description of the data fields:

Field Description

Employee This field contains the name of the employee.

Deduction This field contains the deduction code.

Date This field contains the date of the deduction.

Amount This field contains the extended amount.

Reference This field contains the reference number.

F8(list) Selecting the F8 key, when your cursor in the Deduction field, will bring up a list of
Deductions. The list will appear similar to the following:
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Benefits

When the user chooses Benefits from the Pay Period Override menu, the following
screen will appear:

The following table gives a description of the data fields:

Field Description

Employee This field contains the name of the employee.

Deduction This field contains the deduction code.

Date This field contains the date of the benefit.

Amount This field contains the extended amount.

Reference This field contains the reference number.

F8(list) Selecting the F8 key, when your cursor is in the Deduction field, will bring up a list of
Deductions. The list will appear similar to the following:
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Accumulators

When the user chooses Accumulators from the Pay Period Override menu, the
following screen will appear:

The following table gives a description of the data fields:

Field Description

Employee This field displays the employee�s name.

Accumulator This field contains the accumulator code.

Date This field contains the date of the accumulator
override.

Units This field contains the number of hours for the
override.

Amount This field contains the extended amount.

Reference This field contains the reference number.

F8(list) Selecting the F8 key, when your cursor is in the Accumulator field, will bring up a list
of Accumulators. The list will appear similar to the following:
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Statutory Deduction Override

When the user choosesStatutoryDeductions from thePayPeriodOverridemenu, the
following screen will appear:

The following table gives a description of the screen:

Field Description

Employee This field contains the name of the employee.

Deduction This field contains the statutory deduction code.

Date This field contains the date of the statutory deduction.

Amount This field contains the extended amount.

Reference This field contains the reference number.

F8(list) Selecting the F8 key, when your cursor is in the Statutory Deduction field, will bring
up a list of Statutory Deductions. The list will appear similar to the following:
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Statutory Benefits Override

When the user chooses Statutory Benefits from the Pay Period Override menu, the
following screen will appear:

The following table gives a description of the screen:

Field Description

Employee This field contains the name of the employee.

Deduction This field contains the statutory deduction code.

Date This field contains the date of the statutory benefit.

Amount This field contains the extended amount.

Reference This field contains the reference number.

F8(list) Selecting the F8 key, when your cursor is in the Statutory Deduction field, will bring
up a list of Statutory Deductions. The list will appear similar to the following:
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Adjustments

The Adjustments sub menu, from the Employee Data menu, appears as follows:

The options available to the user through the Adjustments menu are:

n Earnings

n Deductions

n Benefits

n Accumulators

n Statutory Deductions

n Statutory Benefits

F Pay Period Adjustments- This transaction will add the amount entered to the existing
pay period values being processed and does not replace/override them.

F The screens to perform the adjustment transactions are similar to those used to enter
pay period ovverides. Please refer to the preceding section in this chapter.

The adjustments transactions is recommended for processing occasional adjustments
to earnings or fixed dollar amounts for deductions which may vary from pay to pay.
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Payout Accumulator

When the user selects Payout Accumulator from the Employee Data menu, the
following sub menu will appear:

The following options are available to the user:

n Payout All

n Payout Part
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Payout Part

When the user selects Payout Part from the Payout Accumulator menu the following
screen will appear:

F8 When the user selects the F8 key under the accumulators field a list of accumulators
will appear as follows:
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Payout All

When the user selects Payout All from the Payout Accumulator menu, the following
screen will appear:

F8 When the user selects the F8 key under the accumulator field a list of accumulatorswill
appear:
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YTD Adjustments

TheYTDAdjustments submenu, from theEmployeeDatamenu, appears as follows:

The options available to the user through the YTD Adjustments menu are:

n Earnings

n Deductions

n Benefits

n Accumulators

n Statutory Deductions

n Statutory Benefits

F YTDAdjustments- This transaction will add the amount entered to the existing YTD
value.

F For information on how to fill out the YTD Adjustment screens, please refer to Pay
Period Overrides section in this chapter of the manual.

Can-Pay Computer Software 359

EMPLOYEE INFORMATION - 8

E
M
PL

O
Y
E
E

IN
FO

R
M
A
T
IO

N



YTD Overrides

The YTD Overrides sub menu, from the Employee Data menu, appears as follows:

The options available to the user through the YTD Overrides menu are:

n Earnings

n Deductions

n Benefits

n Accumulators

n Statutory Deductions

n Statutory Benefits

F YTD Override - This transaction will set the YTD value to the amount entered as the
YTD balance at the start of the pay period.

F For information on how to fill out the YTD Overrides screens, please refer to Pay
Period Overrides section of this chapter of the manual.
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E.I. Transactions

TheE.I.Transactions submenu, from theEmployeeDatamenu, appears as follows:

The options available to the user through the E.I. Transaction menu are:

n E.I Adjustments
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E.I. Adjustments

When the user selects the E.I. Adjustment the following screen will appear:

The following table gives a description of the screen:

Field Description

Earning This field contains the employee earning code.

Date This field contains the date of the adjustment.

Position This field contains the position adjustment.

Units This field contains the number of units.

Rate This field contains the rate of the adjustment.

Amount This field contains the amount of the adjustment.

Reference This field contains the reference number.

Distribution This field contains the distribution code.
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Calculation

The Calculation menu, from the Employee menu, appears as follows:

The options available to the user through the Employee Calculation menu are:

n Calculate Pay

n View Results

n View Generated Transactions

n View Pay History
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When the user selects theCalculate Pay option from theEmployeeCalculationmenu,
the following screen will appear:

This screen allows you to set some options for the pay calculation, and to start the
calculation.

Field Description

Run Type This field displays the run type for the payroll .

Period This field displays the period for the payroll.

Frequency This field displays the payroll frequency.

Payroll Dates This field displays the starting and ending dates of the
payroll.

Pay Date This field contains the date the employee gets paid.

Distribute all

company benefits

This option causes the pay calculation to distribute all
company benefits according to the distribution of the
earnings that were used to calculate the benefit.

Distribute all

statutory benefits

This option causes the pay calculation to distribute all
statutory benefits according to the distribution of the
earnings that were used to calculate the benefit.

OK The OK button will perform a calculation of the payroll.

CANCEL The CANCEL button, or the Exit option from the File menu, will return you to the
Employee main menu without doing a pay calculation.

F When the pay calculation is being done, a status window is displayed that shows the
employee being calculated.
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Results

When the user selects Results from the Calculation menu, the following screen will
appear:

The following table gives a description of the data fields:

Field Description

Gross This field contains the current and YTD gross amount.

Tax This field contains the current and YTD tax amount.

Que Tx This field contains the current and YTD Quebec tax
amount.

CPP This field contains the current and YTD CPP amount.

QPP This field contains the current and YTD QPP amount.

EI This field contains the current and YTD EI amount

Ded This field contains the current and YTD deduction
amount.

Ben This field contains the current and YTD benefit amount.

Net This field contains the current and YTD net amount.

Arrears This field contains the current and YTD arrears amount.

Employer Current

& YTD

This field contains the employer�s current and YTD
amounts for CPP, QPP, EI, WCB and Health.
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When the user selects the Tax sub tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Amount This field contains the current and YTD amounts of tax
deducted.

Earning This field contains the current and YTD earning amount the
deduction is taken on.

Benefit This field contains the current and YTD taxable benefit amount.

Union This field contains the current and YTD taxable union amount.

Pension This field contains the current and YTD taxable pension amount.

Alimony This field contains the current and YTD taxable alimony
amount.

366 Can-Pay Computer Software

8 - EMPLOYEE INFORMATION



When the user selects the CPP/EI sub tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

CPP Amount This field contains the current and YTD CPP amount.

CPP Earning This field contains the current and YTD CPP earning amount.

CPP Benefit This field contains the current and YTD CPP benefit amount.

E.I. Amount This field contains the current and YTD EI amount.

E.I. Earning This field contains the current and YTD EI earning amount.

E.I. Benefit This field contains the current and YTD EI benefit amount.

E.I. Hours This field contains the current and YTD EI hours amount.

QPP Amount This field contains the current and YTD QPP amount.

QPP Earning This field contains the current and YTD QPP earning amount.

QPP Benefit This field contains the current and YTD QPP benefit amount.
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When the user selects the Earn (Earnings) tab the following screen will appear:

The following table gives a description of the data fields.

Field Description

Description This field contains a description of the earning.

Hours This field contains the hours.

Amount This field contains the current pay amount.

YTD Hours This field contains the total year to date hours.

YTD Amount This field contains the total year-to-date amount.
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When the user selects the Ded (Deductions) tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Description This field contains a description of the
deduction.

Deduction This field contains the deduction amount.

Benefit This field contains the benefit amount.

YTD Deduction Amount This field contains the year-to-date
deduction amount.

YTD Benefit Amount This field contains the year-to-date benefit
amount.
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When the user selects the Accum (Accumulators) tab the following screen will
appear:

The following table gives a description of the data fields.

Field Description

Description This field contains a description of the
accumulator.

Balance Amount & Hours This field contains a balance of the amount and
hours.

Accrued Amount & Hours This field contains an accrued amount and hours.

Paid Amount & Hours This field contains the amount paid and the hours
paid.
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Generated Transaction

When the user selects Generated Transactions from the Employee Calculation
menu, the following screen will appear:

This screen displays the transactions generated by the payroll calculation.

These transactions include:

n Deduction Calculations

n Accumulator Calculations

n Statutory Deduction Calculations

n Contra Earning Transactions

n Contra Deduction Transactions
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View Pay History

When the View Pay History option is selected, only the history from already closed
pay periods will be shown.

The following options are available to the user:

n View Pay History

n View EI History
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When the user selects View Pay History the following screen will appear:

The following table gives a description of the data fields:

Field Description

Gross This field contains the current and YTD gross amount.

Tax This field contains the current and YTD tax amount.

Que Tx This field contains the current and YTD Quebec tax
amount.

CPP This field contains the current and YTD CPP amount.

QPP This field contains the current and YTD QPP amount.

EI This field contains the current and YTD EI amount

Ded This field contains the current and YTD deduction
amount.

Ben This field contains the current and YTD benefit amount.

Net This field contains the current and YTD net amount.

Arrears This field contains the current and YTD arrears amount.

Employer Current

& YTD

This field contains the employer�s current and YTD
amounts for CPP, QPP, EI, WCB and Health.
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When the user selects the Tax sub tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Amount This field contains the current and YTD amount of tax deducted.

Earning This field contains the current and YTD earning amount the
deduction is taken on.

Benefit This field contains the current and YTD taxable benefit amount.

Union This field contains the current and YTD taxable union amount.

Pension This field contains the current and YTD taxable pension amount.

Alimony This field contains the current and YTD taxable alimony
amount.
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When the user selects CPP/EI sub tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

CPP Amount This field contains the current and YTD CPP amount.

CPP Earning This field contains the current and YTD CPP earning amount.

CPP Benefit This field contains the current and YTD CPP benefit amount.

E.I. Amount This field contains the current and YTD EI amount.

E.I. Earning This field contains the current and YTD EI earning amount.

E.I. Benefit This field contains the current and YTD EI benefit amount.

E.I. Hours This field contains the current and YTD EI hours amount.

QPP Amount This field contains the current and YTD QPP amount.

QPP Earning This field contains the current and YTD QPP earning amount.

QPP Benefit This field contains the current and YTD QPP benefit amount.
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When the user selects the Earn (Earnings) tab the following screen will appear:

The following table gives a description of the data fields.

Field Description

Description This field contains a description of the earning.

Hours This field contains the current hours.

Amount This field contains the current pay amount.

YTD Hours This field contains the total year-to-date hours.

YTD Amount This field contains the total year-to-date amount.
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When the user selects the Ded (Deductions) tab the following screen will appear:

The following table gives a description of the data fields:

Field Description

Description This field contains a description of the
deduction.

Deduction Amount This field contains the deduction amount.

Benefit This field contains the benefit amount.

YTD Deduction Amount This field contains the year to date
deduction amount.

YTD Benefit Amount This field contains the year to date benefit
amount.
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Accumulators

The Payroll Accumulator Selection screen allows you to select accumulators from the
list of activities displayed.

The dialog box for the Payroll Accumulator Selection appears as follows:

The accumulators are selected by clicking on the desired accumulator with the mouse
once, this accumulator will now be highlighted. Any number of accumulators may be
selected by repeating this procedure.

When all the desired accumulators are selected click on the OK button.

To de-select a single accumulator simply click on the highlighted accumulator and it
will no longer be selected. To de-select all the selected accumulators click on theClear
Selection object.

When you are selecting certain accumulator you may include or exclude all the
selected accumulators in the report. This is done by clicking on the Include or Exclude
object.
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Deductions

The Payroll Deduction Selection screen allows you to select deduction from the list of
deductions displayed.

The dialog box for the Payroll Deduction Selection appears as follows:

The deductions are selected by clicking on the desired deductions with the mouse
once, this deduction will now be highlighted. Any number of deductions may be
selected by repeating this procedure.

When all the desired deductions are selected click on the OK button.

To de-select a single deduction simply click on the highlighted deduction and it will no
longer be selected. To de-select all the selected activities click on the Clear Selection
object.

When you are selecting certain deductions youmay include or exclude all the selected
activities in the report. This is done by clicking on the Include or Exclude object.
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Select Activity Selection

The Select Activity Selection screen allows you to select activities from the list of
activities displayed.

The dialog box for the Activity Selection appears as follows:

The activities are selected by clicking on the desired activities with the mouse once,
this activity will now be highlighted. Any number of activities may be selected by
repeating this procedure.

When all the desired activities are selected click on the OK button.

To de-select a single activity simply click on the highlighted activity and it will no
longer be selected. To de-select all the selected activities click on the Clear Selection
object.

When you are selecting certain activities you may include or exclude all the selected
activities in the report. This is done by clicking on the Include or Exclude object.
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Select Area Selection

The Select Area Selection screen allows you to select areas from the list of areas
displayed.

The dialog box for the Area Selection option appears as follows:

The areas are selected by clicking on the desired area with the mouse once, this area
will now be highlighted. Any number of areas may be selected by repeating this
procedure.

When all the desired areas are selected click on the OK button.

To de-select a single area simply click on the highlighted area and it will no longer be
selected. To de-select all the selected areas click on the Clear Selections object.

When you are selecting certain areas youmay include or exclude all the selected areas
in the report. This is done by clicking on the Include or Exclude object.
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Select Earnings Selection

The Select Earnings selection allows you to select earnings from the list of earnings
displayed.

The dialog box for the Earnings Selection appears as follows:

The earnings are selected by clicking on the desired earnings with themouse once, the
earning will now be highlighted. Any number of earnings may be selected by
repeating this procedure.

When all the desired earnings are selected click on the OK button.

To de-select a single earning simply click on the highlighted earning and it will no
longer be selected. To de-select the all selected earnings click on the Clear Selection
object.

When you are selecting certain earnings you may include or exclude all the selected
earnings in the report. This is done by clicking on the Include or Exclude object.
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Select Grand Master Payroll File

One of these payrolls must be selected for scheduling. The payroll is selected by
placing the cursor over the payroll and clicking on the left-hand mouse button. The
payroll selected will appear in the main menu screen.

The following dialog box appears:

Inserting a New Payroll

The INSERT button will allow the user to add a new payroll to the list of available
payrolls. To insert a new payroll the following steps should be taken:

1. Select the INSERT button.

2. Type in the name of the new payroll in the dialog box that appears and select
the OK button.

3. In the new dialog box type in the name, description, and path to payroll in the
proper fields.

4. In the payroll password if you click on the enable password the set password
button will be available.

5. Select the Save option from the File menu and then select the OK button.

6. Your new payroll will now be displayed on the screen.
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Updating an Existing Payroll

If the UPDATE button is selected the user will be able to update the name, description,
and/or path to the payroll. To update the payroll follow these steps:

1. Select the UPDATE button.

2. A dialog box will appear which displays the name, description, and path to
payroll. Make changes to the necessary fields.

3. Select the Save option from the File menu and then select the OK button.

4. In the payroll password if you click on the enable password the set password
button will be available.

Deleting an Existing Payroll

If the DELETE button is selected the user will be able to delete the payroll.

To delete the payroll follow these steps:

1. Select the DELETE button.

2. You are asked to confirm the delete. Click on yes to delete the payroll.
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Select Positions Selection

The Select Positions Selection screen allows you to select positions from the list of
positions displayed.

The dialog box for the Position Selection appears as follows:

The positions are selected by clicking on the desired positionwith themouse once, this
position will now be highlighted. Any number of positions may be selected by
repeating this procedure.

When all the desired positions are selected click on the OK button.

To de-select a single position simply click on the highlighted position and it will no
longer be selected. To de-select all the selected positions click on the Clear Selections
object.

When you are selecting certain positions you may include or exclude all the selected
positions in the report. This is done by clicking on the Include or Exclude object.
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Select Reasons Selection

The Select Reasons Selection screen allows you to select reasons from the list of
reasons displayed.

The dialog box for the reason selection appears as follows:

The reasons are selected by clicking on the desired reason with the mouse once, the
reasonswill now be highlighted. Any number of reasonsmay be selected by repeating
this procedure.

When all the desired reasons are selected click on the OK button.

To de-select a single reason simply click on the highlighted reason and it will no longer
be selected. To de-select all the selected reasons click on theClear Selection object.

When you are selecting certain reasons you may include or exclude all the selected
reasons in the report. This is done by clicking on the Include or Exclude object.
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Select Shifts Selection

The Select Shifts Selection screen allows you to select shifts from the list of shifts
displayed.

The dialog box for the Shift Selection appears as follows:

The shifts are selected by clicking on the desired shifts with the mouse once, the shift
will now be highlighted. Any number of shifts may be selected by repeating this
procedure.

When all the desired shifts are selected click on the OK button.

To de-select a single shift simply click on the highlighted shift and it will no longer be
selected. To de-select the all selected shifts click on the Clear Selections object.

When you are selecting certain shifts youmay include or exclude all the selected shifts
in the report. This is done by clicking on the Include or Exclude object.
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Select Single Client Selection

TheSelect SingleClient Selection screen allows you to choose to select only one client
from the list of clients displayed.

The dialog box for the client selection appears as follows:

Next Client Pressing the next button or selecting the next client option from the File menu will
bring up the next client in the list.

Previous Client Pressing the previous client button or selecting the previous client option from the File
Menu will go back to the previous client in the list.

F8 (List) Pressing the F8 key or selecting the list client option from the file menuwill bring up a
list of clients.

ESC (Exit) The ESC key will exit the user from the current screen.
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Select Single Employee Selection

The Select Single Employee Selection screen allows you to select only one employee
from the list of employees displayed.

The dialog box for the employee selection appears as follows:

Next Employee Pressing theNext button or selecting the next employee option from the Filemenuwill
bring up the next employee in the list.

Previous

Employee

Pressing the Previous button or selecting the previous employee option from the File
Menu will go back to the previous employee in the list.

F8 (List) Pressing the F8 key or selecting the list employee option from the file menu will bring
up a list of employees. The list will vary depending on whether or not a payroll has
been selected. If no payroll is selected all employees will appear in the list . However
if a payroll is selected only the employee in that payroll will appear in the list.

ESC (Exit) The ESC key will exit the user from the current screen.

The search technique that is setwill change the order that the employees appear in the
list.
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Select Skill Selection

The Select Skills Selection screen allows you to select skills from the list of skills
displayed.

The dialog box skill selection appears as follows:

The skills are selected by clicking on the desired skill with the mouse once, this skill
will now be highlighted. Any number of skills may be selected by repeating this
procedure.

To de-select a single skill simply click on the highlighted skill and it will no longer be
selected. To de-select all the selected skills click on the Clear Selections button.

When you are selecting certain skills youmay include or exclude all the selected skills
in the report. This is done by clicking on the Include or Exclude objects.
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Select Subactivity Selection

The Select Subactivity Selection screen allows you to select subactivities from the list
of sub activities displayed.

The dialog for the Subactivity selection appears as follows:

The subactivities are selected by clicking on the desired subactivity with the mouse
once, this subactivity will now be highlighted. Any number of subactivities may be
selected by repeating this procedure.

When all the desired subactivities are selected click on the OK button.

To de-select a single subactivity simply click on the highlighted subactivity and it will
now longer be selected. To de-select all the selected subactivites click on the Clear
Selections object.

When you are selecting certain subactivities you may include or exclude all the
selected sub activities in the report. This is done by clicking on the Include or Exclude
object.
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Select Subarea Selection

The Select Subarea Selection allows you to select sub areas from the list of sub areas
displayed.

The dialog box for the Subarea selection appear as follows:

The subareas are selected by clicking on the desired subareaswith themouse once, this
subarea will now be highlighted. Any number of subareas may be selected by
repeating this procedure.

To de-select a single subarea simply click on the highlighted subarea and it will no
longer be selected. To de-select all the selected subareas click on the Clear Selections
object.

When you are selecting certain subareas you may include or exclude all the selected
subareas in the report. This is done by clicking on the Include or Exclude object.
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